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3rd Edition: April 2007 (YK)

Thank you for purchasing the Dagstation DX2000 (hereafter referred to as “DX”).

This User’s Manual explains how to use the useful functions of the DX2000. To ensure
correct use, please read this manual thoroughly before operation.

The following five manuals are provided as DX2000 manuals.

First edition:

Paper Manual

Manual Title Manual No.

Description

DX2000 Operation Guide  IM 04L42B01-02E

Explains the basic operations of the DX2000.
It is also provided in the CD-ROM.

Control of Pollution Caused IM 04L41B01-91C

by the Product

Gives a description of pollution control.

Electronic Manuals Provided on the Accompanying CD-ROM

Manual Title Manual No.

Description

DX2000 Operation Guide  IM 04L42B01-02E

This is the electronic version of the paper
manual.

DX2000 User’s Manual IM 04L42B01-01E

Describes how to use the application
functions. Communication and network
functions are not covered.

DX1000/DX1000N/DX2000 IM 04L41B01-17E
Communication Interface
User’s Manual

Describes how to use the communication
functions using the Ethernet and serial
interfaces.

DAQSTANDARD User’s
Manual

IM 04L41B01-61E

Describes how to use the accompanying
software program, DAQSTANDARD.

The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions.

Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA's permission is strictly prohibited.

The TCP/IP software of this product and the document concerning the TCP/IP software
have been developed/created by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the Regents of the University of California.

All the brands or names of Yokogawa Electric’s products used in this manual are
either trademarks or registered trademarks of Yokogawa Electric Corporation.
Microsoft, MS-DOS, Windows, Windows XP, and Windows NT are either registered
trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Adobe, Acrobat, and PostScript are trademarks of Adobe Systems Incorporated (Adobe
Systems).

CompactFlash and CF are trademarks of SanDisk Corporation.

For purposes of this manual, the ™ and ® symbols do not accompany their respective
trademark names or registered trademark names.

Company and product names that appear in this manual are trademarks or registered
trademarks of their respective holders.

December 2005 Third edition: April 2007

Second edition: October 2006

All Right Reserved, Copyright © 2005, Yokogawa Electric Corporation
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DX’s Version and Functions Described in This Manual

The contents of this manual corresponds to the DX with release number 2 and style
number 2.

DX’s Version and Functions

For the procedure to check the version, see section 2.5.

Edition]| DX [Suffix code Addition and change to functions Refer to
2 Version - (Added) German, French, and Chinese as display language Section 2.6
1.1 - (Added) Modbus client connection retry interval: 10 s, 20 s, and 30 s | Communication manual
/P1 (Added) 24 VDC/AC power supply (/P1 option) Operation Guide
Version| /USB1 |(Added) Tab key on the USB keyboard corresponds to arrow keys. |Section 2.11
1.21 - (Added) Operations to request and release network information Section 2.11
- (Changed)Modbus client: Function to connect a server with a unit Communication manual
number is changed.
- (Added) Modbus client: Connection timeout value Communication manual
- (Added) Modbus registers (floating point type for communication Communication manual
input data)
- (Added) A data output format (Skip or OFF channel data not output)| Communication manual
- (Changed)Error messages 105, 221, and 222 are added. Section 11.1
Error messages 215, 218, 536 and 536 are changed.
3 Release - (Added) Improvement to the operability on the historical trend Section 4.3
number display.
2 - (Changed)Displaying the date in the grid time of the trend display Sections 1.3 and 2.4
(Version when the trend interval is greater than or equal to 1 h/div.
2.0x) - (Added) Improvement to the display group setup operation. Section 5.1
- (Added) Addition of the Upper and Lower settings to the bar graph |Section 5.11
base position.
- (Added) Addition of the relay action when alarm ACK is executed to | Sections 1.2, 3.5, and 3.8
the alarm output relay settings.
/M1, /PM1 |(Added) Ability to reset the computed value during computation. Section 9.4
- (Changed)Changes to how the data files are named. Section 1.4
- (Added) Sorting the files by the update date/time. Sections 6.7, 6.8, and 6.9
- (Added) Storage method for constantly retaining the most recent Sections 1.4 and 6.2
data files in the CF card (Media FIFO).
- (Added) Progress display when saving all data of the internal Sections 4.8
memory.
- (Changed)Changing the initial display selection menu. Sections 4.8 and 5.18
/USB1 |(Changed)Improvement to the data save operation to the USB flash |Sections 2.12 and 5.18
memory.
/USB1 |(Changed)Retaining the state of the CapsLock and NumLock keys  |Section 2.11
on the USB keyboard
/MC1 (Added) Function for automatically assigning MW100s to the Communication manual
Modbus client.
- (Changed)Changing the default setting of the web server function. Operation Guide
- (Added) Error messages, 129, 131, 132, 133, 134, 135, 136, 137, |Section 11.1
513, 514, 515, and 516 have been added.
Style - (Added) The waterproof construction of the DX front panel Section 13.6
number complies with the NEMA4 standard
2
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How to Use This Manual

Structure of the Manual
Read the Operation Guide first to familiarize yourself with the basic operation,
and then read this manual. For a description of the communication function and the
accompanying software program, DAQSTANDARD, read the respective manual.
This user’s manual consists of the following sections.

Chapter Title and Contents

1 Overview of Functions
Describes the functions of the DX.
2 Common Operations

Describes the procedure to set the time and the operating procedure using the
remote control terminal (/KB1 or /KB2 option) and keyboard (/USB1 option).

3 Measurement Channels and Alarms

Describes how to set the measurement conditions and alarms.
4 Switching Operation Screens

Describes the operations on the operation screen.
5 Operations for Changing the Displayed Contents

Describes how to change the displayed contents on the operation screen and how
to write messages.

6 Saving and Loading Data
Describes how to acquire and store the data. Also describes the procedure to
load measured data/setup data on the CF card or the USB flash memory (/USB1
option).

7 Customizing the Action (Event Action)
Describes how to carry out specific actions when a given event occurs, when a
remote control signal is applied, and when the USER key is pressed.

8 Using the Security Function
Describes how to use the key lock function and the function that allows only
registered users to operate the DX.

9 Computation and Report Functions (/M1 and /PM1 Options)
Describes how to use computation channels and how to create reports such as
hourly, daily, weekly, and monthly reports.

10 External Input Channels (/MC1 Option)

Describes how to use external input channels.
" Troubleshooting

Describes error messages and troubleshooting.
12 Maintenance

Describes periodic inspection and calibration.
13 Specifications

Lists the specifications of the DX.
Appendix Describes how to estimate the file size, the types of data that the DX can
generated and how to use them, the data format of ASCII files, etc.

Index

Nofte
« This user’s manual covers information regarding DX2000s that have a suffix code for
language “-2” (English).
« For details on setting the display language, see section 2.6, “Changing the Displayed
Language.”
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How to Use This Manual

Conventions Used in This Manul
Unit

= X

Markings

>

CAUTION

Note

Subheadings
Bold characters

[Ala]#[1]

Procedure

Explanation

Setup Screen

Denotes 1024. Example: 768 KB (file size)
Denotes 1000.

Improper handling or use can lead to injury to the user or
damage to the instrument. This symbol appears on the
instrument to indicate that the user must refer to the user's
manual for special instructions. The same symbol appears in
the corresponding place in the user's manual to identify those
instructions. In the manual, the symbol is used in conjunction
with the word “WARNING” or “CAUTION.”

Calls attention to actions or conditions that could cause serious
or fatal injury to the user, and precautions that can be taken to
prevent such occurrences.

Calls attentions to actions or conditions that could cause light
injury to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Calls attention to information that is important for proper
operation of the instrument.

Denotes key or character strings that appear on the screen.
Example: Volt

Indicates character types that can be used.
A Uppercase alphabet, [allowercase alphabet,@symbols,
[1] numbers.

Carry out the procedure according to the step numbers.

All procedures are written with inexperienced users in mind;
depending on the operation, not all steps need to be taken.
Explanation gives information such as limitations related the
procedure.

Indicates the setup screen and explains the settings. A
detailed description of the function is not provided in this
section. For details on the function, see chapter 1.

IM 04L42B01-01E



Contents
[RTeT (=177 o IR PR R i
DX’s Version and Functions Described in This Manual ...............ooouuuuiiiiiiiiiieeeeeeeeeeeeeeeene ii
HOW t0 USE ThiS IMANUAL.........uueeiiieiieieeeeeee ettt e e e e e e e e e e s iii
Chapter 1  Overview of Functions

Chapter 2

Chapter 3

Chapter 4

1.1 INPUL SECHON ...t e e e e et e e e e e et e e e e e eeaeeeaeesnres 1-1
1.2 = 0 SRR 1-4
1.3 D1 o] =) URTUOUTPRRR 1-7
1.4 Data Storage FUNCHON .........oiiiiiie e 1-23
1.5 BatCh FUNCHON ..o e e e e aee e 1-33
1.6 EVENt ACHON FUNCHON .....oiiiiiiiie e e 1-34
1.7 SECUMtY FUNCHON ..ot e e e e e 1-37
1.8 Computation and Report Function (/M1 and /PM1 Options) ........cccceevvereiiieerieeennnenn. 1-39
1.9 FAIL/Status Output Function (/F1 and /F2 OptionS).........cccceveviiiiiiciiiiceeiiec e 1-45
1.10 Other FUNCHIONS. ...ttt e e e e 1-47

Common Operations

21 Setting the Date/TiMe........oii e e 2-1
2.2 Setting the Time Difference from GMT .........cooiiiiiiiiiie e 2-2
2.3 Setting the Time Correction Operation during Memory Sampling...........cccccceeevieerinnenn. 2-3
2.4 Setting the Date FOrmat..........c.ooo i
25 Viewing the DX INformation............ooooi e
2.6 Changing the Displayed Language

2.7 Setting the LCD Brightness and Backlight Saver............ccccccoiiiiiiiece 2-7
2.8 Initializing Settings and Clearing the Internal Memory ...........ccccociiiiiiiii e 2-8
29 Outputting the DX Status via the Relay Contact (/F1 and /F2 Options)...........cccccevueee. 2-9
2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options) ......... 2-10
2.1 Controlling the DX with a Keyboard (/USB1 Option)........cc.eeoiiiiiiiiiiiiiee e, 2-15
212 Using the USB Flash Memory (/USB1 Option) .......coceeiiiiiiiiiiiciiieeee e 2-17

Measurement Channels and Alarms

3.1 Setting the Scan Interval and the Integration Time of the A/D Converter....................... 3-1
3.2 Setting the Burnout Detection and the Reference Junction Compensation of the
ThermoCOUPIE INPUL .......eeiiie e e e e e e e e e e e e e e e e e e e e s e ennnnenes 3-2
3.3 Setting the INPUL RANGE .....coiieii e e 3-3
3.4 Setting the Moving Average of the INPUt ...........cooiiiiiiiiie e 3-6
3.5 Setting the Auxiliary Alarm FUNCHON. ..o 3-7
3.6 Hiding the Alarm INiCatION ..........coiiiiiiiii e 3-10
3.7 Setting Alarms 0N ChanNEIS.........c.eoiiiiii e s 3-11
3.8 Releasing the Alarm Output (Alarm ACK Operation) .........ccccoccuveeeiieiiiiieeee e 3-14
3.9 Performing Calibration Correction (/CC1 OPtion)........cceeiieieiiiieiiiie e 3-15
3.10 Counting Pulses (/PM1 OPtION)......cciuuieeiiieeiiieeasiiee e et e e e e seeeeesneeeennneeeaneees 3-16
3.1 Setting the Method of Detecting Over-Range Values of Linearly Scaled Measurement
CRANNEIS ... e 3-19

Switching Operation Screens

4.1 Operations in Operation MOGE ..........c.uiiiiiiiiiii e 4-1
4.2 Displaying the Measured Data as Waveforms, Values, or Bar Graphs ..........c.ccccceee. 4-3
4.3 Displaying Past Measured Data (Historical Trend Display)..........c.ccceevverieeeiiieeanieenne 4-5

IM 04L42B01-01E




Contents

Chapter 5

Chapter 6

Chapter 7

Chapter 8

4.4 Display the Statuses of All Channels on One Screen (Overview Display)................... 4-10
4.5 Displaying Various INformation.............coceiiiiiiiii e 4-11
4.6 Using the Alarm SUMMANY .......c.ooiiiiiiiii e 4-13
4.7 Using the MeSSage SUMMAIY .......coouiiiiiiieiiiie et 4-14
4.8 Using the MemOry SUMMAIY..........uviiiiiiiiiiiie ettt e et e e et e e e e e enaneeeaeeaaes 4-15
4.9 Displaying a List of Operation LOGS .........cceiiiiiiiiieeiiee e 4-18
410 Showing the Four Panel DiSPlay ...........ceeiuiieiiieiiee et 4-22

Operations for Changing the Displayed Contents

51 Setting DiSPlay GrOUPS .....ooeoiiiiiiiie ettt e e et e e e e e e nbe e e e e e aennneeeaeas 5-1
5.2 Displaying Tags or Channel NUMDErs..........ccciiiiiiiiiie e 5-3
5.3 Setting the Trend Interval and Switching to the Secondary Trend Interval .................... 5-4
54 WItING MESSAGES ... ettt e e 5-6
5.5 Changing the Channel Display COIOrS .........ccuiieiiiieiiie et 5-9
5.6 Displaying Channels in DisSplay ZONES.........c.cueuiuiieiiieeeiiee e eeeeesee e neee e 5-10
5.7 Displaying a Scale on the Trend DiSplay..........ocuueeiiaiiiiiiee e 5-11
5.8 Displaying Alarm Point Marks and Color Scale Band on the Scale ................ccccouee. 5-15
5.9 Partially Expanding the Waveform ... 5-17
5.10 Changing the Display Layout, Clearing of the Waveform at Start, Message Display
Direction, Waveform Line Width, and Grid.............ccoooooiiiiiiiieiee e 5-19
5.11 Changing the Bar Graph Display Method ............cccooiiiiiiieiie e 5-20
512 Using the Circular DISPIay .........coooueiiiiiiii e 5-23
5.13 Changing the Background Color of the Display ..........ccccoiuiieiiiiiniieecee e 5-30
5.14 Automatically Switching Display GroUPS.........ccceiiiiiiiiniiiiiiie e 5-31
5.15 Automatically Reverting to the Specified Display..........cccccceeiiiiiiiieiiiiieee e 5-32
5.16 Registering the Favorite DiSPlay ..........coouiiiiiiiie e 5-33
517 Writing a Message When the DX Recovers from a Power Failure ...........cccccccceeiiens 5-34
5.18 Changing the FUNC Key Menu and Display Selection Menu............ccccoooiiieiniineee. 5-35

Saving and Loading Data

6.1 Setting the Recording Conditions of the Measured Data............ccccccocviiiiiciiininicien. 6-1
6.2 Setting the Method for Saving the Data ..........cccooiiiiiiiiiiie e 6-4
6.3 Using the Batch FUNCHON .......coouiiii e 6-6
6.4 Starting/Stopping the Recording and Saving the Measured data.............cccc.ccooevveeen.. 6-8
6.5 Manually Saving the Measured Data (Manual Sample).........cccceiveiiiieniieeniee e 6-11
6.6 Saving the Screen Image Data (Snapshot)...........ccceeiiiiiiiiiiee e 6-12
6.7 Managing the Files on the Storage Medium ... 6-13
6.8 Loading and Displaying the Measured Data in the Storage Medium..............cccccoeeee. 6-15
6.9 Saving/Loading the Setup Data ............cooiiiiiiiiiei e 6-16

Customizing the Action (Event Action)

71 Setting the Event Action Function (Including Remote Control (/R Option) and
(U] =1 -1 T TS 7-1
7.2 Setup Examples of EVENt ACON ...........viiiiiiee e 7-5

Using the Security Function

8.1 Disabling the Key Operation (Key Lock FUNCON) ........cooiiiiiiiiiiiiiecee e 8-1
8.2 Enabling Only Registered Users to Operate the DX (Login Function)...........ccccoecveene 8-3
8.3 Logging in @and LOGGiNg OUL.......c.uiiiiiiiiiiiie et 8-6

vi

IM 04L42B01-01E



Contents

Chapter 9 Computation and Report Functions (/M1 and /PM1 Options)

9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on
Computation ChannEIS.............ooiiiiiiiie e 9-1
9.2 WItING EXPrESSIONS ..t ee ettt e e et e e e e et e e e e e mnee e e e e e eanneen 9-5
9.3 Displaying the Computation Channels.............coociiiiiiiiiiic e 9-11
9.4 Starting/Stopping Computation, Resetting Computation, and Releasing Computation
Data Dropout DiSPIaY ...........ueeiiiiiiiiee e 9-13
9.5 (@7 (] T T LT oo o ST 9-15

Chapter 10 Using External Input Channels (/MC1 Option)
10.1 Setting External Input Channels. ...........cooiiiiiiiieie e e 10-1
10.2 Displaying the External Input Channels ... 10-3

Chapter 11 Troubleshooting
1.1 A LISt OF MESSAGES ...ttt e et e e e e e e e e e e e e e neas 111
11.2 TroOUDIESNOOTING. ... e 11-15

Chapter 12 Maintenance
121 PeriodiC INSPECHION ........viiiii e 12-1
12.2 Calibrating the DX ... ..o e 12-2

Chapter 13 Specifications

13.1 Signal INPUE @Nd ATGIM ... 13-1
13.2 DiSplay FUNCHON. ...t e e e e 13-3
13.3 Data Saving FUNCHON ..ottt e e e e e e nneee s 13-5
13.4 Other Standard FUNCHONS ... 13-7
13.5 (0] o310} 0 1= PP PPPRPPPPP 13-9
13.6 General SPeCifiCatioNS .......c.cuiiiiiii e 13-14
13.7 EXternal DIMENSIONS .......couiiiiieei e e et e e e e et e e e e e snnbeeeeeeann 13-18
Appendix
Appendix 1 File Size of Display Data and Event Data.............cccccoooiiiiieiiiciiieiee e App-1
Appendix 2 Types of Data That the DX Can Create and Their Application..............ccc......... App-4
Appendix 3  Data Format of ASCII Fil€S .......cooouiiiiiiiiceee e App-5
Index

IM 04L42B01-01E vii



Chapter 1 Overview of Functions

1.1  Input Section

Measurement Channel

* Number of Measurement Channels and Scan Interval
The DX samples the input signals on the measurement channels at the scan interval
to obtain the measured values. The table below shows the relationship between the
number of measurement channels and the scan interval.

Number of Scan Interval
Model | Measurement

Channels Normal Mode Fast Sampling Mode
DX2004 4 125 ms
DX2008 8 250 ms 25 ms
DX2010 10
DX2020 20
DX2030 30 1s 2s,5s 125 ms
DX2040 40
DX2048 48
Integration time of the A/D 60 Hz/50 Hz 60 Hz/50 Hz/100 ms 600 Hz (fixed)
converter

For the setting procedure, see section 3.1.

¢ Integration Time of the A/D Converter
The DX uses an A/D converter to convert the sampled analog signal to a digital
signal. By setting the integration time of the A/D converter to match the time period
corresponding to one cycle of the power supply or an integer multiple of one cycle, the
power supply frequency noise can be effectively eliminated.
* Because 100 ms is an integer multiple of 16.7 ms and 20 ms, this setting can be used to
eliminate the power frequency noise for both frequency, 50 Hz and 60 Hz.
» In fast sampling mode, the performance of eliminating power frequency noise is worse than

in normal mode. We recommend that you use normal mode when making measurements in
an environment affected by power frequency noise.

For the setting procedure, see section 3.1.

Input Type and Computation

You can make measurements using the following input types.

Input Type

Description

DC voltage

Measures a DC voltage in the range of +20 mV to +50 V.

DC current

A shunt resistor*' is attached to the input terminal. The current signal is converted
to a voltage signal and measured. The measurable range is the range equivalent
to the “DC voltage” range indicated above after converting the current to the
voltage signal.

Thermocouple

Measures temperature corresponding to each type: R, S, B, K, E, J, T, N, W, L, U,
and WRe3-25. Measurement is possible on other thermocouples such as
PR40-20 and PLATINEL*?,

RTD

Measures temperature corresponding to each type: Pt100 and JPt100.
Measurement is possible on other RTDs such as Cu10 or Cu25*3 and Pt50 or
Ni100*2,

ON/OFF input

Displays the contact input or voltage input signals by correlating them to 0% or
100% of the display range.

Contact input: Closed contact is ON (1). Open contact is OFF (0).

Voltage input: Less than 2.4 V is OFF (0). Greater than or equal to 2.4 V is ON (1).

Pulse input**

Counts the pulses.

*1 ltem sold separately. For example, a 250-Q shunt resistor is used to convert the signal
to 1to 5V for 4-20 mA input.

*2 /N3 option.
*3 /N1 option.

*4 /PM1 option.

IM 04L42B01-01E
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1.1 Input Section

The following input processing and computation are available.

Moving average Linear Calibration Low cut Difference Measured
scaling correction computation  value
(/CC1 option)
DC Voltage | Y TN o '
T P ) P
Shunt resistor Lo / Lo
DC current L b —~ b e
} T b S N\ b
! E Square root computation | E .
1-5V [ - O P o
Burnout detection ) b P .
RIC_ | | L
Thermocouple —ri i—i : ;o ; '
Burnout detection <) ---4 | ! | M) -
P N/ [
RTD Lo L Y
| I Do
/ [
5 . -
ON/OFF input \?Jr- Lo T
| Y Lo
/ S
Convert to number of pulses over 1 second
Pulse )

(/PM1 option)

"
v N\

Dotted lines indicate that the function can be selected.

Reference Junction Compensation

Burnout Detection

Performs reference junction compensation on
the thermocouple. DX

Thermocouple 4
P ) Internal
L] reference
Thermocouple junction

External reference junction
For the setting procedure, see section 3.2.

Detects and indicates a burnout in the sensor.

Burnout
1-5V
C ® Indicated as
Detected on the Burnout.
1-5 V value.

Thermoelectromotive

Burnout
force

Nl

For the setting procedure, see section 3.2.

Indicated as
Burnout.

Moving Average

Eliminates noise.
Operation example when the number

New sampled

New sampled

of moving average data points is 3 data ‘ data '
1| 10.0 mv 15.0 mV 10.0 mV Number of moving
_SatmhpILn%fdata 2| 50mv s 10.0 mvV s: 15.0 mvV average data points: 2 to 400
in the burter 3 oomv 50mv_ [ 10.0 mv
) Clear Clear
(Moving average) [ 50mv | [[10.0mv | [117mv ]
Sampling nth time n + 1th time n + 2th time

For the setting procedure, see section 3.4.
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1.1 Input Section

Square Root Computation

Linear Scaling

Takes the square root of the input value and converts
the unit to obtain the measured value.

b B
— — oX Measured
value X value
a /\

A B

L1

N

X

For the setting procedure, see section 3.3.

Converts the unit to obtain the measured value.

N0V——— 300 °c

Measured
value

0OV —>— -100°c

For the setting procedure, see section 3.3.

Calibration Correction (/CC1 Option)

Low-cut

Corrects the input value with the characteristics
specified by segments to obtain the measured value.

Number of break

Output points: Up to 16
value
()
value

Input
value

For the setting procedure, see section 3.9.

For square root computation, measured values below
the specified value are cut.
For 1-5 V input, values below 0 % are cut.

Measured
value
Low-cut value |+

/! value

For the setting procedure, see section 3.3.

Result of square root
computation

Difference computation

Pulse Input (/PM1 Option)

The measured value of the channel is set to the
difference with respect to the measured value of the
reference channel.

Input Measured
value value

Measured value on the reference channel

For the setting procedure, see section 3.3.

Pulse that can be counted Input to the DX
Pulse
100 Hz or less Contact {

J | or —> DX
T open 4,
5 ms or more collector

Count on the DX
|The contact changes from open to close.|

The signal level at the input terminal changes from high
to low.

For the setting procedure, see section 3.10.

Note

Difference computation is executed even if the input type or range is not the same between

the difference computation channel and the reference channel. The difference is computed

discarding the decimal place and unit, and the decimal place and unit of the difference

computation channel are applied.

Example 1: If the input value of the difference computation channel is 10.00 and the
measured value of the reference channel is 100.0, the computed result is
10.00 — 100.0 = -90.00.

Example 2: If the input value of the difference computation channel is 10.00 V and the
measured value of the reference channel is 5.00 mV, the computed result is
10.00 V-5.00 mV =5.00 V.

IM 04L42B01-01E
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1.2

Alarms

This function generates an alarm when the measured data meets a certain condition. Up
to four alarms can be set for each channel.

Alarm Type

You can use the alarms shown below. The character inside the parentheses is the

symbol denoting each alarm.

For the alarm setting procedure, see section 3.7.

High Limit Alarm (H)

Low Limit Alarm (L)

Measured value Hysteresis

Alarm value |> 7

| X

Alarm output ON

Measured value Hysteresis

‘ Z

Alarm output ON —

Alarm value |>

Delay High Limit Alarm (T)

Delay Low Limit Alarm (t)

T Measured value

Alarm value |> /i ; R

—_—=r

Delay time ‘

Alarm output ON —+

\ Measured value /
I

|
|

I

—_— I
i I !

I

|

Alarm value |>

Delay time

Alarm output ON ———

High Limit on Rate-of-Change Alarm (R)

Low Limit on Rate-of-Change Alarm (r)

Measured value Change in the
A

/./' measured value
T2 -
_- Amount of change in
T P the setting
T2-T1|
/| t1 t2 L
> Time

D E—
Interval (t2-t1)

Measured value
A

T2 Amount of change in
the setting
S
T1 RN [T2-T1]
N < Change in the measured value
t1 t2) "o N
» Time

Interval (t2-t1)

Difference High Limit Alarm (h)

Difference Low Limit Alarm ()

Difference in the measured values of two channels
Hysteresis

Alarm value |> .
! AN

Alarm output ON s

Difference in the measured values of two channels
Hysteresis
\ /

A
i\_/ i

Alarm output ON e

Alarm value [>

e Alarm Hysteresis

You can set a width (hysteresis) to the value used to activate and release alarms.

Delay High Limit Alarm and Delay Low Limit Alarm
An alarm occurs when the measured value remains above or below the alarm value
for a specified time period (delay period).

High Limit on Rate-of-Change Alarm and Low Limit on Rate-of-Change

Alarm
The rate-of-change of the measured values is checked over a certain time (interval).

An alarm occurs if the rate-of-change of the measured value in the rising/falling
direction is greater than or equal to the specified value.

The alarm value of the rate-of-change alarm is set using an absolute value. The
interval is derived using the following equation and set using the number of samples.

Interval = the scan interval x the number of samples
For the setting procedure, see section 3.5.

Difference Upper Limit Alarm and Difference Lower Limit Alarm
An alarm occurs when the difference in the values of two channels is greater/less

than or equal to the specified value. These alarms can be specified on measurement
channels set to difference computation.
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1.2 Alarms

Alarm Indication

The alarm conditions are displayed as alarm icons in the status display section and on

the operation screen such as the trend, digital, bar graph, overview displays. Detailed

information about the alarms is displayed in the alarm summary.

* Hold/Non-hold of Indications
The alarm indication can be set to operate in the following fashion when the condition

is no longer met.

» Clear the alarm indication (non-hold).
* Hold the alarm indication until the alarm ACK operation is executed (hold).
The default setting is non-hold.

For the setting procedure, see section 3.5.

¢ Alarm Hide Function

The alarm setting is displayed, but no indication is made when an alarm occurs. The
alarm is also not recorded in the alarm summary. The alarm is output to the relay
(/A[ ] option) or internal switch. This function can be set for each channel and each

alarm.

For the setting procedure, see section 3.6.

Alarm Output Relay Operation

Contact signals can be generated from alarm output relays (/A_ option) when alarms
occur. The alarm output relay operation can be changed.
For the setting procedure, see section 3.5.

- é rox. é rox.
Alarm output relay ms ms

(reflash OFF)

L (when a relay is set to “OR” logic)

Reflash AND/OR
r Channel 1 —l‘ Channel 1_’—!_
Alarm L Alarm | |
Channel 2 | | { Channel Zﬂ
| ‘ !
| Channel 3_?_%_!_ ] .
b | Alarm output relay [ [ AND ; [ | ;
Alarm output relay | U | | !
Internal switch I e
(reflash ON) nternal switc

(You can set the alarm output relay and internal
switch. For details on the internal switch, see the

next page.)

Energize or De-energize

When power is shut down  Normal operation

cogze | /] /]

When alarm is occurring

N, |

NO: Normally Opened
C: Common

NOC NC NOC NC NOC NC NC: Normally Closed
De-energize | /l N |
NOC NC NOC NC NOC NC
Non-Hold Hold
Alarm occurrence Alarm ACK Alarm ACK
1
Alarm ' l Alarm release | | 1 E :
1 1 1
Alarm  'Activated Activated " Activated | — Normal| @
output Relay is activated 5
relay Deactivated Deactivated Deactivated in the next scan =
interval >
2
o
Alarm occurrence Alarm ACK Alarm ACK Alarlm ACK 3
! o
Alarm release_| 1 I L I ™ Reset | 5
Alarm _!_.I_ ! . ! (Release| >
Alarm Activated or Activat';d Activated or Activat(‘d number g
output I L I - L___ |Relay is activated 2
relay Deactivated Deactivated Deactivated Deactivated on the next alarm || or later)
occurrence

IM 04L42B01-01E
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1.2 Alarms

Internal Switch

¢ Reflash
When multiple alarms are assigned to one alarm output relay, this function notifies the
occurrence of subsequent alarms after the relay is activated by the first alarm. When
subsequent alarms occur, the output relay is released temporarily (approximately 500 ms).
The reflash function is set on the first three output relays.*
* 101 to 103 or 111 to 113. 101 and 102 for the /A1 option.

Note

When reflash is enabled, the first three output relays are used exclusively as reflash relays.
The first three output relays are set to OR logic and de-energize operation regardless of the
AND/OR and energize/de-energize settings explained below.

¢ AND/OR
When multiple alarms are assigned to one alarm output relay, the condition for
activating the output relay can be selected from the following: You can select AND
operation also for the internal switch.
« AND: Activated when all assigned alarms are occurring simultaneously.
+ OR: Activated when any of the specified alarms is occurring.

* Energize or De-energize Operation
You can select whether the alarm output relay is energized or de-energized when an
alarm occurs. If de-energized is selected, the status of the alarm output relay when an
alarm occurs is the same as the status that results when the DX power is shut down.
The setting applies to all alarm output relays.

* Non-Hold/Hold
The alarm output relay can be set to operate in the following fashion when the alarm
condition is no longer met.
* Turn OFF the relay output (non-hold).
* Hold the relay at ON until the alarm ACK operation is executed (hold).
The setting applies to all alarm output relays.

¢ Alarm ACK Operation
The alarm acknowledge (alarm ACK) operation releases all alarm indications and
relay outputs. For the action of alarm indication and alarm output relay when you
carried out the alarm ACK operation, see the previous page.

Note

When you enter the basic setting mode, the hold/non-hold condition of the alarm output relay

immediately before is retained. In the basic setting mode, alarms are not detected, and you
cannot acknowledge alarms.

The alarm status can be output to software switches (30 internal switches). The values of
the internal switch are shown below. Like the alarm output relay, you can specify AND/
OR operation (see the previous page).

Alarm occurrence

Alarm
Alarm release

1
Internal switch F,_L

The internal switches can be used events of the event action function (see section 1.6).
In addition, the internal switches can be written in calculation expressions of computation
channels (/M1 or /PM1 option).

1-6
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1.3

Display

Common Items Related to the Display

10.4 TFT Color LCD and the Screen Configuration
The DX has a 10.4-inch TFT color LCD (480 x 640 dot resolution). The screen
consists of the status display section and the data display section.

e /a1 09:g2:27 orsP NI Smin x )| — Status display section

— Data display section

¢ Status Display Section
The status display section shows the display name, date/time, batch name (when
using the batch function), user name (when using the login function), usage of the
internal memory or CF card, alarm occurrence, computation status (/M1 or /PM1
option), and usage of key lock or e-mail transmission.

» Data Display Section
The data display section shows the measured data using numeric values,
waveforms, and bar graphs. It also shows the setup screen when setting functions.

Group Display

On the trend, digital, and bar graph displays, the data of channels is displayed by
groups that are set in advance. Up to 36 groups can be registered, and up to 10
channels can be assigned to each group. Groups are common to the trend, digital,
and bar graph displays.

The displayed group can be switched automatically at a specified time interval (5 s to 1 min).
For the setting procedure, see section 5.1.

Channel Number Display and Tag Name Display

Channels can be displayed as tags or channel numbers. The setting applies to all
channels.

For the setting procedure, see section 5.2.

Update Interval of Measured Values
The values are updated every second. However, if the scan interval is greater than 1 s,
the values are updated at the scan interval.
For the setting procedure, see section 5.3.

Alarm Indication
Alarms that are set for each channel are checked at all times and are indicated with
the symbol representing the alarm type on each display.

Alarm Type Symbol Alarm Type Symbol
High limit alarm H High limit on rate-of-change alarm R
Low limit alarm L Low limit on rate-of-change alarm r
Difference high limit alarm h Delay high limit alarm T
Difference low limit alarm | Delay low limit alarm t
IM 04L42B01-01E 1-7
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1.3 Display

Status Display Section

The following information is displayed in the status display section during operation

or setting mode.
Memory sampling status

Data type
Display data
Event data
Memory sampling @
stopped
(e

Ly
Memory sampling '
in progress ]

Memory sampling icon

EXT

P 1 ALL

GROI e .
o bva/22 10:57:05 g 01> NN 46nin

Display name or group name
For all channel display on the trend display,
“All” is displayed.

Date and time
Displayed in yellow while the time is being corrected.

: When using the batch function

P1-process-AABAAS Batch name and the display
name are shown alternately.
Date and time

If the “batch number-lot number” exceeds 20 :
characters, the “date and time” position is used to !
display the “batch number-lot number.” !

Name of the user logged in
Display name
Date and time

Name of the user logged in

Batch name and the display
name are shown alternately.

Date and time

CF

(2]
(0]
The green level display indicates the amount of _._Ej
CF card used. If Media FIFO* is not enabled and
the free space on the CF card falls below 10%,
the level indicator changes to red.
* See section 1.4, in the DX1000/DX1000N User's

Manual. Media FIFO is a function available on
release number 2 or later.

(5]
]

Bar Graph

Memory sampling progress

Displays the progress using a green bar graph. The frame indicates the file
save interval (display data) or the data length (event data).

Error in internal memory.

Contact your nearest YOKOGAWA dealer for repairs.

Displays the remaining memory sampling time for the left bar graph.

mode

Alarm icon

Displayed when any alarm is activated.
Blinks when there are alarms that are
occurring but have not been acknowledged.

)

(Red)

Uil All alarms have been released after they
have occurred, but there are alarms that

(Green)
have not been acknowledged.

Status icon
The status assigned to the status output relay
(/F1 option) is occurring.

m Keys are locked.

E E-mail transmission is enabled.

Computation icon (/M1 option)
White icon:Computation started

Yellow icon:Computation data dropout occurred

card icon

CF card is being accessed.

Waiting.

Light blue icon: CF card in the slot is not

recognized. Remove and reset it.

CF card error.

Carry out the procedure below to reset the CF card icon to

normal.

» Replace the CF card with a normal one.

» Format the CF card on the DX (the data on the CF card
will be erased).

When a pretrigger is configured in the event data recording and you press the START
key causing the DX to enter the trigger wait condition, the data in the pretrigger section
is recorded. During this time, the bar is displayed in orange. After the pretrigger time
elapses, the length of the bar fixed at that point. However, the relevant data is updated
until the trigger condition is met. When the trigger condition is met, the bar turns green,
and data is recorded after the data in the pretrigger section.

1-8
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1.3 Display

Trend Display (T-Y)

Waveform data is displayed in a waveform. For the operating procedure, see section 4.2.

Trend interval Grid Numeric display section
See section 5.3. See section 5.10. See section 4.2.
f—Aﬁ
>
g 1B 08:51:48 W

Tag name or channel number, measured value,
and specified alarm

Ininsdiv

Trip line (up to four lines)
See section 5.1.

— Current value mark

#— Waveform (displayed using the channel display color)

L 1.72 Change the channel display color (see section 5.5.)

‘HH\HH‘QHUHH

1
179.88 Change the waveform line width (see section 5.10.)
56 ; Display the waveforms of all channels (see section 4.2.)
£ 3 Message (mark, time, and message)
() B84z B84 gz dg =100 42.

See section 5.4.

v

+— Alarm point mark
See section 5.8.

1 division
(30 dots)

L See section 5.7.
"Trend space” function
Inserts a division-wide space here.
-~ Maximum value See section 4.2.
“Minimum value  Time at the grid position
1 dot Displays the time or the date and time.
See sections 2.4 and 5.3.

Color scale band
See section 5.8.

E\H\HIIEHIUHE

@F‘\“‘-‘\””\““E‘\ T

+— Current value display
using a bar graph
See section 5.7.

21T

Displays the maximum and minimum values of the
data sampled within the time corresponding to 1 dot.

TTTTTT T

Display layout See section 5.10.

Vertical display

=
_‘HH‘PH‘HH‘HH‘H
=1

GROLP 1 = , =
29B5/18/8] 08-52:89 o s (S)ER -

-100 0 M]H 200 300
Lo @0 Lt b ATh_ AT T T b A
-1.0 -0.6 0.2 g 0.2 0.6 1.0

0 100 200 gsm 300 400 500 Z:r— Alarm mark
\HHIHHlHH\HH\lH \l\\|H|\I|\H\||.\|M|H\ L. 7 nn
H W s [=]

=B HoLD Inip/div —_— Alarm type
EE:gh :
AN 68:48 START
=4S

B

o '

EUT-162 [RFI-163 W% RvA-264 | Z:EH:IE Y
97.P2 247.2 R 49.6 397.4
kPay|

H i u‘ Y Hn-418 I
99.49|L 8.97 181.59 57.1 42.8
Horizontal wide display

GROUP 1 P=s _
2005/10/81 88:52:24 DIsP N { 8nin

1nin/div

-0.013

Horizontal split display (displays two groups)
GROUP 1
2605/18/81

)

B8:51 HOLD <

I “c
6 415.4 | H
3
43.3

a5

3 838 48 G842 B84 |4 ke g =5
1181 foHoUT-162 IR (-103 R a-26d
115.1 8.870 265.9 52

kPa? 1 y B
183.88 L 9.80 183.23 57.6
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1.3 Display

¢ Updating of the Waveform

On the screen, 30 dots along the time axis is represented by a unit called division (see
the figure on the previous page). The displayed waveform is updated at an interval
corresponding to one dot. This interval is determined by the time corresponding to one
division (referred to as the trend interval). The relationship between the trend interval
and the speed of movement of waveforms on the screen is as follows:

Trend interval [/DIV] 15s” 30s 1 min 2 min 5 min
Time (s) corresponding to 1 dot 0.5 1 2 4 10
Speed of movement of waveforms

(approximate value, mm/h) 2500 1250 625 312 156
Trend interval [/DIV] 10 min 15 min | 20 min 30 min 1h
Time (s) corresponding to 1 dot 20 30 40 60 120
Speed of movement of waveforms

(approximate value, mm/h) 8 42 31 21 10
Trend interval [/DIV] 2h 4 h 10 h

Time (s) corresponding to 1 dot 240 480 1200

Speed of movement of waveforms 5.2 26 10

(approximate value, mm/h) ) ) :

* Selectable on the DX2004 and DX2008

Switching the Trend Interval
You can switch from the normal trend interval to the secondary trend interval during
memory sampling and vice versa. For the operating procedure, see section 5.3.

Writing Messages

Preset messages

Start
Material 1

Tren

o

\awlb]=

/\_/

Free message /

Set the message when writing the message

Preset Messages

Preset messages are recalled and written.
The number of messages that you can use are 100 (message 1 to 10 are shared with
free messages). For the operating procedure, see section 5.4

Free Messages

Messages are entered when you need to enter them. The number of messages that
you can use are 10. For the operating procedure, see section 5.4.

Automatic Message Writing

* A message is written when the trend interval is switched during memory sampling.
For the setting procedure, see section 5.3.

* A message is written when the power recovers from a power failure during memory
sampling. For the operating procedure, see section 5.17.

Message display method

» Except for the vertical display, you can set the direction in which messages are
displayed to horizontal or vertical. For the setting procedure, see section 5.10.

» Messages can be displayed consolidated at the upper left of the screen (list
display). For the operating procedure, see section 4.2.

List display

L5~
~idinrdiv
= « Q403 HOLD

Lgb

BIB Tenperatur
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1.3 Display

e Zone Display
You can display channels in specified zones. This function can be used to keep the

waveforms from overlapping for easier view. 9
In the example below, channel 1 is displayed in the 0 to 30% zone, channel 2 in the S
30 to 60% zone, and channel 3 in the 60 to 100% zone. g'
When zone display is not used When zone display is used =
100 % = 100 % y
>
/ CH3 _//\ Zone 3 o
N []
/A \WI SN/ 60 % 2
/SN A\ Y/ -
71\ W] - I Zone 2
// / \\\J/ \NA/ 30%
CH1 & /\ Zone 1
. _ 0% — 1 0%
Time axis Time axis

For the setting procedure, see section 5.6.

e Partial Expanded Display
By compressing a section of the waveform display range, the rest of the section is
expanded.
In the example below, 0 V (boundary value) is moved to the 30% position of
the display range (new boundary position). The 30% area below the boundary
corresponds to “—6 V to 0 V" and 70% area above the boundary corresponds to “0 V

to6 V.
When partial expanded display When partial expanded display
is not used is used
Percentage with Percentage with
respect to the respect to the
Measured value display span Measured value display span
6V 100 6V 100 ——
s
°
]
Bound{ry /1\ /1\ New ]
value boundary | S
c
0 5\ / \ / \ position | §
/ i
\/ \ [/ o o g
A4 ANIV4 Reduced
section
-6V - - 0 -6V 0 ——
Time axis Time axis

For the setting procedure, see section 5.9.

¢ Alarm Indication
Alarm mark, alarm type, and measured value are displayed as follows according to
the alarm status.

When indication is When indication is
set to non-hold setto hold
Alarm ACK Alam ACK

Alarm mark Green| Red | Green | Green| Blinking |Blinking: Green Green | Blinking : Red | Green
red green red

Alarm type None| Red | None | None| Red None :None None| Red :Red|None

Melasured Blue| Red | Blue | Blue | Red Blue : Blue Blue| Red :Red | Blue
vailue
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1.3 Display

Digital Display

Displays the measured data numerically using large numbers. For the operating
procedure, see section 4.2.

Unit

Measured value

Alarm mark

. 168.73
TI-285 53. 0%
256 38.8

Numeric display of measurement channels

If a measured value of a measurement channel is over range (see below), the measured
value is indicated as “+Over” or “~Over.” If a burnout is detected on a channel whose
burnout detection function is enabled, the word “Burnout” is indicated. Otherwise, a numeric
value is displayed.

Over range of measurement channels

For DC voltage input, over range occurs when the measured value of the measurement
channel exceeds +5% of the measurable range. For example, the measurable range when
the measurement range is 2 V is —2.000 to 2.000 V. If the measured value exceeds 2.200 V,
+ over range occurs; if the measured value falls below —2.200 V, — over range occurs.

For thermocouple or RTD input, over range occurs when the measured value exceeds
approximately £10°C of the measurable range. For example, the measurable range

when the measurement range is R is 0.0 to 1760.0°C. If the measured value exceeds
approximately 1770.0°C, + over range occurs; if the measured value falls below
approximately —10.0°C, — over range occurs.

For channels that are linearly scaled, + over range occurs when the value exceeds 30000
excluding the decimal point; — over range occurs when the value falls below —30000.
However, + over range can be changed to greater than or equal to 105% of the scale width
and — over range to less than or equal to —-5% of the scale width within £30000. For the
setting procedure, see section 3.11.

Numeric display of computation channels

See section 1.8, “Computation and Report Function (/M1 and /PM1 Options)

Numeric display of external input channels (/MC1 option)

The numeric range that can be displayed is —30000 to 30000 excluding the decimal point.
The decimal place corresponds to the decimal place of the lower limit of span of the external
input channel. On the numeric display, values are displayed if the value is within the —30000
to 30000 range regardless of the upper and lower limits of span.

If the value exceeds 30000, + over range occurs; if the value falls below —30000, — over
range occurs.

e Alarm Indication
Alarm mark and measured value are displayed as follows according to the alarm

status.
When indication is When indication
set to non-hold is set to hold
Alaim ACK Alan'q ACK
Alam Occurrence I_l I_l :
Release |_

Alarm mark Green| Red |Green| Green Ezlnking BIinkingEGreen Green zl::?kmg Red | Green

value

green

Measured  Blue| Red | Blue | Blue| Red | Blue iBlue Blue| Red | Red| Blue
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1.3 Display

Bar Graph Display
Waveform data is displayed in a bar graph. For the operating procedure, see section 4.2.
Vertical

tir-41@— Tag name or channel number

3 208,60 108, ma.eL Alarm mark
L i
Upper limit of span

300.0

- @— Scale
See section 5.7.

|~ | Alarm point mark
— = — — |

n o B - | | @#— Bar graph (displayed using the
7 channel display color)
See section 5.11.

| oo, | e | e | e | oo @— Lower limit of span and unit
555.9 [131.18 | 16.18 |195.99 | 61.6 | 47.3 @— Measured value

J
Y

Bar graph base position is set to Center
See section 5.11.

-1ea.a | -1.008 a.n 0.8 0.0
R] u

C %1
255.8 | B.789 | 412.4 | 76.8

3

Horizontal See section 5.10.
GROLP 1

= .
2805/18/8] B8:54:44 DIsP N 16min
—1@5, 8 ts=N =] Tl_lﬂl

_:IH

Bar graph base position is set

246.0 to Normal

R L.ee [QUT-162 V= (The starting point of the bar
I — | B.664 \ graph is the left edge or right
50 o [FIIB ik : .
—: @21 edge, which ever the value is
—— [ smaller)
o oo 1005 oo 2 See section 5.11.

. . I — M s )
o0 s [P0 KPa

. . = : — H__129.21
. o 100.56 (AC_3AT

Bar graph base position is set
> to Center
See section 5.11.

200, BB

A 106.8
1 1 I 1 I ]

N:] 1088

a
\
a
\
a
[ I 1 | I 1 I ]
a
\
a
\
a
\

¢ Updating of the Bar Graph
The bar graph is updated at the same interval as numeric values.

¢ Alarm Indication
Alarm mark, alarm point mark, and measured value are displayed as follows according
to the alarm status.
When indication is
set to hold
Alaim ACK

o

When indication is
set to non-hold

ool IR
Release

Alarm ACK

L

Alarm

Alarm mark Green| Red |Green | Green| Blinking |Blinking: Green Green | BINKing : Red | Green
red green red

Point mark Green| Red |Green | Green| Red Green :Green Green| Red :Red [Green

Meiasured Blue| Red |Blue Blue| Red Blue : Blue Blue| Red :Red | Blue

value
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1.3 Display

Historical Trend Display

The waveform of the past measured data (display or event data) in the internal memory
or external storage medium can be displayed. This function is called Historical trend.

* Methods of Displaying the Historical Trend
There are four methods to display the historical trend of the measured data in the
internal memory.
» Display from the alarm summary. For the operating procedure, see section 4.6.
» Display from the message summary. For the operating procedure, see section 4.7.
» Display from the memory summary. For the operating procedure, see section 4.8.
» Recall from the display selection menu. For the operating procedure, see section 4.3.
Measured data on an external storage medium can also be displayed as historical
trend. For the operating procedure, see section 6.8.

* Displayed Contents

Background Waveform (channel display color)
color Cursor Zoom factor of the time axis

(Can be changed) Trip line Time axis

7T UETMs—t—— Tag name or channel number (channel display color)

v '*— Measured value (maximum or minimum value over
£ the entire display range)

m\ Measured value (maximum or minimum value at
the cursor position)

Unit

ws—e— Screen switch display

TE The most recent data position among the displayed data
Date and time of the data at Date and time of the data at the right end on

the left end on the time axis the time axis or the time at the cursor position

The time at the cursor position is displayed enclosed in a
yellow frame.

Half screen display

U_l:_ Historical trend

+— Current trend

\E
L ¢
t

Item Description

Alarm summary Displays an alarm summary of the displayed data.

Message summary Displays a message summary of the displayed data.

Data information Shows information about the displayed data (file name, sample start

time, end time, etc.).

* Added Messages
Added messages can be written. For the operating procedure, see section 5.4.
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1.3 Display

Circular Display

Message

GROUP 1
2005/18/08 13:33:23
413133900
N19:00 STRRT

16:30:00 16/08
N83:24 25}

The circular display shows the measured data on a circular time axis in place of the trend
display (T-Y). The time per revolution can be set in the range of 20 minutes to 4 weeks.
For the operating procedure, see section 5.12.

DISP i

Sh/qgg_

11:38:88 1868

19/88

12:08: 64
18,/85

“tee12: 98108
128

£HE
oUT-182
e
v
.
F1-183

416.2

n3/h

i/ ““\ Ya-284

Quarter cycle display

GROUP 1
2085/16/88 13.34:14

Gh/rav |

1+

* Historical Trend Display

GROUP 1
2AR5/18/87 14:33:82

=

This position is the time reference position.

The time axis is set so that the time reference

position is hour 0.

The reference position can be offset in unit of one hour.

Time per revolution
See section 5.12

Message mark (position where the message was written)

See section 5.4
Grid
See section 5.10

— Waveform (displayed using the channel display color)

To change the channel display color, see section 5.5.
To change the waveform line width, see section 5.10.
To display the waveforms of all channels, see section

Trip line (up to four lines)

See section 5.1

\ 76.6 _
r— Date/time

Time scale (main scale marks and small scale marks)

Channel number corresponding to the scale value

Scale

Simplified historical trend

6h/rav

Displays the past data for each time of revolution. The displayed contents and

operating procedure are the same as the historical trend of the T-Y display. Half
screen display is not possible.
DisP N 2%nin

+¢—— Time per revolution

See section 5.12

—— Date/time

=—— Cursor (yellow line)

See section 5.12

=— Cursor time
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1.3 Display

Overview Display
Displays a list of the statuses of all channels.
You can move the cursor to select a channel and display the trend, digital, or bar graph
of the group containing the selected channel.
For the operating procedure, see section 4.4.

Seeraven pe:saoe e 01 DI in (B N
P1-206 Channels on which an alarm is
H 119.09 kpa occurring are indicated in red
Alarm type
Cursor

Measured value and unit

Tag name or channel number

e Alarm Indication
Channel display area, tag name/channel number, alarm type, and measured value are
displayed as follows according to the alarm status.

When indication is When indication is
set to non-hold set to hold
Alarm ACK Alaim ACK

o O[] | [ L

Tag/Channel Black| White |Black | Black | Blinking |Blinking: Black Black |Blinking : White | Black
white | black white

Channel Green| Red |Green|Green| Red | Green :Green Green| Red | Red |Green
area

Alarm type None| White | None | None | White | None :None None| White :White|None

Melasufed Black| White |Black | Black | White | Black : Black Black| White :White|Black
value
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1.3 Display

Alarm Summary

Displays a list of the most recent alarms.

» Up to 1000 alarms can be displayed.

» You can select arbitrary alarm information and recall the historical trend of the display
data or event data that contains the alarm information.

For the setting procedure, see section 4.6.
ALARH SURHARY

20085/10/81 B

SuUOI32UN4 JO MBIAIBAQ

{AB28/0834) ~RAlarn Tine

A 0N 2L 2085/10/81 B9:62:41
a 0N 2 2085/10/1 B9:A1:18

= aN 1L 2085/18/81 88:59:42 ———> To the historical trend display
¢ ~ OFF PI-206 1H 2085/10/81 88:59:21
OFF  TI-181 1H 2085/10/81 B8:57:48
OFF  OUT-162 1T 2085/18/81 B8:56:15
QO ALK 2085/10/81 B8:55:49
A 0N OuT-182 1T 2085/10/81 B8:55:13
A 0N TI-B1 1H 2085/10/81 B8:53:48
AN PI-286 1H 2085/10/81 B8:52:53
OFF  AC-387 1L 2085/10/81 B8:52:37
OFF  VA-284 1R 2085/18/81 B8:52:36
AN VA-284 1R 2085/10/81 B8:52:35
OFF  VA-284 1R 2085/10/81 88:52:34
A 0N Va-204 1R 2085/10/81 B8:52:33
OFF  VA-284 1R 2085/10/81 B8:52:28
AN vA-284 1R 2085/10/81 B8:52:27
OFF  VA-284 1R 2085/10/81 B8:52:21
A 0N Va-284 1R 2085/10/81 B8:52:28
FF Vagnd i 2085/10/HlgB8:52°15

|
Date/Time of alarm occurrence/release
Alarm No. (1, 2, 3, 4)/type (H,L, h, R, r, T, 1)
Channels on which alarms are occurring
4 0N : Alarm occurrence
( ~ blinks until the alarm ACK operation is carried out if “Indicator” is set to
“Hold.”)
oFF : Alarm release

O Atk @ Alarm acknowledge
(when blinking is cleared through the alarm ACK operation)

Cursor (selects the alarm)

Number of the alarm information displayed on the bottom line/number of alarm
information in the internal memory
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1.3 Display

Message Summary
Displays a list of written messages and the time the messages were written.
» Up to 450 messages can be displayed.
» Up to 50 messages that are added to the past data section (added messages) can be

displayed.

* You can select arbitrary message information and recall the historical trend of the
display data or event data that contains the message.
For the setting procedure, see section 4.7.

HESSAGE SUMHARY = ,
205/18/81 89:03:55 pIsP [N min

) )

(B85/@A5)  Message

Time

Group

Pressure
Temperature
= HOLD
® START
0

2085/18/81 9:A3:33
2885/18/81 09:03:18
2885/18/81 B8:51:31
2085/10/081 B8:48:49
2555189/38‘}8247236

Al

> To the historical trend display

Message
Added message
(displayed in blue)

Destination group to write the message
All groups or a group number

Date/Time when the message was written

Cursor (selects the message)

Number of the message displayed on the bottom line/number
of messages in the internal memory

» Switching of the Display Items
You can switch between two sets of display contents.
* Message, time when the message was written, and group to which the message

was written

* Message, user name that wrote the message
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1.3 Display

Memory Summary

Displays the information pertaining to the display data and event data in the internal

memory.

» By selecting the display data or event data, the historical trend display can be recalled.

» The number of manual sampled data and report data (/M1 and /PM1 options) in the
internal memory is displayed.

For the setting procedure, see section 4.8.

HENCRY SUFHERY = :
Soion) Booder 0 D NN win  (©)

H.SAHPLE DATA  (B4/4BR) -20085/1B/81 B8:5 1

Date/Time of the most recent

&=
=0

2
REPORT DATA (ES/F) z2095/10/81 A9:60:60 -

i

data

SAHPLE DATA = B DISPLAY DATA @
Start Time End Tine Data Factor

2085/18/81 B8:50:56 20B5/10/81 P9:A4:06 378 Sampling
2665/18/81 B8:30:56 20@5/10/81 B8:50:54 660 Auto Save
mp 2085/16/0] B8:10:56 2085/18/81 B3:38:54 688 Auto Save
® 2005/89/30 13:41:B0 20@5/89/30 13:48:28 2'2'5 St't'm
L I |

I- Number of data points in the
internal memory/maximum
number of data points that
can be recorded in the
internal memory

Data type
* Display data
* Event data

— To the historical trend display

Status

Sampling count

Date/Time of memory stop

Date/Time of memory start

Cursor (selects the file)

¢ Switching of the Display Items
You can switch between two display methods.
» Display the start and end times
» Display the file name

¢ Saving the Data

The data in the internal memory can be saved to a CF card or USB flash memory

(/USB1 option).
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1.3 Display
Report Data (/M1 and /PM1 Options)

Report data residing in the internal memory can be displayed.
For the operating procedure, see section 4.5.

REPORT DATA = ) =
2085/10/81. 89:B4:22 D I min () )

~@dex : 33 @FKind : Hourly Stert : 2835/18/01 B9:10:55  Timeup: 2605/16/81 e3:00:00 &1 Start: Start date/time
Channel Unit St fve Hax Hin Sun Timeup: Report date/time

114.5 253.9 6.8 3.311867EHAS
8,066 8,727 -8.727  1.99d1dRE+A2
265.1 4166 3.3 7.G6BBO5EHHS
52.4 .7 23,3 1.61R377E+HS
414.5 553 248.8  1,199052E+06
2.976701E+85

. 1,81 2.8199R4E+Ad
183.13 196,35 167,26 5.297556E+05
5.6 B1.7 52.6  1.BG5LBIEHES
43.3 47.4 38.3 1.251785E485

TI-181 °C

aT-102 v

FI-183 udh
¥

°¢
PI-286 kPa
¥

PLHP-343 1
HA-d@3 ¥

Shbddbhddd
=
w3
o
=
@
S
o
S
=

L ]
I Report data status
Indicates that the following
occurred between the report
interval.
E: Error data
O: Over data
P: Power failure
C: Time change
B: Burnout
Unit Average, maximum, minimum, sum,
or instantaneous value

Report type

Tag name or channel number
Number of the displayed report data/number of report data in the internal memory

Status Display
The following displays available.
For the operating procedure, see section 4.5.

* Relay Status Display
Displays the status of the alarm output relay and internal switch.

¢ Modbus Client Status Display and Modbus Master Status Display
Displays the command status.

Log Display
Displays various logs (operation log).
For the operating procedure, see section 4.9.

Log Type Description

Login Log of login/logout, log of time setting, and log of power failure
Error Log of error messages

Communications Log of communication commands

FTP transfer Log of FTP transfers

WEB Log of Web operations

E-mail transmission Log of e-mail transmissions

SNTP Log of accesses to the SNTP server

DHCP Log of accesses to the DHCP server

MODBUS Log of communications using Modbus client or Modbus master
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1.3 Display

Four Panel Display
Displays four different display formats on a single screen. Because the size of each
screen is reduced to 1/4, there are limitations in the format, content, and operation of the
display.
For the operating procedure, see section 4.10.

GROUP 1
2 3 45 6 7 8 918

i

Displayable Screen Limitation

Trend No auto switching of groups. No all channel display and
message display. Number of displayed scales is 6 or less.

Digital No auto switching of groups.

Bar graph display No auto switching of groups. No numeric display. Displays
one representative alarm character.

Overview No operation. No numeric display when there are more than
261 channels.

Alarm summary No operation using the cursor.

Message summary

Memory summary

Modbus client status display

Modbus master status display

Relay Status Display -

Report display No operation using the cursor.

* Registering Screens
You can assign a display name to the display condition of the four panel display (up
to four configurations) and register it. A registered configuration can be recalled by its
display name and displayed.
The default values are as follows:

Display Name Displays Shown

MIX Trend (group 1), digital (group 1), bar graph (group 1), and overview
ALL TREND All trend displays (groups 1 through 4)

ALL DIGITAL All digital displays (groups 1 through 4)

ALL BAR All bar graph displays (groups 1 through 4)
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1.3 Display

Other Useful Functions
¢ Automatically Reverting to the Specified Display

Show a preset display when there is no operation for a specific time.
For the setting procedure, see section 5.15.

* Favorite Key
Register a frequently used display to the Favorite key and enable the display to be
shown through simple operation.
For the setting procedure, see section 5.16.

¢ Customizing the Menus
Change the FUNC key menu that appears when the FUNC key is pressed and the
screen menu that appears when the DISP/ENTER key is pressed.
For the setting procedure, see section 5.18.

Setting the Display Conditions of the LCD
The display conditions of the LCD can be configured.

Display Attribute Setting

Background color of the  The background color of the display can be set to white or black.

operation display The default value is White. For the setting procedure, see section
5.13.

Background color of the  You can select white, cream, black, or light gray for the background
historical trend screen color of the screen. The default value is Black. For the setting
procedure, see section 5.13.

LCD brightness The brightness of the LCD can be set among six levels. The default
brightness is 2. For the setting procedure, see section 2.7.
Backlight saver The lifetime of the LCD backlight can be extended by automatically

turning OFF or dimming the light when there is no key operation
for a specified amount of time. The display returns to the original
brightness with a key operation or an alarm occurrence. By default,
the backlight saver is disabled. For the setting procedure, see
section 2.7.
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1.4

Data Types

Data Storage Function

This section explains the types of data that the DX can record and how to store them.

The types of data that the DX can record are as follows:

Data Type Description

Display data »  Waveform data displayed on the trend display. The measured data

is recorded as a specified sampling interval. The sampling interval is
specified using the trend interval.

*  The minimum and maximum values among the measured data within the
sampling interval are saved.

* Aheader string (common to other files) can be written in the file.

» The display data contains alarm and message information.

» Data format: Binary (Undisclosed)

Event data * Measured data that is recorded at a specified sampling interval. There
are two modes. One mode starts recording when a trigger event occurs.
The other mode records at all times.
* Aheader string (common to other files) can be written in the file.
» The event data contains alarm and message information.
» Data format: Binary (Undisclosed)

Manual sampled data
» Instantaneous value of the measured data when a manual sample
operation is executed.
* Aheader string (common to other files) can be written in the file.
» Data format: ASCII

Report data (/M1 and /PM1 options)

* Hourly, daily, weekly, and monthly report data. Report data is created
at an interval that is determined by the report type (one hour for hourly
reports, one day for daily reports, and so on).

* Aheader string (common to other files) can be written in the file.

» Data format: ASCII

Snapshot data (screen image data)
» The image data of the DX screen when the snapshot operation is
executed.
» The data can be saved to a CF card.
» Data format: PNG

Setup data * The setup data of the DX.
» Data format: Binary (Undisclosed)

Display data and event data
Display data can be likened to the conventional recording on the chart sheet and
are useful for long-term recording. Event data is useful when you wish to record the
measured data in detail.

:_--_--_.--_--._--_| Displaydata
Maximum value per sampling interval - [ . ‘ 1
Minimum value per sampling interval —I> ; ; !

- e o e e o e e e o = e

Event data

, Measured data per
1 scan interval

Scan interval
Sampling interval of event data

Sampling interval of display data

IM 04L42B01-01E
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1.4 Data Storage Function

Flow of Data Recording and Storage
Measured data is recorded once to the internal memory and then saved to the external
storage medium.
Measurement Computation External input

channel channel channel
~—— Data of another device
(via communication)
AN J
Vo
Display Setup data
Sampling
Internal memory D
| |
:l:l Screen image Save
Save the data data
FTP server on
the network < Display/Event EE
data
I

<

CF card USB memory (/USB1 option)

External storage medium

Internal Memory
Display data and event data are held in files in the internal memory. The data area also
stored on the external storage medium in files.

Internal memory

Manual

Display data and event data sampled data

Report data

FTP server on <—¢
the network

Directory on the external storage medium
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1.4 Data Storage Function

Recording Method of Display Data and Event Data
For the setting procedure, see section 6.1.

¢ Types of Data to Be Acquired
Select display data only, display data and event data, or event data only.

Deciding the Data to Be Recorded

Record the data that suits your application. Refer to the following examples.

Example 1: Continuously record the waveform data as with the conventional chart
recorder.
Record the display data.

Example 2: Record waveform data under normal conditions but record details around
the point of alarm occurrence when alarms occur.
Continuously record display data and record event data when alarms
occur.

Example 3: Only record the most-detailed data at all times.
Record event data by specifying the sampling interval.

Example 4: No need to continuously record data. Record data only when alarms
occur.
Record event data only when alarms occur.

e Internal Memory
The recorded measured data is divided at a specific time interval and saved to files.
The size of the internal memory that holds the files is 80 MB or 200 MB (expansion
memory). If this size is exceeded or if the number of display data files and event data
files exceeds 400, files are overwritten from the oldest file.

¢ Recording Conditions of Display Data

Item Description

Source channels Select from measurement channels, computation channels, and
external input channels.

Sampling interval Specify the sampling interval with the trend interval (see the table
below). You cannot specify a sampling interval that is faster than the
scan interval.

File creation Files are created at the specified file save interval

/ /\V\V Jime

I I I v

File File File Adding data

Files are also created in the following cases.
*  When afile is created manually.
*  When the memory sampling is stopped.

» When file creation is executed with the event action function.
Memory start/stop Press the START key to start recording (memory start) and the
STOP key to stop the recording (memory stop).

Trend interval and the sampling interval of display data

Trend interval [/DIV] 15 s* 30s 1 min 2 min 5 min
Sampling interval of displayed data (s)| 0.5 1 2 4 10
Trend interval [/DIV] 10 min| 15 min | 20 min 30 min 1h
Sampling interval of displayed data (s)] 20 30 40 60 120
Trend interval [/DIV] 2h 4h 10 h

Sampling interval of displayed data (s) 240 480 1200

* DX2004 and DX2008 only
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1.4 Data Storage Function

¢ Recording Conditions of Event Data

Item Description

Source channels Same as the display data.

Sampling interval Select from the available settings between 25 ms to 600 s. However,
you cannot specify an interval that is faster than the scan interval.

File creation Afile is created when the specified data length is reached.

Files are also created in the following cases.

*  When afile is created manually.

*  When the memory sampling is stopped.

»  When file creation is executed with the event action function.

Mode The available modes are Free (continuously record), Single, and
Repeat. The recording operation varies depending on the mode as
follows:

Free
Press the START key to start recording (memory start) and the STOP
key to stop the recording (memory stop) .

/ /W/—\V Jime

I I I v

File File File Adding data
Single
Pressing the START key places the DX in the trigger-wait state. When
the trigger condition is met, the DX records data for a specified time
(data length) and stops. From this point, the DX does not record even
if the trigger condition is met.
Trigger condition met

Time
I I >
—
File

Repeat

Pressing the START key places the DX in the trigger-wait state. When
the trigger condition is met, the DX records data for a specified time
(data length) and stops. The DX enters the trigger-wait sate again and
keeps recording the data for a specified time (data length) each time
the trigger condition is met. To stop the recording of the event data,
press the STOP key.

Trigger condition met  Trigger condition met

/r/—/‘\/‘/\‘— Time

Pretrigger of Event Data
The pretrigger can be specified in trigger mode.
This function is used to save the data before the point where the trigger condition
is met as event data. This function is convenient when you wish to record the data
before the occurrence of a certain event such as when an alarm occurs.
Specify the pretrigger as a percentage (0, 5, 25, 50, 75, 95, or 100%) of the recording
time (data length) of the event data. If set to 0%, the data after the trigger condition is
met is recorded.

Trigger co?dition met

Time

T »

Data before —»I |<— Data after —»I

the trigger the trigger

e e

Trigger for Starting the Event Data Recording
When set to trigger mode, you can set various conditions for starting the recording.
Example: Key operation, alarm occurrence, specific time, or remote control

1-26
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1.4 Data Storage Function

¢ Creating Files through Key Operation

Files can be created using keys.
Key operation

/ /\t/_\ﬁ Jime

I I I I v

File File File
Previous files [ Current file ]

Manual Sampled Data

Report Data

Manual sampled data is recorded to the internal memory. When the number of manual
sampled data exceeds 400, the data is overwritten from the oldest data.

/JM Jime

: IS A '

= Manual sampled data

Report data is recorded to the internal memory. When the number of report data
exceeds 100, the data is overwritten from the oldest data.

/ /\t/—\r Jime

¥ i i >

= = = Report data
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1.4 Data Storage Function

Saving Data to the External Storage Medium
For the setting and operating procedure, see sections 6.2 and 6.4 respectively.

¢ Type of External Storage Medium

* CF card (32 MB or more)
» USB flash memory (/USB1 option)

e Auto Save
Have the CF card inserted in the slot at all times. The data in the internal memory is
automatically saved to the CF card.
Auto Save Timing
Data Type Description
Display data The file is saved when the file is created.

—r/ /\/\T” Jime

I I 4

File |  File 1 File l

[ Save to the CF card ]
Event data Same as the display data.
Manual sampled data The first time manual sample is executed, a manual sampled data

file is created on the CF card. The data is appended to this file for
each subsequent manual sample operation.

Report data The first time report data is generated, a report data file is created
on the CF card and report data is stored. The report data is
appended to this file every time of report.

Dividing of the report files

The appending of the report data to the file is stopped at a specified
time, and subsequent reports are saved to a new file. The file is
divided in the unit shown in the table below.

Report Type Report File

One File File for Each Type
Hourly report |[—_Jhourly reports of a day
Daily report |[__]daily reports for a month
Hourly and  |__Jhourly reports for a day and  |[~_] a file for each daily report

daily reports a daily report [ hourly reports of a day

Daily and [Jdaily reports for a week and |[—_] a file for each weekly report
weekly reports a weekly report ] daily reports for a month
Daily and [Jdaily reports for a month and |[_] a file for each monthly report
monthly reports| a monthly report [ daily reports for a month

Save Destination
CF card.

Data Save Destination Directory

You can set the data save destination directory name (DATAO by default). The
specified directory is created on the CF card, and the data is saved in the directory.

Save Operation (If Media FIFO Is Disabled)

The data in the internal memory can be saved only if there is sufficient free space on
the CF card. Replace the CF card and save the data before the data in the internal
memory is overwritten.

Save Operation (Constantly Retaining the Most Recent Data Files Using
Media FIFO) (Release Number 2 or Later)

When saving the data files automatically, you can save the data so that the most
recent data files are constantly retained in the CF card. This method allow you to use
the DX continuously without having to replace the CF card.
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1.4 Data Storage Function

* Operation

old Update date New N\
< >
- g
Deleted File 1 File 2 File 3 <Saved File 4
_ —
\_ Medium y,
N\

If not enough free space is available when saving a new data file to the CF card,
files are deleted in order from the oldest data update date/time to save the new file.
This operation is referred to as FIFO (First In First Out).

» The FIFO operation is carried out only when saving the following files
automatically. It is not carried out when saving files to the save destination
directory using another method. Display data files, event data files, report data
files, manual sample data files, and snapshot files

» Files that are deleted
All the files in the save destination directory are applicable to be deleted.
However, the following files are excluded. Hidden files, read-only files, files in
the subdirectory within the save destination directory

» The most recent 1000 files are retained. If the number of files in the save
destination directory exceeds 1000, the number of files is held at 1000 by
deleting old files even if there is enough free space.

 If there are more than 1000 files already in the save destination directory, one or
more files are always deleted before saving the new file. The number of files is
not kept within 1000 in this case.

¢ Manual Save (Collectively Storing Unsaved Data)

Unsaved data in the internal memory is stored in unit of files to the external storage
medium when an external storage medium is inserted and a given operation is carried
out.

Save operation

‘Q/—‘/\‘/_\'—“ Time

I I I I I 4

File File File
AN
Saved the A
previous time = | Saved this time |

When using manual save, it is important that you save the data in the internal memory
to the external storage medium before the data is overwritten. Determine the usage
condition of the internal memory and save the data to the external storage medium at
appropriate times.

Save Destination
You can select a CF card or USB flash memory (/USB1 option).

Data Save Destination Directory
You can set the data save destination directory name (DATAO by default).

IM 04L42B01-01E

1-29

SuUOI32UN4 JO MBIAIBAQ



1.4 Data Storage Function

* File Name
You can select the file name configuration from three types.
Structure Description
Date Display data
Event data 7-digit - Specified string - Date . | Extension
Manual sampled data | Ex.: 000123 AAAAAAAAAAA050928 174633.DAD
Snapshot data
Report data 7-digit - Specified string - Date | . [Extension |
Ex.: 000123_AAAAAAAAAAA050928_174633HD.DAR
Sequence Display data
Event data [ 7-digit W Specified string I . [Extension |
Manual sampled data | £y : 000123_AAAAAAAAAAA.DAD
Snapshot data -
Report data 7-digit .
Ex.: 000123_AAAAAAAAAAAOHD.DAR
Batch name Display data [ 7-digit [IRNN Batch name I . [Extension |
Event data Ex.: 000123 BBBBBBBBBBBBBBBBBBBBB.DAD
Report data [ 7-digit | Date |ETypes . [ Extension
Ex.: 000123_050928_174633HD.DAR
Manual sampled data | [ 7.digit | Date | . [Extension
Snapshot data Ex.: 000123_050928 174633.DAM
Item Description
7-digit Consists of a 6-digit number and 1-character delimiter.
6-digit A sequence number in the order of occurrence. The number ranges from
number 000001 to 999999. If the number reaches 999999, it returns to 000001.
1-character | Starts with ‘_’ and takes on the following values: A to Z and 0 to 9.
delimiter | If a file with the same name exists in the specified directory, the file is
saved by changing the delimiter to prevent overwriting.
Example:If a file named “000123_AAAAAAAAAAA.DAD” already exists,
the file is saved to the name “000123AAAAAAAAAAAA.DAD.”
Date YYMMDD_hhmmss |YY: Year (lower two digits), MM: Month, DD: Day

hh: Hour, mm: Minute, ss: Second

Specified string |AAAAAAAAA-eA Up to 16 alphanumeric characters can be used
Batch name BBBBBBBBBBB++*B |Up to 40 alphanumeric characters can be used
Type H_,D_,W_, NM_, Report data type
HD, DW, DM H_: Hourly, D_: Daily, W_: Weekly, M_: Monthly,
HD: Hourly and daily, DW: Daily and weekly,
DM: Daily and monthly
Extension Display data :DAD Report data :DAR
Event data :DAE Snapshot data :PNG
Manual sampled data :DAM Setup data :PDL

Note

Differences from the File Names up to Now
The “ID” item at the end of the file name is deleted and its functionality is included in the

“Separator” of the 7-digit sequence.

Example

DXs before release number 2:

000123_AAAAAAAAAAAQ50928 1746330.DAD

The “ID” functionarity
has been shifted.

DXs with release number 2 or later: 000123_AAAAAAAAAAA050928_174633.DAD

The sequence section of the display data and event data file names is changed to 7 digits,

and the “ID” function is included in the “Separator” when using the “Batch name.”
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1.4 Data Storage Function

File Names on DXs before Release Number 2
The table below shows the file name that is assigned when the measured data is saved
to the CF card.

Structure Description
Date Display data
Event data 7-digit |00 Specified string 1] Date [0 1. [Extension
Manual sampled data | gy . 000123_AAAAAAAAAAA050928_1746330.DAD
Snapshot data
Report data 7-digit |00 _Specified string 1] Date . [Extension]
Ex.: 000123_AAAAAAAAAAA050928 174633DH0.DAR
Sequence Display data
Event data 7-digit |0 Specified string I 1D | . [Extension
Manual sampled data | Ex.: 000123_AAAAAAAAAAA0.DAD
Snapshot data
Report data p
Ex.: 000123_AAAAAAAAAAAHDO.DAR
Batch Display data . [Extension]
name Event data Ex.: 123BBBBBBBBBBBBBBBBBBBBB0.DAD
Report data 7-digit | Date ETyped ID | . [Extension
Ex.: 000123_050928_174633HD0.DAR
Manual sampled data 7-digit | Date |10 ]. [Extension
Snapshot data Ex.: 000123_050928_1746330.DAM
Item Description
Date YYMMDD_hhmmss Same as release number 2 and later.

7-digit sequence

000001 to 999999

Consists of a 6-digit number and an underscore as a separator.
A sequence number in the order of occurrence.

3-digit sequence |001 to 999 A sequence number in the order of occurrence.
Type H_ D_W_ M Report data type
HD, DW, DM Same as release number 2 and later.

ID 0to9,AtoZ When a file with the same name exists in the specified directory,
the file is saved by changing the ID character to prevent
overwriting.

Example:If a file named

“000123_AAAAA050907_1036480.DAD”

already exists, the file is saved to the name

“000123_AAAAA050907_1036481.DAD.”
Extension Same as release number 2 and later.

IM 04L42B01-01E
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1.4 Data Storage Function

e Saving Data through Key Operation

You can carry out the following data save operations regardless of whether auto save
or manual save is used.

Data Storage Description

All save Collectively saves all the data in the internal memory.

Selective save Saves the specified display data or event data file.

Manual sampled data save  Collectively saves all the manual sampled data in the internal
memory.

Report data save Collectively saves all the report data in the internal memory.

Save Destination
You can select a CF card or USB flash memory (/USB1 option).

Data Save Destination Directory

Creates a directory with the name of the data save destination directory name with the

date/time added and saves the data.

Directory name: “Specified string”_ YYMMDD_HHMMSS

Example: If the data is saved at 17 hours 6 minutes 42 seconds on September 30,
2005, the data is saved to a directory named “DATAQ0_050930_170642.”
“‘DATAOQ” is the specified string.

Nofte

The number of directories that you can create on the external storage medium varies
depending on the length of the directory names. If the length of the “specified string” is 5
characters, approximately 170 directories can be created. If it is 20 characters, approximately
120 directories can be created. An error occurs, if you try to create directories exceeding this
limit.

Other Types of Data That Can Be Stored

e Setup Data

The setup data of the DX is saved to a CF card or USB flash memory (/USB1 option).
The setup data is saved to the root directory.

Name of the setup data file [ Specified |. PDL
Example: ABCD10005.PDL

Snapshot Data

The screen that the DX displays is saved to a CF card in PNG format. The data is
saved to the same directory as the display data and event data. For the file name, see
the previous page.

e =
4 Iime

»

[m] [m] [m] =] Snapshot
CF card Data file

Saving Data via the Ethernet Network

Display data, event data, report data (/M1 or /PM1 option), and screen image data can
be automatically transferred and saved to an FTP server via the Ethernet network by
using the FTP client function. Conversely, the DX can function as an FTP server. The
DX can be accessed from a PC and the data files in the internal memory or the external
storage medium can be retrieved to be stored on the PC.

See the Communication Interface User’s Manual IM 04L41B01-17E.
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1.5 Batch Function

You can add batch information to the display data and event data files. The files can be
managed using the batch information.
For the setting and operating procedure, see section 6.3.

Batch Information

e Batch Number and Lot Number
Afile can be identified by its “batch number-lot number.” The lot number does not
have to be specified.
« Batch number (up to 32 characters).
* Lot number (up to 8 digits)

* Automatic Increment of the Lot Number
The lot number can be automatically incremented when the memory sampling is
stopped.

* Text Field
Eight sets of arbitrary text can be entered in a file. Each text field consists of the
following:
+ Field title (up to 20 characters)
» Field string (up to 30 characters)

The text field can be shown on the DX screen through key operation.

e Batch Comment
Three arbitrary comments can be entered in a file. A single comment can be entered
while memory sample is in progress.
* Comment 1, Comment 2, and Comment 3 (up to 50 characters each)

Using the Batch Function

See the figure below. For example, enter the operator and administrator in the text field.
Comment

Memory start Memory stop

Batch number + lot number

Text field > /\/—//\/—\L Time

»

I I v

Comment

v

Data file
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1.6

Events

Event Action Function

A specified action is carried out when an event occurs. This function is called event

action.

For the setting procedure, see section 7.1.

* Events
Select from the following events.
Event Level/Edge* Description
Remote Level/Edge ON/OFF of the remote control input.
Qutput relay Level/Edge Activated/Deactivated condition of the alarm output
relay.
Internal switch Level/Edge The value 0 and 1 of the internal switch.
Timer Edge Timer timeout.
Match time timer Edge When the time matches.
Alarm Level/Edge The state in which any alarm is occurring and the state
in which no alarm is occurring.
USER key Edge The operation of pressing the USER key.
* For a description of level and edge, see “Miscellaneous” in this section.
e Timers
Four timers are available.
Timer Type

Absolute timer

Relative timer

Set the timer

Set the timer Ref. time Reset the timer
l + + + l + Time + * Time
I A ) A I A I A (I B | B |o==
+ Timeout A: Interval B: Interval

¢ Absolute Time Mode

The timer expires at the times determined by the reference time and the interval.
The reference time is set on the hour (00 to 23).
Example: Reference time: 00:00

Interval:

10 min

The timer expires at 0 hour, 0 hour 10 min, 0 hour 20 min, ... 23 hour 40
min, and 23 hour 50 min. For example, if the timer is set at 9 hour 36
min, the timer expires at 09 hour 40 min, 09 hour 50 min, 10 hour, and

SO on.
¢ Relative Time Mode

The timer is started when the timer is set, and the timer expires every specified
interval. In this mode, the timer stops when a power failure occurs.

Example: Interval: 00:15

The timer expires every 15 minutes.

¢ Match Time

You can set the time matching conditions for the four match time timers. Specify
the date/time using the method described below. For each condition, you can select
whether to use the condition once or continuously.

Specified Date/Time

Description

Y hour of the X day

The condition is met once a month.

Y hour of the X day of the week

The condition is met once a week.

Y hour

The condition is met once a day.
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1.6 Event Action Function

Action

Actions

Select from the following actions.

Action Level/Edge* Description

Memory start/stop Level Starts/stops memory sampling.

Memory start Edge Starts the memory sampling.

Memory stop Edge Stops the memory sampling.

Event trigger Edge Applies a trigger for starting the event data

recording.
This is valid when recording event data in trigger
mode. See the next page.

Alarm acknowledge Edge Releases the alarm output.
This is valid when the use of the alarm ACK
operation is enabled.

Computation start/stop*™  Level It is used to start/stop the computation.

Computation start** Edge Starts the computation.

Computation stop** Edge Stops the computation.

Computation reset** Edge Resets the computed values on all computation
channels.

Save display data Edge The display data being recorded is saved to the

internal memory as a file. This is the same function
as the data save operation using the FUNC key.

Save event data Edge The event data being recorded is saved to the
internal memory as a file.
This is the same function as the data save
operation using the FUNC key.

Message Edge Writes a message.
This action can be executed while memory
sampling is in progress.

Snapshot Edge Saves the screen image data.

Switch the display rate Level Toggles between the trend interval and the
secondary trend interval.
This action is valid when the DX is configured to
use trend interval switching.

Manual sample Edge Executes manual sampling.

Reset the relative timer Edge Resets the relative timer. The timer restarts from
that point.

Switch the display group  Edge Switches the display group when the trend, digital,
or bar graph is displayed.

Flag™* Level The flag is zero for normal conditions and 1 when

an event occurs. The flag can be written in a
calculation expression of a computation channel.

Load the setup Edge Loads the setup data file in the root directory of the
CF card into the DX and updates the DX settings.
See below.

Adjust the time Edge Synchronizes the time to the nearest hour. See the
next page.

* For a description of level and edge, see “Miscellaneous” in this section.
**An option.

Resetting the Relative Timer

If the event is set to output relay, internal switch, match time timer, or alarm, the
resetting of the timer is not considered a timeout. (The action is not executed even if
the timer is used as an event.)

Loading the Setup

Can be specified as an action only when the event is set to remote control input.
Loads the setup data file, LOAD1.PDL, LOAD2.PDL, or LOAD3.PDL, in the root
directory of the CF card into the DX and updates the DX settings.

You must create a setup file and save it to the CF card in advance.

IM 04L42B01-01E
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1.6 Event Action Function

Event Trigger Operation

When the event is set to output relay, internal switch, or alarm

If the output relay is activated, the internal switch is 1, or the alarm is occurring during
memory sampling, the event trigger is always activated. However, the number of times
the trigger is activated depends on the event data mode (single or repeat).

Time Adjustment

Time adjustment can be specified as an action only when the event is set to remote
control input. The internal clock of the DX is adjusted to the nearest hour through
remote control input.

¢ Operation When Memory Sampling Is Stopped
Difference from the Nearest Hour Operation
00 min 00 s to 01 minto 59's  Truncates the minutes and seconds.
Example: 10 hours 01 min 50 s becomes 10 hours 00 min 00 s.
02 min 00 s to 57 minto 59 s  The time is not changed.
58 min 00 s to 59 minto 59 s  Rounds up the minutes and seconds.
Example: 10 hours 59 min 50 s becomes 11 hours 00 min 00 s.

¢ Operation during Memory Sampling
If the time difference between the time the remote control signal is applied and the
nearest hour is within the preset time, the time is gradually corrected. Otherwise,
the time is corrected immediately. For details, see section 10.1.

Miscellaneous
Limitations on the Combinations of Events and Actions
The combinations that are checked in the table below can be used.
Event Remote | Output | Internal Timer Match Alarm | User Key
Action Relay Switch Timer
Alarm ACK v v v v
Reset the relative timer v v v v v v
Load the setup v
Adjust the time v
Other actions v v v v v v v
e Level and Edge
The combinations of events and actions are summarized in the figure below.
Type Operation
Event
Edge Edge
Level
Action Status 1
Level Edge
Status 2 Operation Operation
executed executed
Level and Edge of the Remote Control Input Signal
Level Edge
ON l
y OFF L
—>H<—250 ms or more
For contact inputs, the remote signal rises when the contact switches from open to
closed and falls when the contact switches from closed to open. For open collector
signals, the remote signal rises when the collector signal (voltage level of the remote
terminal) goes from high to low and falls when the collector signal goes low to high.
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1.7  Security Function

Key Lock Function
Key lock is a function that prohibits key operations. You enter a password to release the

key lock.
For the setting procedure, see section 8.1.
Key Lock Items Description
Keys The following keys can be locked independently.

START key, STOP key, MENU key, USER key, DISP/
ENTER key (prohibits switching the operation screen),
and Favorite key.
Access to the storage medium Prohibits all operations listed below.
* Manually save the data
* Load the display data and event data files
+ Save/Load setup data files
+ List the files on the storage medium
» Delete the files on the storage medium
» Format the storage medium
Function operation The following FUNC key operations can be locked
independently.

* [Alarm ACK]

* [Message], [Free message], [Batch],
[Add Message], [Add Free Message]
[Text field]

» [Math start], [Math stop], [Math reset],
[Math ACK]

» [Save display], [Save event],

[Manual sample], [Trigger],
[Snap shot], [Timer reset], [Save stop]

* [E-Mail start], [E-Mail stop], [FTP test],

Operations to [Request] or [Release] network
information

» [SNTP], time setting (operation in the setting mode)
» [Favorite regist], [4panel], [Standard display],
[Second speed], [Normal speed]
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1.7 Security Function

Login Function

Only registered users can operate the DX. Access from communication functions can
also be limited to users registered here.
For the setting and operating procedure, see sections 8.2 and 8.3 respectively.
* Login and Logout
You enter your user name and password to log into the DX in the following cases.

Method of Accessing the DX Login Required

Keys »  When the power is turned ON
»  When logging in after exiting the basic setting mode
» When logging in after logging out

Communication When accessing the setting/measurement server, FTP
server, maintenance/test server, or Web server.

Auto Logout (When Logged in Using Keys)

When logged in using keys, you are automatically logged out when there is no key
operation for a specified time. If you are automatically logged out from the setting
mode, the setting changes are cancelled. You are not automatically logged out during
basic setting mode.

Operations That Can Be Carried Out When Logged Out
When logged out, you can switch the operation screen using the DISP/ENTER key,
arrow keys and Favorite key.

e User Levels

A user can be an “administrator” or a “user.”

Administrator

Administrators can perform all operations on the DX. At least one administrator must
be registered to use the login function.

Item Description
Number of users that 5
can be registered

Range of operations All operations.

Login method Select key operation, via communication, or Web server login.
ID information User name and password

User

Item Description

Number of users that 30
can be registered
Range of operations Key operations

Operation Limitation
Basic setting mode Not allowed
Setting mode Customize menus Not allowed
Other Specified by user privileges
Operation mode |Key operation Specified by user privileges

* User privileges
You can set operation privileges for each user.The privileges are
the same as with the key lock function.
Operations via communication
See the Communications Interface User’s Manual.
Login method Select key operation, via communication, or Web server login.
ID information User name and password
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1.8

Computation Function
Equations can be defined in computation channels by using the measured data or
computed data as variables. The result of the computation can be displayed or stored.

For the setting procedure, see section 9.1.
¢ Channels Dedicated to Computations

Computation and Report Function (/M1 and
/PM1 Options)

Model Number of Channels Channel Numbers
DX2004, DX2008 12 101 to 112
DX2010, DX2020, DX2030, DX2040, DX2048 60 101 to 160

¢ Computation Types

In the table below, [001] represents the measured value of channel 001.

Type Example Description of the Example
Four arithmetic 001+002 Determines the sum of [001] and [002].
operation 001-002 Determines the difference between [001] and [002].
001*002 Determines the product of [001] and [002].
001/002 Divides [001] by [002].
Power 001**002 Determines [001] to the power of [002]. y = X"
Square root SQR(001) Determines the square root of [001].
Absolute value ABS(001) Determines the absolute value of [001].
Common logarithm  LOG(001) Determines the common logarithm of [001]. y =
log1ox
Natural logarithm LN(001) Determines the natural logarithm of [001]. y = Inx
Exponent EXP(001) Determines e to the power of [001]. y = "
Relational 001.LT.002 The result is 1 when [001] is less than [002] or O
computation otherwise.
001.LE.002 The result is 1 when [001] is less than equal to [002]
or 0 otherwise.
001.GT.002 The result is 1 when [001] is greater than [002] or O
otherwise.
001.GE.002 The result is 1 when [001] is greater than equal to
[002] or O otherwise.
001.EQ.002 The result is 1 when [001] is equal to [002] or O
otherwise.
001.NE.002 The result is 1 when [001] is not equal to [002] or O
otherwise.
Logical computation 001AND002 The result is 1 when [001] and [002] are nonzero or
0 otherwise.
0010R002 The result is 1 when [001] or [002] or both are
nonzero or 0 otherwise.
001XOR002 The result is 0 when [001] and [002] are nonzero or
1 otherwise.
NOTO001 The result is 1 when [001] is zero or 0 otherwise.

TLOG computation*

TLOG.SUM(001)

Determines the sum of [001].

TLOG.MAX(001)

Determines the maximum value of [001].

TLOG.MIN(001)

Determines the minimum value of [001].

TLOG.AVE(001)

Determines the average value of [001].

TLOG.P-P(001)

Determines the difference between the maximum
value and minimum value of [001].

*

Usage is explained on page 1-42.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

Type

Example Description of the Example

CLOG computation

CLOG.SUM(001.002.003)
Determines the sum of [001], [002], and [003].

CLOG.MAX(001.002.003)
Determines the maximum value among [001], [002],
and [003].

CLOG.MIN(001.002.003)
Determines the minimum value among [001], [002],
and [003].

CLOG.AVE(001.002.003)
Determines the average value of [001], [002], and [003].

CLOG.P-P(001.002.003)
Determines the difference between the maximum
value and the minimum value among [001], [002], and
[003].

Special computation

PRE(001) Determines the previous value of [001].

101=HOLD(001.GT.K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried
out to derive the computed value. When [001] exceeds
K01, the previous computed value is held.

K01

Description
HOLD(a):b When a is zero, b is carried out to derive the computed
value. Otherwise, the previous computed value is held.

RESET(101.GT.K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried
out to derive the computed value. When [101] exceeds
K01, the previous computed value is reset, and TLOG.
SUM(001) is carried out.

K01 lsset
I H N
Description

RESET(a):b When ais zero, b is carried out to derive the computed
value. Otherwise, the previous computed value is
reset, and b is carried out to derive the computed
value.

CARRY(KO01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried
out to derive the computed value. When the computed
value is greater than or equal to K01, the computed
result is the excess (computed value — KO1).

K01

Description

CARRY(a):b Only TLOG.SUM can be specified for b. If the
computed value X of b is less than a, the computed
result is X. If X is greater than or equal to a, the
computed result is the excess (X — a).

Conditional equation

[001.GT.K01?001:001+002]
When [001] is greater than K01, the computed value
is set to the value of [001]. Otherwise, the computed
value is set to the value of [001] + [002].

Description

[a?b:c] If the computed result of a is nonzero, b is carried out.
Otherwise, c is carried out.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

¢ Data That Can Be Used in Equations

The data listed below can be used.

Data Notation Description

Measurement channel data 001, etc. Specify the computed data using a channel number.
Computation Channel data* 101, etc. Specify the computed data using a channel number.
External input channel data* 201, etc. Specify the computed data using a channel number.
Constant KO01to K60  Avalue.

Communication input data  C01to C60 Data set through communications.

Status of the remote control* D01 to DO8** The value is 1 when the remote control input is

input ON or 0 when it is OFF.

Pulse input* P01 to P08** Counts the number of pulses per scan interval.
Q01 to Q08** Counts the number of pulses per second.

Internal switch status S01t0S30 1or0.

Alarm output relay* status 101 to 136 The value is 1 when activated or O when deactivated.

Flag FO1 to FO8 1 or 0. Set the flag using the event action function

(see section 1.6).

*

An option. ** Values such as 01 are terminal numbers.

Only the data that are checked in the table below can be used in TLOG, CLOG, and
PRE.

Data | Meas.| Comp.|Ext. Constant | Comm. |Remote| Pulse |Internal| Relay | Flag
Comp. Type CH CH Input CH Input Switch
TLOG v v v v v v v
CLOG v v v
PRE v v v v v v v
Other computations v v v v v v v v v v

Example: TLOG.SUM(S01), CLOG.AVE(001.002.K01), and PRE(S01) are not allowed.

Processing Order of Computation

Computation is processed in order from the smallest event action number for each
scan interval.

Example: If you specify 102 = 101 + 103, the value of the previous scan interval is
used for the 103 value.

Handing of the Unit in Computations
In computations, measured values are handled as values without units. For example,

if the measured data from channel 001 is 20 mV and the measured data from channel
002 is 20 V, the computed result of 001 + 002 is 40.

Displaying the Computed Data

The computed data is displayed by setting a measurement span for each computation
channel. Computation channels can be displayed on various operation screens in the
same fashion as the measurement channels.

For the setting procedure, see section 9.3.

Alarm

Up to 4 alarms can be assigned to each computation channel. The alarm types are
high limit alarm (H), low limit alarm (L), delay high limit alarm (T), and delay low limit
alarm (t).

Saving Computed Data
As with the measured data, the computed data can be saved to display data, event
data, manual sampled data, and report data.

Computation Data Dropout

A computation data dropout occurs if the computation is not completed within the scan

interval. For the operating procedure, see section 9.4.

* The computation icon in the status display section turns yellow.

*  When a computation data dropout occurs, the computed data of the scan interval in
which the dropout occurred is set to the data immediately before the dropout.

« If computation data dropout occurs frequently, lessen the load on the CPU by
reducing the number of computation channels or setting a longer scan interval.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

* Numeric Display and Recording

The range of displayed values of computed data is from —9999999 to 99999999
excluding the decimal point. The decimal place corresponds to the decimal place of
the lower limit span of the computation channel. On the numeric display, values are
displayed if the computed result is within the above range regardless of the upper and
lower limits of span. The following table indicates special displays.

Display/Recording Computed Data Status

+Over » +Display over: When the computed result exceeds 99999999

» +Computation over: When the value exceeds approximately 3.4x
10*® in the middle of the computation

»  When a computation error* occurs (select +Over or —Over.)
—Qver » —Display over: When the computed result is less than —9999999

» —Computation over: When the value is less than approximately —3.4
x10% in the middle of the computation

»  When a computation error* occurs (select +Over or —Over.)

Computation error occurs when the following computation is carried out.
+  X/0, SQR(—X), or LOG(—X)
» If a channel number set to skip or Off is used in the equation

Rolling Average

The rolling average of the computed result of the equation specified for the
computation channel is determined, and the result is the computed data for that
channel. The number of samples and the sampling interval can be specified for each
computation channel. The rolling average is applied over the time corresponding to “the
number of data samples x the sampling interval.” The maximum sampling interval is 1
hour, and the maximum number of samples is 1500.

Starting the Computation
You can configure the DX to start the computation when you press the START key.

Usage of TLOG Computations

TLOG computation determines the sum, maximum, minimum, average, or the
difference between the maximum and minimum of a specific channel for each interval
determined by a timer.

Timers That Are Used

The timer that is used is assigned to each channel.

Unit of Sum Computation
Set the sum scale when using sum computation (TLOG.SUM).
Select Off, /s, /min, or /h. For details, see the next page.

Resetting the TLOG Computed Value
You can select whether to reset the TLOG computed value at each interval. The figure

below illustrates the reset operation for sum computation (TLOG.SUM).
Example: Result of the TLOG.SUM computation

Timer timeout 1 2 3

Reset Reset Reset
Reset: On W
Reset: Off

When reset is On, the sum value is calculated over each interval. When set to Off, the
sum value from computation start is calculated.

Power Failure Operation, Handling of Error Data, and Handling of

Overflow Data
See page 1-42.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

Report Function

This function is used to create hourly, daily, weekly, and monthly reports.

Report Data Types
You can select from four types among maximum value, minimum value, average
value, sum value, and instantaneous value.

Report Type

Type Description

Hourly report Creates report data every hour on the hour for the previous one hour.

Daily report Creates report data every day at a specified time for the previous one day.

Weekly report Creates report data every week at a specified time at a specified day of
the week for the previous one week.

Monthly report Creates report data every month at a specified time at a specified day for

the previous one month.

Combinations of Reports That Can Be Created
You can select from hourly reports only, daily reports only, hourly and daily reports,
daily and weekly reports, and daily and monthly reports.

Source Channels
You can select from measurement channels, computation channels, and external input
channels. The report data are not created for channels that are set to Skip or Off.

Model Number of Report Channels
DX2004 and DX2008 12
DX2010, DX2020, DX2030, DX2040, and DX2048 60

Unit of Sum Computation

In the sum computation, data are summed over the scan interval. However, for flow
values that have units /s, /min, /h, or /day a simple summation results in the actual
value not matching the computed result, because the scan interval and the unit of the
input values are different. In such cases, set the sum scale to match the unit of the
input value. In effect, the sum value with the same unit as that of the input value is
calculated.

For example, if the scan interval is 2 s, and the input value is 100 m®/min, a simple
summation would add 100 every 2 s resulting in 3000 after one minute. However, if
the sum scale is set to /min, then 2 s/60 s is multiplied every scan interval before the
value is added giving a result that has an m>/min unit.

The following converting equations are used to compute the sum. The unit of the scan
interval is seconds.

Off: >(measured data every scan interval)

Is: >(measured data every scan interval) x scan interval
/min:  ¥(measured data every scan interval) x scan interval/60
/h: >(measured data every scan interval) x scan interval/3600

/day: X(measured data every scan interval) x scan interval/86400

Displaying the Report Data
You can display the report data using keys.
For the operating procedure, see section 4.5.

Saving the Report Data
See section 1.4, “Data Storage Function.”

Numeric Display and Recording

The numeric range of the report data is from —9999999 to 99999999 excluding the
decimal point.

For the data handling of special cases, see page 1-42.

For details on the report file format, see appendix 3.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

Special Data Handling

This section explains the handling of special data in TLOG computation, CLOG
computation, and reports.

* Power Failure Operation (TLOG and Reports)

If a power failure occurs when the report function is enabled or in the middle of the
TLOG computation, the report operation and TLOG computation resume when the
DX recovers from the power failure. The operation varies depending on whether the
DX recovers from the power failure before or after the time to create a report or TLOG
data.

Time of Recovery Operation

After the time to create the data The report or TLOG data is created immediately after the
DX recovers. The measured data up to the time of the
power failure is used. At the time the next report or TLOG
data is created, the data after the recovery is used.

Before the time to create the data  After the DX recovers, report or TLOG data is created at
the normal time to create the data. The measured data
excluding the power failure period is used.

Error Data Handling (TLOG, CLOG, and Reports)

If an error occurs in the channel data, the error data is discarded, and the computation

continues. If all the data are in error, an error results.

The following types of data are considered error data.

* Channels set to skip or Off.

» The measured result on a measurement channels is error (A/D converter failure,
etc.).

» The computed result on a computation channel is error.

* The input of the measurement channel is in a burnout condition.

» The external input channel is Off or there is no data (communication failure, etc.)

Handling of Overflow Data*
* Refers to over range on a measurement channel, computation overflow on a computation
channel, and over range of an external input channel.
For TLOG, CLOG, and Reports
When the channel data is overflow data, the DX handles the data as follows:

Computation Type Description
Average value or sum Set the handling to ERROR, SKIP, or LIMIT.

value ERROR: Considers the data to be a computation error.
SKIP: Discards the overflow data and continues the computation.
LIMIT: Replaces the data with the limit value and continues the
computation.

The limit value is the span upper or lower limit or the scale
upper or lower limit of the channel.
Maximum, minimum,  Set the handling to OVER or SKIP.
Maximum — minimum  OVER: Computes by using the overflow data.
SKIP: Discards the overflow data and continues the computation.

For Multiplication and Relation Computation EQ and NE
Computation Type Computation Computed Result
Multiplication 0*(+Over)
0*(—Over)
(+Over)*0
(=Over)*0
EQ. (+Over).EQ.(+Over)
(—Over).EQ.(—Over)
).
).

.NE. (+Over).NE.(+Over)
(—Over).NE.(—Over)

===l (== =]
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1.9 FAIL/Status Output Function (/F1 and /F2
Options)
FAIL Output

When a failure occurs in the CPU of the DX, a relay contact signal (1 signal) is output.
The relay is energized when the CPU is normal and de-energizes when a CPU failure
occurs. Therefore, relay output is carried out also when the power is turned OFF (including
a power failure). You cannot change this behavior.

Relay Operation

N LA LA

NO Cc NC NO Cc NC NO Cc NC

During normal operation When a failure occurs When power is turned OFF
* NO: Normally Opened, C: Common, NC: Normally Closed

If a failure occurs, contact your nearest YOKOGAWA dealer for repairs.
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1.9 FAIL/Status Output Function (/F1 and /F2 Options)

Status Output

Outputs the status below with a relay contact signal (1 relay). You can select whether
each status is output to the relay. The relay is energized when the status occurs. You
cannot change this behavior.

For the setting procedure, see section 2.9.

Status Description Corrective Action

Status of the internal  Error in the internal memory. Contact your nearest

memory or CF card YOKOGAWA dealer for
repairs.

When the auto save function to the CF card is On.

» The free space on the CF card dropped  Replace the CF card.
to 10% of the total size (only when
the media FIFO (see section 1.4) is
disabled).

e Errorin the CF card. * Replace the CF card with
a normal one.
» Format the CF card on
the DX (the data on the
CF card will be erased).

However, the status of the internal memory Insert a CF card.
is output when the CF card is not inserted.
* 10 MB or less of available space*
remaining in internal memory.
* The number of files in internal memory
for which Auto Save to the CF card has
not been completed has exceeded 390.

When the auto save function to the CF card is Off.

* 10 MB or less of available space* Save the data in the internal
remaining in internal memory. memory to the CF card.

* The number of files in internal memory
for which Manual Save has not been
completed has exceeded 390.

Measurement error Error in the A/D converter. Contact your nearest
Burnout is detected. YOKOGAWA dealer for
repairs.

Replace the thermocouple
that has burned out.
Communication error A Modbus master or Modbus client Check the error in the
communication error occurred. Modbus master or Modbus
client screen and carry out
the corrective action.

Failed the FTP file transmission. Check the FTP log and carry
out the corrective action.
Memory stop When the memory sampling is stopped. Start the data acquisition.

* The internal memory’s “available space” refers to the following quantities.
¢ Unused regions
» Regions of data for which Auto Save or Manual Save (see page 1-26) has been completed.

Relay Operation

NO Cc NC NO C NC NO Cc NC

During normal operation When specified status occurs When power is turned OFF
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1.10 Other Functions

Time Related Functions

Time Correction
The DX internal clock can be changed in the following manner.

Method Description

Key operation Sets the DX internal clock to the specified time.

Event action function Synchronizes the DX internal clock to the nearest hour.

SNTP client function Sets the DX internal clock to the time retrieved from an SNTP
server.

Time Correction Operation
The time correction operation varies depending on whether the memory sampling is in
progress or not.

Status Operation
Memory sampling stopped The DX internal clock is changed immediately.
Memory sampling The DX internal clock is gradually corrected. While the time is

being gradually adjusted, the date/time in the status display

section is displayed in yellow.
Operation of Gradually Correcting the Internal Clock
If the time deviation between the time of the DX internal clock and the correct time (the
specified time) is within a specified value, the DX clock is adjusted gradually at 40 ms
for each second. Otherwise, the clock is corrected immediately. The maximum value
of time deviation (tm in the figure below) can be selected in the range of 10 s to 5 min.

Time when the remote control

Time specified using keys or signal is applied

Time on retrieved from an SNTP server Nearest (Time on the DX)

the DX J7 hour J7
! A 4 ! > ! A 4 ! >
I I i [ |[N——— ”

Time deviation Time deviation

tm tm tm tm
Range in which the time is gradually Range in which the time is gradually
adjusted adjusted

Example:  When changing the time to 12 hours 55 minutes 35 seconds when the
internal clock is 12 hours 55 minutes 32 seconds
The time deviation of 3 seconds is adjusted 40 ms per second. The
internal clock will be synchronized to the specified time 75 seconds later.

Date Format

You can select the display format of the data from “2005/09/28,” “09/28/2005,”
“28/09/2005,” and “28.09.2005.”

For the setting procedure, see section 2.4.

Time Zone
Set the time difference between the location where the DX is used and GMT.
For the setting procedure, see section 2.2.

DST

If the DX is used in a region that has DST, the time is switched automatically between
DST and standard time by setting the date/time when switching from the standard
time to DST and the date/time when switching back from DST to standard time.

For the setting procedure, see section 2.1.
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1.10 Other Functions

System Display
Displays the total number of inputs on the DX, the size of the internal memory, the
communication functions, the external storage drive, the options, the remote controller
ID, the MAC address, and the firmware version number.
For the operating procedure, see section 2.5.

Language
The displayed language can be set to English, Japanese, German, French, or, Chinese.
For the setting procedure, see section 2.6.

VGA Output Terminal (/D5 Option)
Shows the DX display on a monitor through the RGB output.

24 VDC Power Supply for Transmitter (/TPS4 or /TPS8 Option)
Provides 24-VDC power supply to up to four (/TPS4) or eight (/TPS8) two-wire system
transmitters. The measured values of the transmitter correspond to a current signal of
4 to 20 mA on the same cable. Therefore, the signal can be connected to the DX input

terminal and displayed.
DX

Current
—_—

Transmitter power

supply output terminal Transmitter

Input terminal
Shunt resistor: 250 Q

Easy Text Entry Option (/KB1 and /KB2 Options)
You can control the DX using the keys on the remote control terminal.
» Set the remote controller ID on the DX and the ID number on the remote control
terminal to the same value.
* You can set a value between 0 and 31 for the remote controller ID and ID number.
» By changing the ID number on the remote control terminal, you can control DXs with
different remote controller IDs from a single remote control terminal.

/

./

%

AU

=
N

)

Infrared signal
output section

<o

‘f ’_
N AN 7

Light-receiving A
section
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1.10 Other Functions

USB Interface (/USB1)

You can connect a keyboard or USB flash memory to the USB port on the front and rear

panels of the DX.

* You can use a keyboard to control the DX.

* You can save measured data and setup data to the USB flash memory and also load
from it.

Connectable devices: 109/104 keyboard and USB flash memory

For the operating procedure, see sections 2.11 and 2.12.

External Input Channels (/MC1)

Temperature Unit

These channels handle measured data of other devices that is read with the
communication function. There are 240 channels available. As with measurement
channels, the data of these channels can be displayed and saved.

For the setting procedure, see sections 10.1 and 10.2.

You can set unit when measuring temperature with the thermocouple or RTD to °C or °F.
For the setting procedure, see section 3.3.
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Chapter2 Common Operations

2.1 Setting the Date/Time

Setup Screen

Set the date/time. If you are using the DX in a region that uses DST, specify the date/time

for switching between DST and standard time.

Date/Time
Press MENU (switch to the setting mode) and select Date/Time > Date &
Time

GROUP 1 =
o182 16:57:54 e 01> I Zhor  (S) o)

Setting menu

Heas channel Mol iakt Canina Tina
Hath channel 1

Ext. channel | [(5/18/22 16:57:52
Display r

Group set, Trip line
Message

Tiner. Event action
Data save

Save/Load

vy v v v

Henu customize

DST
Press MENU (switch to the setting mode) and select Date/Time > Daylight
Saving Time

GROUP 1 = ,
Shobrao/on 15:45:25 el DI NN win ()

Date/time > Davlisht savings time

r Daylight savings time

Use/Not | Use |
Start time :
Honth APR
Day order 1st
Weekday SUN
Hour of the day 2
End time
Honth ocT
Day order Last
Weekday SUN
Hour of the day 1
| Use | Mot |
Time set

Enter the date and time and press DISP/IENTER.

Daylight savings time > Use/Not

To switch between DST and standard time, select Use.

Daylight savings time > Start time

Specify the date/time to switch from standard time to DST. Set the month, the nth
week, the day of the week, and the time.

Daylight savings time > End time

Specify the date/time to switch from DST to standard time. Set the month, the nth
week, the day of the week, and the time.
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2.2 Setting the Time Difference from GMT

Set the time zone of the region in which the DX will be used. Make sure to set this value
if you are using the Internet network functions or the DST function.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Time settings

Time settings

Date & Tine —_—
Tine zone(HHHH)
Tine deviation limit s
Date format Y/HD

Date & Time > Time zone

Set the time zone of the region in which the DX will be used in terms of the time
difference from GMT. Specify a value in the range of —1300 to 1300 (where the first
two digits denote the hour and the last two digits denote the minute). A negative value
indicates that the local time is behind the GMT.

Example: The standard time in Japan is ahead of the GMT by 9 hours. In this case,
enter “900.”

2-2
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2.3 Setting the Time Correction Operation during
Memory Sampling
This function gradually corrects the time when the time is changed while Memory
Sampling is in progress.
For a description of the time correction operation, see section 1.10.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Time settings

Basic Setting Mode

Date & Tine
Time zone{HHHM} 908

Tine deviation limit [IIDELCINN
Date format Y/i/D

0ff 18s 2Bs 3Bs Inin 2min  |Next 1/2

Time deviation limit

Current time ﬁSpecified time
| AV I

|
—_——
| Time deviation limit |

When the time deviation between the time on the DX and the specified time is within
*(the value specified here), the time on the DX is gradually corrected. Otherwise, the
clock is corrected immediately.

Settings Description
10 s to 5 min The time deviation limit.
Off Disables the function that gradually corrects the time.

Example: If Time deviation limit is set to 10s and the time on the DX is 10 hours 21
minutes 15 seconds, the time on the DX is gradually corrected if the specified time is
between 10 hours 21 minutes 5 seconds and 10 hours 21 minutes 25 seconds.

IM 04L42B01-01E
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24 Setting the Date Format

Select the display format of the date.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Time settings

Basic Setting Mode

Time settings

Date & Time

Time zoneHHHH) 900
Time deviation limit 3ds
Date format

Y/H/D H/DAY D/NAY D.M.¥

Setup Items

¢ Date format

Settings Display Example
Dates other than the grid time of Time at the grid position in the
the trend display trend display (example: 8 O’clock
on Nov. 30)*
Y/M/D 2005/11/30 11/30 08
M/D/Y 11/30/2005 11/30 08
D/M/Y 30/11/2005 30/11 08
D.M.Y 30.11.2005 30.11 08

*

Only if the trend interval is set greater than or equal to 1 h/div. A function available on DXs
with release number 2 or later.

Applied Range

The format is applied to the date displayed on the screen. It does not change the

date format on the setup screen of the date/time, the date in the output data via
communications, the date saved along with the data, and the date used in the data file
names.
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2.5

Procedure

Explanation

Viewing the DX Information

Show the DX information on the system information screen and the network information

screen.

* Displaying System Information Screen

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the System info soft key.
The system information screen is displayed.
¢ Displaying Network Information Screen

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Network info soft key.
The network information screen is displayed.

¢ System Information Screen

SYSTEN INFO. r=] .
Subar 0/ is:06:08 (e} 01PN Snin =]
ANALOG: 48(C) MATH: 68 EXTCH: 240

Y ( ANALOG
Number of measurement channels

HEMORY: 88HB

(C) denotes the clamped input

RS-422/485
ALARM B.6.8.8 SPECIAL INPUT
REHOTE CAL CORRECT

terminals (/H2 option)
MATH
Number of computation channels
(/M1 and /PM1 options)
EXTCH
Number of external input channels
 (/MC1 option)

REMOTE CONTROLLER 1D : 2 MEMORY
Internal memory size
PRODUCT:
MAC address B:6D:64:88:25:F4 | OPTIONs
Version 1.81
f Remote controller ID

(/KB1 and /KB2 options)

¢ Network Information Screen

MAC address
Version
Firmware version

The following values set on the DX are displayed.
|P address, MAC address, DNS server, host name, and domain name

NETWORK, INFO. P= _
2605/10/28 13:26:46 oisP I i ()

IP address
Subnet mask
Default sateway :
HAC address : B8:80:64:88:25:F4
DNS server
Prinary
Secondary

=0
=@
oo
=2

Host name
KRHRRE-HR

Domain name
XK. KXKH. net
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2.6

Changing the Displayed Language

Set the displayed language.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > Operating Environment

Environment > Operating environment

Operating environment

Tag/Channel Tag
Language
Remote Controller ID off
Temperature ¢

English |Japanese | German | French | Chinese

* Operating environment > Language
Set the displayed language to English, Japanese, German, French, or Chinese

2-6
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2.7 Setting the LCD Brightness and Backlight
Saver

Change the LCD brightness. In addition, set the backlight saver function to prolong the
service life of the LCD backlight.

Setup Screen

Press MENU (switch to the setting mode) and select Display > Trend, Bar
graph, LCD, Monitor

GROUP 1 P=
102z te5as o D1 N 2or (5] +)

Display > Trend. Bar graph, LCD. Honitor

Trend —_— F LCD —_—
Direction Horizontal Brightness [
Trend clear Off Backlight saver
Message direction Horizontal Hode Dimmer
Scale Saver time 1h

Digit Normal Restore KewtAln
Value indicator Hark
Trend line 2 dot | _ Honi tor
Grid futo  div
Background
B h Display White
=P eRd Historical trend Black
Direction Vertical Scroll time 1065
Jump default display off

e LCD > Brightness
Select a value from 1 to 6 (2 by default). Larger the value, brighter the display
becomes.

e LCD > Backlight saver > Mode

Settings Description

Off Disables the backlight saver

Dimmer Dims the display if there is no operation for a given time.
Timeoff Turns the backlight OFF if there is no operation for a given time.

e LCD > Backlight saver > Saver time
Select a value from 1 min to 1 h. If the specified time elapses without any key
operation or alarm occurrence, the LCD backlight switches to the specified mode.

* LCD > Backlight saver > Restore

Settings Description
Key The backlight returns to the original brightness when a key is pressed.
Key+Alm The backlight returns to the original brightness when a key is pressed or

when an alarm occurs.

Nofte
» If the backlight is dimmed or turned OFF by the backlight saver function, pressing any key
on the DX causes the backlight to return to the original brightness. In this operation, the key
does not perform its intended function.
» The degradation of the brightness and the discoloration of the screen (become yellowish)
tend to progress faster as the brightness is set higher. Extended use at an unnecessary high
setting should be avoided. It is also recommended that you use the backlight saver function.
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2.8 Initializing Settings and Clearing the Internal
Memory

Initialize the settings to default values. In addition, clear the data in the internal memory.
For the default settings, see the DX2000 Operation Guide (IM04L42B01-02E).

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to

the basic setting mode), and select Load settings, Initialize > Initialize

Load settings. Initialize > Initialize

Initialize
(Kind

Initialize contents

Clearl : Setup settings + Settings + Measurebfiath data
Clear2 : Settings + Heasurebtath data
Cleard : MeasurelHfath data

Clear 1 | Clear 2 | Clear 3

¢ [|nitialize

Settings Description

Clear 1 Initializes the settings of the basic setting mode and setting mode and
clears the data in the internal memory.

Clear 2 Initializes the settings of the setting mode and clears the data in the
internal memory.

Clear 3 Clears the data in the internal memory.

e Data in the Internal Memory That Is Cleared
Display data, event data, manual sampled data, report data (/M1 and /PM1
options), and log information.

Procedure

1. Press the Clear 1, Clear 2, or Clear 3 soft key.

Press DISP/ENTER.
A confirmation window opens.

3. Select Yes and press DISP/ENTER.
The specified operation is executed, and the DX returns to the operation mode.
If you do not want to initialize, select No and press DISP/ENTER.
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2.9 Outputting the DX Status via the Relay Contact
(/F1 and /F2 Options)

Setup Screen

Procedure

A signal is output to a dedicated relay when an error occurs in the DX CPU. In addition, a
signal is output to a different relay when the a specified status occurs.
For a description of the FAIL/status output function, see section 1.7.

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Status relay

Basic Setting Mode

Status relay

Hemory/Hedia status
Heasurement error Off
Comnunication error Off
Hemory stop off

Memory/Media status
On: Outputs the internal memory and CF card statuses to the relay.

Measurement error
On: Outputs a relay signal when a measurement error occurs.

Communication error
On: Outputs a relay signal when a communication error occurs.

Memory stop
On: Outputs to the relay when the memory sampling is stopped.

FAIL Output

There are no settings or operations that are required. A signal is output to the relay
contact when a CPU error is detected. A signal is also output to the relay contact when
the DX is turned OFF.

Status Relay
A signal is output to the relay contact when a specified status occurs.

IM 04L42B01-01E

suonesadQ uowwo9n n



2.10 Controlling the DX with the Remote Control
Terminal (/KB1 and /KB2 Options)

Handling Precautions

Preparing the DX

If the infrared signal output section of the remote control terminal or the light-receiving
section on the DX becomes dirty or receives scratches, it can hinder the transmission/
reception of the infrared signal. Clean the infrared signal output section of the remote
control terminal or the light-receiving section on the DX.

When cleaning, wipe using a dry soft cloth. Do not use chemicals such as benzene or
thinner, since these may cause discoloring and deformation.

Do not apply shock to the remote control terminal.

Do not operate the remote control terminal with wet hands.

The transmission/reception sensitivity of the infrared signal may deteriorate if used in
the following types of locations.

» Location where the receiver of the DX is exposed to direct sunlight or fluorescent lamp.
* Near magnetic field sources such as a transceiver.

If you carry the remote control unit in your pocket, for example, keys may be pressed
unintentionally and cause the DX to be controlled. Handle the remote control terminal
properly so that keys are not pressed inadvertently.

When you are near the DX, press the keys on the remote control terminal only when
controlling the DX. If you are going to press the keys on the remote control terminal
but do not wish to control the DX, take measures so that the signal does not reach
the DX such as by covering the infrared signal output section of the remote control
terminal.

The distance at which the DX can be controlled using the remote control terminal
varies depending on the operating environment such as the battery voltage and the
presence or absence of external light.

There is a possibility that DXs with the same remote controller ID be controlled
simultaneously. It is recommended that different remote controller IDs be set on each DX.

Set the remote controller ID.
e Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > Operating Environment

thernet

Environment > Operating environment

Operating environment

Tag/Channel Tag
Language English

Renote Controller ID
-

Tenperature ¢

0ff [ 1 2 3 4 Next 1/6

Remote Controller ID
Select the remote controller ID from 0 to 31. When not using the remote control
terminal, select Off.

¢ Checking the Remote Controller ID

You can check the DX remote controller ID on the system information screen.
See section 2.5.
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2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

Preparing the Remote Control Terminal
Names of Parts

Battery cover

Infrared signal
output section

* Loading Batteries

1. While pressing the projection
on the battery cover, open
the cover.

2. Load the batteries.
3. Close the battery cover.

Setting the ID Number

Set the ID number of the remote control terminal to match the remote controller ID of
the DX that you are to operate.

The ID number of the remote control terminal is not displayed anywhere. If you are
not sure which ID number the remote control terminal is set to, set the appropriate 1D
number according to the following procedure.

1. Press ID.

2. Enter the ID number (0 to 31) by pressing the keys
from 1 (A1) to 0 (NO).
Example For ID number “16”
Operation: Press 1 (A1) and 6 (G6).

3. Press ID.

Note

» If you enter an ID number other than 0 through 31, the ID number retains the original setting.

* Pressing the ID key once causes the remote control terminal to enter the ID number setup
mode. If none of the keys on the remote control terminal is pressed for 8 s, the remote
control terminal automatically exits from the ID number setup mode. In this case, the ID
number of the remote control terminal retains the original setting.

» If you remove the batteries, the ID number is reset to 0. After loading the batteries, set the
appropriate ID number again.

Affixing the ID Number Label

If you are using the remote control terminal with a fixed ID number (such as when
there is a one-to-one correspondence between the DX to be controlled and the remote
control terminal), you can enter the ID number on the label and affix the label on the
remote control terminal.

Affix the ID number label on the battery cover
of the remote control terminal.

IM 04L42B01-01E

211

suonesadQ uowwo9 ﬂ



2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

Controlling the DX
Control the DX by pointing the infrared output section of the remote control terminal to
the light-receiving section on the DX. Control the DX while checking the results on the
DX screen.
Note

» The remote control terminal cannot be used to control the Favorite key.

*  When a specific key operation is possible on the DX, the corresponding key on the remote
control terminal is activated. For example, the operation for entering a character string is
activated when a window for entering a character string is displayed on the DX screen.

* You cannot control the DX using the remote control terminal, if the remote control terminal is
in the ID number setup mode.

¢ Correspondence with the DX Keys

— Character input

keys 3 *C |10 4
A4 A N A
| - Up arrow key Hanual

message | sample

|- User key
/ DISP/ENTER key F1/F5 F2/F6 F3/F7 F4 Hold down SHIFT
and press F3/F7.
Hold down SHIFT
and press F2/F6.
Hold down SHIFT
and press F1/F5.

ESC key —

Left arrow key — — Right arrow key

— Down arrow key

FUNC key — & ;
............. =~ MENU key

LT U v w., R
o o o o Character input
: X Y Z MARK: keys

@'-—— Soft keys

Character type switch key for character input keys (see the next page)

START key STOP key
YOKOGAWA ¢
Delete key
k Deletes the character at the cursor position when inputting characters.
Space key

Enters a space at the cursor position when inputting characters.

¢ Entering Strings
When a character input window is displayed on the DX screen, pressing the A/a/1
key switches the character type assigned to the character input keys as shown in the
following figure.

P 3

¢ Uppercase Alphabet Characters and Symbols/Lowercase Alphabet
Characters and Symbols

Uppercase alphabet
characters and symbols

Lowercase alphabet J_" Numbers ’
characters and symbol -l

Alphabet (Ato Z or ato 2)

Each time the MARK key is pressed, the displayed symbol switches
in the following order.
The display switches in a cyclic pattern.

) | Number of times
the key is pressed
Symbol % # | @ - (/)| +* 1

FIFS F2.F6 F3/F7  Fa
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2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

¢ Numbers

Number (1 to 9 and 0)

Decimal point

However, when setting a constant to be used in the computation
on the DX with the /M1 or /PM1 option, the display switches

in the order “.”, “+”, and “E” each time the key is pressed.

The display switches in a cyclic pattern.

Minus sign

When a window for entering an equation is displayed on the DX with the /M1 math
option, the character strings of computing elements are assigned to each key as shown
in the following figure.

v

The character string switches in the following order each time the key is pressed. The
display switches in a cyclic pattern.

key

Al
B2
Cc3
E4
F5
G6
17
J8
K9
NO

© ©W O N O O hA WON 2

Number of times the key is pressed

2 3 4 5 6 7 8 9
( )

K C D P Q | S F
+ - * /

[ 1 ? :

.EQ. .NE. .GT. LT. .GE. .LE.

AND NOT XOR OR

SQR( ABS( LOG(  |EXP( LN(

PRE( RESET( |CARRY( | HOLD(

TLOG.AVE(  TLOG.MAX(| TLOG.MIN(| TLOG.SUM( TLOG.P-P(
CLOG.AVE( CLOG.MAX(| CLOG.MIN(| CLOG.SUM( CLOG.P-P(
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2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

Troubleshooting

The DX does not react when you try to control it using the remote control terminal.

Are the correct batteries loaded in the remote control terminal?

Check the voltage and polarity of the batteries.

Are the batteries flat?

Replace the batteries with new ones.

Does the ID number of the remote control terminal match the remote
controller ID of the DX that you are trying to control?

Check the remote controller ID on the DX, and set the ID number of the remote control
terminal to the same value.

Is the remote control terminal in ID number setup mode (condition in
which the ID key is pressed once)?

Wait 8 seconds without pressing any keys to exit from ID number setup mode.

Is the remote control terminal too far away from the DX?

Get closer to the DX. Control from as close to the front of the DX as possible.

Is a strong light hitting the light-receiving section of the DX?

Take measures to prevent strong light from hitting the light-receiving section of the DX.
Is there a magnetic field source such as a transceiver nearby?

Move the magnetic field source away from the DX.

Is the infrared output section of the remote control terminal or the light-
receiving section on the DX dirty?

Clean them.

Is the DX in a condition that allows the relevant key operation?

Check the condition of the DX, and start from an operation that is possible.

214
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2.1

Controlling the DX with a Keyboard (/USB1
Option)

Connecting/Removing a Keyboard

¢ Connecting a Keyboard
Connect the keyboard connector to the USB port on the DX.
The message “USB device has been connected” appears on the screen, and the
keyboard is ready for use.

* Removing the Keyboard
Remove the keyboard connector from the USB port on the DX.

Nofte
* You can connect or remove the keyboard regardless of the DX status (power ON/OFF or
displayed screen).
* One keyboard can be connected.
« Use a keyboard appropriate for the language setting on the DX.
« The state of the CapsLock and NumLock keys is retained even if you disconnect the USB
keyboard. A function available on DXs with release number 2 or later.

IM 04L42B01-01E
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2.11 Controlling the DX with a Keyboard (/USB1 Option)

Operating from the Keyboard

Use the keyboard while watching the DX screen. An operation that can be carried out on

the DX can be carried out from the keyboard.
Example: Switch to setting mode

When the DX is in the operation mode, press Ctrl+M.
The DX switches to setting mode, and the setting menu appears.

¢ Mapping of the Keys on the DX to the Keys on the Keyboard

Keys on the Keyboard

104 Keyboard (US)for the PC Keys on the DX
Enter DISP/ENTER
— Left arrow key
1 Up arrow key
l Down arrow key
— Right arrow key
Num Enter DISP/ENTER
Esc ESC
F1to7 Soft key 1 to soft key 7
F9 FUNC
F12 Hold down FUNC for 3 seconds
Left-Windows MENU
Right-Windows MENU
Application Favorite key
Ctri+S START
Ctri+P STOP
Ctri+U USER
Ctrl+M MENU
Ctri+F Favorite key
Tab, Shift+Tab Arrow keys*

Press Tab to move the cursor to the next item, or Shift+Tab to move to the previous item.
However, this does not work in the following screens:

Operation screens, Menu screens for Setting mode and Basic setting mode, screens for
entering values and characters, “Menu customize” and “Save/Load” screens in Setting mode,
and “Load setting, Initialize” screen in Basic setting mode

¢ Entering Alphabets, Numbers, and Symbols
When alphabets, numbers, and symbols can be entered on the DX, you can enter
them from the keyboard. The operation is the same as with normal keys. However,
symbols that cannot be used on the DX are invalid.
Symbols That Can Be Entered Using the Keyboard
The symbols below can be entered. However, symbols that cannot be used on the
DX are invalid. For example, the characters &, *, /, :, and ? cannot be used in the data

save destination directory name.

>3 *
S

E aE

AEENE

A

e ]

*

* Invalid Keys
Keys enclosed in frames are invalid.
The 104 Keyboard for a PC (US)

Press “A” on the keyboard to enter the temperature degree symbol.
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2.12 Using the USB Flash Memory (/USB1 Option)

Connecting/Removing a USB Flash Memory
* Connecting a USB Flash Memory
1. Connect a USB flash memory to the USB port on the DX.

2. In operation mode, possible operations are shown. Select the desired operation
using the arrow keys and press DISP/ENTER.

When set to auto save

GROUP 1 = ,
2085/81/17 14:21:80 DIsP I 19nin

1min/div

[Load Settings | Cancel kPaZ
1006.688

When set to manual save

GROUP 1 = ,
2605/81/17 14:19:55 0IsP NN (nin

Imin/div

[ Save data |[|Load Settings |  Cancel

suonesadQ uowwo9n ﬂ

L 9.89
________________________________________________________ 181.82
57
3
14: 1L 42. 9
Setting Description

Save Manual Saves unsaved data in the internal memory to the USB flash memory.
Save data Moves to the memory summary display. For the procedure to save the

internal memory data, see section 4.8.

Save data is displayed only when a flash memory is connected to the

USB port and is usable* in the operation mode (Release Number 2 or

Later).

* If DX is configured so that any of the items below is shown in the display
selection menu, Save data can be executed. You can change the items
shown in the display selection menu using the MENU CUSTOMIZE

function.
SELECT SAVE, M.SAMPLE SAVE, REPORT SAVE, or ALL SAVE
Load Settings Moves to the setup load display of the setting mode. For the procedure to
load the setup data, see section 6.9.
Cancel Closes the operation selection window.

IM 04L42B01-01E
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2.12 Using the USB Flash Memory (/lUSB1 Option)

¢ Removing the USB Flash Memory

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Media eject soft key and then the USB soft key.
A message “Media can be removed safely.” appears.

3. Remove the USB flash memory.

Note

*  One USB flash memory can be connected.
» Be sure to carry out the procedure above when removing the USB flash memory.

Saving and Loading Data
The following data save/load and file operations can be carried out.
Save/Load setup data files (see section 6.9).
Save display data and event data files (see sections 4.8 and 6.4).
Load display data and event data files (see section 6.8).
List files and delete files (see section 6.7).
Format (see section 6.7).
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Chapter 3 Measurement Channels and Alarms

3.1 Setting the Scan Interval and the Integration
Time of the A/D Converter

Select the scan interval and the integration time of the A/D converter.
For a description of the scan interval and the integration time of the A/D converter, see
section 1.1.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select A/D, Memory

Scan interval

Scan node Normal

Scan interval 1s

A/D intesrate futo

Hemory
(Data kind Display

Scan interval > Scan mode

Normal: Measures at the normal mode scan interval.

FAST: Measures at a scan interval of 25 ms (DX2004 and DX2008) or 125 ms (DX2010,
DX2020, DX2030, DX2040, and DX2048).

Scan interval > Scan interval
The selectable settings appear.

Scan interval > A/D integrate
When the scan mode is set to Normal, select the A/D integration time as necessary.
Only the selectable settings are displayed.

Settings Description

Auto The DX automatically detects the power supply frequency and sets the integration
time to 16.7 ms and 20 ms for 60 Hz and 50 Hz, respectively. Fixed to 20 ms on
/P1 models that use the 24 VDC power supply.

50Hz Sets the integration time to 20 ms.

60Hz Sets the integration time to 16.7 ms.

100ms Sets the integration time to 100 ms (when the scan interval is 2 s or 5 s).
600Hz The A/D integration time for fast sampling mode. You cannot change this value.

IM 04L42B01-01E
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3.2 Setting the Burnout Detection and the
Reference Junction Compensation of the
Thermocouple Input

Setup Screen

Set the function that detects burnouts in the sensor for thermocouple input and 1-5V
input and the reference junction compensation method of the thermocouple.

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Burnout, RJC

Burnout, RJC
First-CH Last-CH [}

Burnout set
(Hode off
RJC —
Hode External
Volt [

First-CH/Last-CH
Select the target channels.

Burnout set > Mode
Thermocouple Input

Settings Description
Off Does not detect burnouts in the sensor.
Up When the sensor burns out, the measured result is set to +over range. The

measured value displays “Burnout.”
For 1-5V input, the DX assumes that the sensor has burned out when the
measured value exceeds the scale upper limit by 10% of the scale width.
(Example: When the measured value is greater than 110 when the scale is from
0 to 100)

Down When the sensor burns out, the measured result is set to —over range. The
measured value displays “Burnout.”
For 1-5V input, the DX assumes that the sensor has burned out when the
measured value falls below the scale upper limit by 5% of the scale width.
(Example: When the measured value is less than —5 when the scale is from 0 to
100)

RJC > Mode
Sets the reference junction compensation method of the thermocouple input. Select
Internal or External.

Settings Description
Internal Uses the reference junction compensation function of the DX.
External Uses an external reference junction compensation function. When set to

External, Volt is displayed.

RJC > Volt
The compensation voltage to be added to the input. Set the value in the range of —
20000 pV to 20000 pV.

3-2
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3.3 Setting the Input Range

Set the input range for each channel.

Setup Screen

¢ Temperature Unit
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > Operating Environment

Ethernet

Operating environment

Tag/Channel Tag
Language English
Remote Controller ID Off
Temperature

* Input Range for Each Channel
Press MENU (switch to the setting mode) and select Meas Channel >
Range, Alarm

GROUP 1 r= ,
Shey/a0ran 131012 e DIsP DN 15ein (T

Heas Channel > Range. Alarn

First-CH Last-CH [l
r Range
Hode Range Span Lower  Span Upper
Volt v -2-BB68 2.8808
r Alarn
1 |0ff
2 | Off
3 | 0ff
4 | Off

* Temperature
Select the temperature unit. The setting is applied to all temperature measurement

SwLie|Y pue sjauuey) juswainsesyy

channels.

Settings Description

C Use Celsius

F Use Fahrenheit
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3.3 Setting the Input Range

¢ First-CH/Last-CH
Select the target channels.

* Range > Mode
Settings Description
Skip Not measured.
Volt, TC, RTD, DI, 1-5V  Input type. Represents DC voltage, thermocouple, RTD, ON/OFF
input, and 1-5V inputs, respectively.
Delta, Scale, Sqrt Difference computation, linear scaling, and square root computation.

Set the items with check marks in the table below according to the mode value.

Mode
Setup Item Volt | TC | RTD | DI |Delta | Scale| Sqrt | 1-5V | _ Skip
Type v v
Range v v v v v v v v
Span Lower v v v v v v v v
Span Upper v v v v v v v v
Scale Lower v v v
Scale Upper v v v
Unit v v v
Ref. CH v
Low-cut v v
Low-cut value v

* Range > Type
Input type when Mode is Delta or Scale. See the description on Mode above.

* Range > Range
Input type details.

Setting Input Type Notes Setting Input Type Notes
20mV —20.000 mV to 20.000 mVDC |Standard R Type R Standard
60mV —60.00 mV to 60.00 mVDC S Type S

200mV —200.00 mV to 200.00 mVDC B Type B

2V —2.000 V to 2.000 VDC K Type K

6V —6.000 V to 6.000 VDC E Type E

20V —20.000 V to 20.000 VDC J Type J

20V —50.00 V to 60.00 VDC T Type T

Pt Pt100 N Type N

JPt JPt100 Wi Type W

Level ON/OFF(Voltage) L Type L

Contact ] Type U

1-5V 0.800V to 5.200V WRe type WRe

Setting Input Type Notes Setting Input Type Notes
Kp Kp vs Au7Fe /N3 Cu1 Cu10 (GE) /N1
PLATI | PLATINEL option Cu2 Cu10 (L&N) option
PR PR40-20 Cu3 Cu10 (WEED)

NiMo NiNiMo Cu4 Cu10 (BAILEY)

W/WRe | W/WRe26 Cu5 Cu10: a = 0.00392 at 20°C

N2 Type N (AWG14) Cub Cu10: a = 0.00393 at 20°C

Pt50 Pt50 Cu25 Cu25: a = 0.00425 at 0°C

Ni1 Ni100 (SAMA)

Ni2 Ni100 (DIN)

Ni3 Ni120

J263 J263*B

Cu53 Cu53

Cu100 Cu100: a = 0.00425 at 0°C

Pt25 P25

¢ Range > Span Lower, Span Upper
Input range. The selectable range is displayed on the screen.

Nofte

* You cannot set the same value to Span Lower and Span Upper.
*  When the Mode is 1-5V or Sqrt, Span Lower must be less than Span Upper.
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3.3 Setting the Input Range

Range > Scale Lower, Scale Upper

Input range after converting the unit.

The selectable range is from —30000 to 30000. The decimal place is determined by
the Scale Lower setting. It can be set to the following positions: “X.XXXX,”
XXXXX,” XXXXXK,” XXXXX,” or “XXXXX.”

Note

* The DX converts the measured value to a value obtained by removing the decimal point
from the value span specified by Scale Lower and Scale Upper. For example, if the scale
setting is “—5 to 5,” the value is converted to a value within the span of “10”; if the scale
setting is “-5.0 to 5.0,” the value is converted to a value within a span of “100.” In this case,
the resolution of the value converted to a span of “10” is lower than the value converted to a
span of “100.” To prevent the display from becoming rough, it is recommended that the scale
be set so that this value is greater than 100.

* You cannot set the same value to Scale Lower and Scale Upper.

*  When the Mode is 1-5V or Sqrt, Scale Lower must be less than Scale Upper.

Range > Unit
Sets the unit (up to 6 characters, [Ala[#]1])-

Range > Ref. CH
The reference channel for difference computation.

Range > Low-cut
Select On to use the low-cut function.
*  The low-cut value for 1 to 5 V input is fixed to 0% value of the input span.

Range > Low-cut value
On a square root computation channel, set the low-cut value in the range of 0.0% to
5.0% of the input span.

Measured value

Result of square root computation

Low-cut value I

7] Input value

IM 04L42B01-01E
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3.4 Setting the Moving Average of the Input

Set the moving average function of the measurement channel. This function suppresses
the effects of noise.
For a description of the function, see section 1.1.

Setup Screen

Press MENU (switch to the setting mode) and select Meas Channel >
Moving average

GROUP 1 = :
Shoaoam 13:izc1s e ISP NN nin ()

Heas Channel > Hoving average

First-CH Last-CH ]
Hoving average ———
On/0ff On
Count 2

—>-|—|<—Scan Interval
AV VAR VAN VAN VAR VAR v/

————— Average value
————— Average value

* First-CH/Last-CH
Select the target channels.

e On/Off
To use moving average, select On.

e Count
Set the number of data points of the moving average in the range of 2 to 400.
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3.5 Setting the Auxiliary Alarm Function

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Alarm

Alarn
 Basic settinn — Switch, Relay
Ref lash 0ff Internal Switch
Rate of change AND None
Decrease 1 Relay
Increase 1 AND None
Indi cator Nonhold fAction Energize
Hold Nonhold
= Hysteresis — Relay Action on ACK | Normal
Heas CH
Hi gh/Low 8.5 2
Delta High/Lou 8.8 %
Ext. CH
Hi gh/Low 8.8 2
On 0ff

* Basic setting > Reflash

To set the reflash operation on the alarm output relay, select On. The reflash function
is set on the first three output relays.

Basic setting > Rate of change

* Decrease
Set the interval for the rate-of-change calculation of the low limit on rate-of-change
alarm in terms of the number of sampled data points (1 to 32). The actual interval is
obtained by multiplying the value specified here by the scan interval.

* Increase
Set the interval for the rate-of-change calculation of the high limit on rate-of-change
alarm in the same manner as the interval for the low limit on rate-of-change alarm.

Basic setting > Indicator
Select the alarm indication behavior from the following:

Settings Description

Nonhold Clears the alarm indication when the alarm condition is released (returns to
normal condition).

Hold Holds the alarm indication until an alarm acknowledge operation is performed.

IM 04L42B01-01E
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3.5 Setting the Auxiliary Alarm Function

¢ Switch, Relay

Note

Internal Switch > AND

Select the internal switches that are to operate using AND logic. Set the range

of internal switches (from the first internal switch) to take the AND logic. All
subsequent switches will be set to OR logic.

Relay > AND

Select the relays that are to operate using AND logic. Set the range of relays (from
the first alarm relay) to take the AND logic. All subsequent relays will be set to OR
logic. Available settings are None, 101 (101 only), 101-102 (101 and 102), 101-103 (101
to 103), etc. Only alarm output relays that are installed are valid.

When reflash is turned ON, the operation of the first three output relays is fixed to OR logic.
Specifying AND produces no effect.

Relay > Action
Select whether the alarm output relay is energized or de-energized when an alarm
occurs. The setting applies to all alarm output relays.

* Relay > Hold
Select the alarm output relay behavior from below: The setting applies to all relays.
Settings Description
Nonhold Turns the output relay OFF when the alarm condition is released (returns to
normal condition).
Hold Holds the output relay at ON until an alarm acknowledge operation is performed.
Nofte

When reflash is turned ON, the operation of the first three output relays is set to nonhold.
Specifying Hold produces no effect.

Relay > Relay Action on Ack
You can select the relay output status that is enabled after the alarm ACK operation
from the following two settings.

Settings Description

Normal The relay output is deactivated when the alarm ACK operation is executed. If the

condition for activating the alarm output relay is met in the next scan interval, the
relay output is activated.
This operation is valid only when the alarm output relay is set to Hold.

Reset The relay output is deactivated when the alarm ACK operation is executed. If a

new condition for activating the alarm output relay is met, the relay is activated.

An example of the relay action when alarm ACK is executed is shown below. This
example is for the case when the output relay AND item is set to OR.

Normal
Alarm Alarm ACK

occurrence ¥V
Alarm 1 Alarm
occurrence
Alarm 2
Activated
Alarm output relay
Deactivated

(Relay is activated in the next scan interval)

3-8
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3.5 Setting the Auxiliary Alarm Function

Reset
Alarm Alarm ACK
occurrencev
Alarm 1 Alarm
occurrence
Alarm 2

Activated
Alarm output relay
Deactivated

(Relay is activated on the next alarm occurrence )

» Hysteresis > Meas CH

¢ High/Low
Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm
specified on measurement channels.
Selectable range: 0.0% to 5.0% of the span or scaling width

¢ Delta High/Low
Sets the hysteresis width of the alarm occurrence/release of the difference high/low
limit alarm specified on measurement channels.
Selectable range: 0.0% to 5.0% of the span

¢ Hysteresis > Math CH (/M1 and /PM1 options) and Ext. CH (/MC1 option)
Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm
specified on computation and external input channels.
Selectable range: 0.0% to 5.0% of the measurement span

IM 04L42B01-01E
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3.6 Hiding the Alarm Indication

Setup Screen

Select whether to enable the alarm hide function.

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > View, Message, Input,

Alarm

r View

Trend type
Partial
Trend rate switching

Basic Setting Hode

r Hessage

Write group
Power-fail nessage
Change message

Cornon
0ff
off

Alarm > Detect
To enable the function that turns off the alarm indicator and logging, select On. The
Detect setup item is displayed in the alarm setting screen (see section 3.7).

— Input
(Ualue on over-range Ouer

Alarn
(Detect 0ff

This function disables the alarm indicator and the logging of the alarm event to the
alarm summary even when an alarm occurs.

Settings for Each Channel and Each Alarm

See section 3.7.
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3.7 Setting Alarms on Channels

Setup Screen

Setup Items

Set the alarms after setting the range. All alarm settings of a channel are cancelled in the
following cases.

When the input type (Volt, TC, etc.) is changed.

When the input range is changed.

When the upper or lower limit of the span or scale is changed on channels that are set
to linear scale, square root computation, or 1-5 V (including changes in the decimal
point position).

Alarms for Each Channel
Press MENU (switch to the setting mode) and select Meas. Channel >
Range, Alarm

GROUP 1 r= ,
Shey/a0ran 13:12:46 R 0I5 DN 15nin ()

Heas Channel > Range. Alarn

First-CH [@81  Last-CH [
r Range
Hode Range Span Lower  Span Upper
[Volt [2v [-2®%e@8 [ 2.0060
r Alarn
Relay

Type Value On/0ff  Mumber Detect
1 I W goeed [on  [16T  [On
2 [off
3 [Off
4 JOfF

Alarm Delay Time
Press MENU (switch to the setting mode) and select Meas. Channel > Tag,
Memory sample, Alarm delay

GROUP 1 = .
Shobrao/on 13:a:qr e ISP NN 1sin ()

Heas Channel > Tag, Hemory sample, Alarm delay
First-CH [@01  Last-CH aa1

Tag
(Tas —

Hemory sanple

(Unlﬂff On
Alarm delay

(}ime T s

First-CH/Last-CH
Select the target channels. The target channels are common with the other items that
are displayed on the screen.

Alarm > 1, 2, 3, and 4
For each alarm, 1 to 4, select On to enable it.

IM 04L42B01-01E
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3.7 Setting Alarms on Channels

e Alarm > Type

Select the alarm type.
Settings Name Description

High limit alarm —
Low limit alarm -
Difference high limit alarm Can be specified on channels set to difference computation.
Difference low limit alarm Can be specified on channels set to difference computation.

High limit on rate-of-change alarm —

Low limit on rate-of-change alarm —
Delay high limit alarm —
Delay low limit alarm —

~|d|= || —|=||T

Alarms on channels set to difference computation are inserted at the following
positions.
HI!L!T!t RI!r!hlI

Input value O Measured value ’

T
Measured value on the reference channel

Alarm > Value
Set the alarm value for the selected alarm type.

When the Mode of the Channel Is Set to Volt, TC, RTD, or DI
Type Value Example of a Range of Alarm Values
H,L Value in the measurable range —2.0000 to 2.0000 V for 2 V range
R, r 1 digit to the upper limit of the width of 0.0001 to 3.0000 V for 2 V range
the measurable range
However, less than or equal to 30000 0.1 to 1760.0°C for thermocouple type R
excluding the decimal point.
T, t Same as Hand L. Same as Hand L.

When the Mode of the Channel Is Set to Delta

Type Value Example of a Range of Alarm Values
H,L Value in the measurable range —2.0000 to 2.0000 V for 2 V range
h, I Value in the measurable range —1760.0 to 1760.0°C for thermocouple type R
R, r 1 digit to the width of the measurable 0.0001 to 3.0000 V for 2 V range
range

However, less than or equal to 30000 0.1 to 1760.0°C for thermocouple type R
excluding the decimal point.

T, t Same as Hand L. Same as H and L.

When the Mode of the Channel Is Set to Scale, Sqrt, or 1-5V

Type Value Example of a Range of Alarm Values

H,L —5% to 105% of the scale width. —5.0 to 105.0 when the scale is 0.0 to 100.0
However, within —30000 to 30000 —120.00 to 300.00 when the scale is —100.00
excluding the decimal point. to 300.00

R,r  Within 1 to 30000 excluding the decimal 0.1 to 3000.0 when the scale is 0.0 to 100.0
point. 0.01 to 300.00 when the scale is —100.00 to

300.00
T t Same as Hand L. Same as Hand L.

Alarm > Relay
Select whether to turn On or Off the relay output.

Alarm > Number
Set the output relay number or internal switch number when performing relay output.

3-12
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3.7 Setting Alarms on Channels

Alarm > Detect

This item appears when the alarm hide function (see section 3.6) is turned On. Select
whether to show or hide the alarm indication when an alarm occurs. If set to Off, a
signal is output to the alarm output relay or internal switch when an alarm occurs, but
it is not indicated on the screen. The alarm is also not recorded in the alarm summary.

Alarm delay > Time (for delay high/low limit alarms)
Set the alarm delay time using an integer in the range of 1 to 3600 s.

Nofte
* The alarm delay time takes on a value that is an integer multiple of the scan interval. For
example, if the alarm delay time is set to 5 s when the scan interval is 2 s, the actual delay
timeis 6 s.
* The delay alarm has the following special operations.
+ If the computation is stopped in a condition in which the computed value is exceeding the
alarm setting when a delay alarm is set on a computation channel, the alarm is turned
On after the specified period (delay period) elapses.
* The alarm detection operation is reset if a power failure occurs. The operation restarts
after the power recovers.
+ If the alarm setting of the delay high limit alarm is changed when an alarm is already
activated and the input is greater than or equal to the new setting, the alarm continues.
For all other cases, the alarm detection operation starts at the new setting. This is also
true for the delay lower limit alarm.

IM 04L42B01-01E
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3.8 Releasing the Alarm Output (Alarm ACK
Operation)

Procedure

Explanation

This operation is valid when the DX is set as follows:

DX with release number 2 or later

* When Indicator is set to Hold in the basic setting mode.

* When Relay Hold is set to Hold and Relay action on ACK is set to Normal in the
basic setting mode.

* When Relay action on ACK is set to Reset in the basic setting mode.

DX before release number 2

* When Indicator is set to Hold in the basic setting mode.

* When Relay Hold is set to Hold in the basic setting mode.

For the procedure to set the relay action, see section 3.5.

This operation is carried out after an alarm occurs.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the AlarmACK soft key.
The alarm output is released.

e Alarm Acknowledge (ACK) Operation
When an alarm acknowledge operation is carried out, the indications and outputs
(relays and switches) of all activated alarms are cleared.

3-14
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3.9 Performing Calibration Correction (/CC1
Option)

Setup Screen

Setup Items

The input value is corrected using segments, and the result is used as a measured value.
For a description of the function, see section 1.1.

Press MENU (switch to the setting mode) and select Meas Channel >
Calibration correction
a0 13:14:06 e D1 DN 15ein () +)

Heas Channel > Calibration correction
First-CH [BA1  Last-CH [

r Calibration correction
Number of set points D
HES val True val
1| 26688 | -2. 6688
2[-2.pem0 [ -2. 9668
3[-2.68m8 [ -2. 9668
; -2.6600 | -2.88BR

0ff 2 3 4 5 6 Next 1/3

Condition
X1<X2<X3<X4<X5

Y5
Y4

Y3 Calibration set points
I

Y2 ~

|

Y1
X1 X2 X3 X4 x5 |Trueval

First-CH/Last-CH
Select the target channels. You can set consecutive channels whose range is set to
the same value as the first channel.

| Number of set points

Calibration correction > Number of set points

Select the number of points that make up the segments (including the start and end
points) in the range of 2 to 16.

To disable calibration correction, select Off.

Calibration correction > MES val, True val

Press the Input soft key and enter the value.

For the MES value, set a value that is greater than the previous value.

Press the Measure soft key to set the measured value at that point to MES val. If
you press the Measure soft key when setting multiple channels simultaneously, the
measured value of the first channel are set to the MES val of all channels.
Selectable Range of MES and True Values

¢ Channels on which linear scaling is specified
—30000 to 30000 (the decimal place is the same setting as the scale value)
¢ Other channels

Value in the measurable range of the selected range
Example: —2.0000 to 2.0000 for 2 V range

Nofte

« The calibration correction setting is set to Off if you change the Mode or Range setting.
« Calibration correction cannot be specified on channels set to Skip.

IM 04L42B01-01E
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3.10 Counting Pulses (/PM1 Option)

Setup Screen

The pulses applied to the pulse input terminal are counted on a computation channel.
For a description of the function, see section 1.1.

Press MENU (switch to the setting mode) and select Math Channel >
Calculation expression, Alarm

GROUP 1 =3 .
Shosrmo/on 13:i5:5 el D1 NN win () )
Hath Channel > Calculation expression, Alarn
First-CH Last~CH 181
Hath range
Hath On/0ff [On

Caleulation expression
[aL
Span Lower  Span Upper  Lnit

—208. [

r Hath alarm

1 0ff
2 0ff
3 0ff
4 0ff

¢ First-CH/Last-CH
Select the target computation channels.

e Math range > Math On/Off
Select On.

¢ Math range > Calculation expression
Enter the equation using symbols.
Q01 to Q08: Displays the number of pulses per second.
P01 to P08: Displays the number of pulses per scan interval.
*  The numbers 01 to 08 correspond to the pulse input terminal numbers.
For the procedure to set the computation channels, see section 9.1.

The procedure is explained below using an example.

¢ Example 1: Pulse Sum Value
Display the sum value of the pulse signal applied to pulse input terminal number 6.

| R R R R RN ER T REE M
—

Scan interval

Pulse input Time

0
o
o
o

per scan interval

E o
Number of pulses \— \_

(Sum) H
ﬁ

Pulse sum value
Expression

Assign the computation channel and set the expression. Set the span lower/upper
limit and unit according to the application.

Channel Equation Description

101 TLOG.SUM(P6) Sum of the number of pulses per scan interval

IM 04L42B01-01E



3.10 Counting Pulses (/PM1 Option)

¢ Example 2: Number of Pulses per Minute

Count the pulse signal applied to pulse input terminal number 6 on the DX2004 (scan
interval set to 250 ms), and calculate and display the number of pulses per minute.
(Moving average over a minute)

Pulse input — e
Sampling interval
(250 ms) ’/
i O T B T B B
Number of pulses l (60x) ‘ ‘ l ‘ ‘ ‘
per second E E E ﬂ ﬂ E E
H|® & |H [®|H|H
Number of pulses
per minute
Expression

Assign the computation channel as shown below and set the expressions. Set the
span lower/upper limit and unit according to the application.

Channel Equation Description
101 Q6 Number of pulses per second
102 101*K01 Number of pulses per minute
Constant Value Description
K01 60 Coefficient for converting the number of

pulses per second to the number of
pulses per minute

Channel Rolling average Description
101 Sampling interval: 1s Moving average over a minute
Number of samples: 60

Channels

The computation is performed in order from the channel with the smallest channel
number in one scan interval.

Use a channel of a channel number larger than that of the channel counting the
number of pulses per second for the computation channel that is to calculate the
number of pulses per minute.

Example 3: Reset When the Pulse Sum Value Exceeds a Certain Value
Reset the sum value when the pulse sum value exceeds a specified value (reset
value) and carry over the value exceeding the reset value to the sum after the reset.
Count the number of resets and calculate the total sum value up to that point.

Expression
Assign expressions to the computation channels as shown below and set the
constants.

Channel Expression Application

101 ((102+P01).GE.K01)+101 Pulse sum value reset count

102 CARRY(K01):TLOG.SUM(P01) Pulse sum value

103 K01*101+102 Total sum value

Symbol Description

P01 Counts the number of pulses per scan interval.

K01 Constant. The reset value. The sum value is reset when this value is exceeded.

IM 04L42B01-01E
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3.10 Counting Pulses (/PM1 Option)

Pulse input Time

Scan interyal

sl INsINE I INAINA]

Number of pulses
per scan interval

o o |1 |1 1 | 2 | 2

Reset count

all

(Resets the value below the reset value)

reset value

D
Sum value

Channel 101: Reset Count

Calculates the number of times the pulse sum value is reset.

The expression “((102+P01).GE.K01)” is set to 1 when “the previous pulse sum value
(102) + the current pulse count (P01)” is greater than the reset value (K01). Otherwise,
the expression is set to 0. The value of channel 101 is incremented when the pulse
sum value exceeds the reset value.

Channel 102: Pulse Sum Value

Calculates the pulse sum value.

Under normal conditions, the pulse sum value TLOG.SUM (P01) is calculated. When
the pulse sum value is greater than or equal to the reset value (K01), the pulse sum
value is set to the amount exceeding KO1.

Channel 103: Total Sum Value
Multiplies the reset value (K01) by the reset count (101) and adds the pulse sum value
(102) to derive the total sum value.

Note

» The computation is performed in order from the channel with the smallest channel number

in one scan interval. If the channel number in the expression is greater than or equal to the
channel number in which the expression is assigned, the previous computed result (previous
value) is used for the channel in the expression.

» Because the accuracy of the computation function is single-precision floating point, we
recommend a reset value less than or equal to 107,

» If the pulse input value of the scan interval is greater than the reset value, correct
computation cannot be achieved.

3-18
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3.11 Setting the Method of Detecting Over-Range
Values of Linearly Scaled Measurement
Channels

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > View, Message, Input,
Alarm

Environment > View. Message. Input. Alarm

r View —_— Input
Trend tupe TV (Ualue on over-range
Partial Off
Trend rate switching Off RAlarn
(Detect Off
r Hessage
Write group Comon
Power-fai | message Off
Change message off

* Input > Value on over-range

Settings Description

Free The value is set to —over range if the value is less than —30000 and +over range
if the value is greater than 30000 excluding the decimal point. The value is
displayed as —Over and +Over, respectively.

Over The value is set to —over range if the value is less than —5% of the scale and
+over range if the value is greater than 105%. The value is displayed as —Over
and +Over, respectively.

Example: If the scale is 0.0 to 200.0, the value is set to —over range if the value
is less than —10.0 of the scale and +over range if the value is greater than 210.0.

Note

For computations such as TLOG, CLOG, and report, the handling of the scale over-range value
can be set in advance.
See section 9.1.
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Chapter 4

Switching Operation Screens

4.1

Operations in Operation Mode

Switching the Screen with the DISP/ENTER Key and Arrow Keys

Press DISP/ENTER and arrow keys to show the display selection menu and sub menu to

switch the display. The flow of operation is indicated below.

(( DISP/ENTER key and arrow keys
~ TREND Sec. 4.2
| 1
| | ShaB10/28 18:28-37 DIsP NN nin
> GROUP1  [---- GROUP n L PN
: N i
RN I I }_ ____________________ J
DIGITAL _ | | _Sec.42 —— , 448.7
! ! kPaz
i (—'—‘—'j ! 169.708
: Lo E 3
b4 GRQ P1 - GROUP n | = 11.49
i i = T 186.22
| | %
: Do pE 58.5
et Bl e - 1
1 A = 44.2
BAR Sec. 4.2
et [ e 1 Sub menu
E U (_I_(_Ij— E Display selection menu
i GROUP1  F---- GROUP n i Tag Display
! ' Long tags may not fit in the display space. In such case,
| ' they are displayed as follows:
R e J » Automatically scrolls the screen once immediately
}— after the screen is displayed.
OVERVIEW » Scrolls the screen once when you press ESC.
Sec. 4.4
INFORMATI|ON
r-=——==---9 ol e al
i ALARM MESSAGE MEMORY REPORT DATA RELAY E
! | SUMMARY SUMMARY SUMMARY Sec. 4.5 Sec. 4.5 !
| sec.4.6 Sec. 4.7 Sec. 4.8 !
o . N 7 [mopBus i
' |MASTER |
TREND | |MODBUS ;
HISTORY 1 CLIENT Sec.4.5 !
Sec. 4.3
LOG  Sec.4.9
E Login log, error log, communication log, FTP log, E
[ N I Web log, e-mail log, SNTP log, DHCP log, and !
i' Modbus status log :
4 PANEL
Sec. 4.10
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4.1 Operations in Operation Mode

Operations Using Other Keys

/S\oft keys (see below)
N\

® G
, @ @ @

| |

FUNC key (see below) Favorite key (see section 5.16)
USER key (see section 7.1)

START and STOP keys (see section 6.4)

Operation Using the FUNC Key
Press FUNC to display the FUNC key menu at the bottom of the screen. Press the
Next soft key to switch the menu. Press the desired soft key.
S 10728 18:31:51 DIsP NN dnin

1nin/div

Hanual
sanple

AlarnACK | Hessage
message | display

Y

FUNC key menu Next soft key
(Select using the soft keys)

AlarmACK | Hessage e "‘?di a Sngp Manual Trigger
nessage | eject shot sample

Sec.3.8 Sec.54 Sec.54 Sec.6.4 Sec.6.6 Sec.6.5 Sec.6.4

Sec. 2.12
Save Save Save Hath Hath Hath Timer
display | event stop start reset ACK reset

Sec. 6.4 Sec.6.4 Sec.4.8/6.4 Sec.9.4 Sec.9.4 Sec.9.4 Sec.7.1

Password | Second Batch Text Favorite

Keglopk | Lopgut change speed field regist

Sec. 8.1 Sec.8.3 Sec.8.2 Sec.53 Sec.6.3 Sec.6.3 Sec.5.16

Standard Network

display info

Sec. 4.10 Sec. 5.15 Sec.2.5 Sec.2.5 Comm.* Comm.* Comm.*

FTP test * Communication Interface User’s Manual.

Comm.*

Customizing the Menus
The display selection menu that appears when the DISP/ENTER key is pressed and
the FUNC key menu that appears when the FUNC key is pressed can be changed.
See section 5.18
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4.2 Displaying the Measured Data as Waveforms,
Values, or Bar Graphs

This section explains how to use the trend, digital, and bar graph displays.
For a description of the function, see section 1.3.

Procedure

* Showing the Display

1.
2.

Press DISP/ENTER to show the display selection menu.

Press the arrow keys to select TREND, DIGITAL, or BAR, and press DISP/
ENTER.

The selected display appears.

e Changing the Displayed Contents

1.
2.
3.

Press DISP/ENTER to show the display selection menu.
Press the right arrow key to display the sub menu.

Press the up and down arrow keys to select the sub menu item.
Sub menu of the trend display

GROLP 1 = : o
2085/18/81 09:24:58 o I oin  (S)ER o)

:l— Group name: Displays the group

—— ALL CHANNEL: Displays the waveforms of all
channels

GROUP CHANNEL: Displays the waveforms of the
channels registered to groups

SCALE ON: Displays the scale

SCALE OFF: Clears the scale

.............. DIGITAL OFF: Clears the numeric display section

DIGITAL ON: Displays the numeric display section

MESSAGE DISP1: Displays the messages using display
method 1

MESSAGE DISP2: Displays the messages using display
method 2

—ETREND SPACE ON: Inserts a space at the right edge
: (horizontal display) or the top edge
E (vertical display) in the waveform
; display section
'TREND SPACE OFF: Does not insert a space

(To show these items on the menu, see section 5.18.)

groups
AUTO SCROLL OFF: Does not automatically switch the
displayed groups

Sub menu of the digital display

GROLP 1 = , =
2005/18/0] 09:25:01 msp e e (S8 o)
C 1| P1-286 kPa L1

1251797 130. 37
1R QQ"

Group name: Displays the group

AC-307

DIGITAL »

groups
i AUTO SCROLL OFF: Does not automatically switch the
o ! displayed groups

—— AUTO SCROLL ON: Automatically switches the displayed

—— AUTO SCROLL ON: Automatically switches the displayed

IM 04L42B01-01E
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4.2 Displaying the Measured Data as Waveforms, Values, or Bar Graphs

Explanation

Sub menu of the bar graph display

Group name : Displays the group

= —— AUTO SCROLL ON : Automatically switches the displayed
groups

AUTO SCROLL OFF: Does not automatically switch the
displayed groups

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

Starting the Waveform Display of the Trend Display/Stopping the
Waveform Updating

Press START to start the waveform display of the trend display. Press STOP to stop
the waveform updating.

Writing Messages
See section 5.4.

Switching the Displayed Group Using Arrow Keys
Press the right arrow key to switch the displayed group in ascending order. Press the
left arrow key to switch the displayed group in reverse.

Switching the Trend, Digital, and Bar Graph Displays Using the Arrow
Keys

Press the down arrow key while showing the trend, digital, or bar graph display to
switch the display in the order trend, digital, bar graph, trend, and so on. Press the up
arrow key to switch the display in reverse order.

ALL CHANNEL /GROUP CHANNEL on the Trend Display
On the group display, the channels that are assigned to the group are displayed. In all
channel display, the waveforms of all channels that are configured to record data are

displayed on the current group display.
* All channel display is disabled when the trend interval is 30 s/div on the DX2010, DX2020,
DX2030, DX2040, or DX2048 with the external input function (/MC1 option).

SCALE ON/OFF and DIGITAL ON/OFF on the Trend Display
Select whether to show or hide the scale and numeric display sections.

AUTO SCROLL ON/OFF

The displayed groups can be automatically switched at a specified interval by
selecting AUTO SCROLL ON. The display switches in ascending group order.
For the procedure to set the auto scroll interval of groups, see section 5.14.

MESSAGE DISP 1 and MESSAGE DISP 2 on the Trend Display
Switches the message display method.
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4.3

Displaying Past Measured Data (Historical
Trend Display)

There are five methods to display the past measured data.
For a description of the function, see section 1.3.
Recall from the display selection menu (see this section).
Display from the alarm summary (see section 4.6).
Display from the message summary (see section 4.7).
Display from the memory summary (see section 4.8).

Show the measured data stored on an external storage medium (see section 6.8).

Procedure

* Showing the Display
Carry out the procedure below while memory sampling is in progress.
1. Press DISP/ENTER to show the display selection menu.

2. Press the arrow keys to select TREND HISTORY, and press DISP/ENTER.
The display appears.

* Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.
Sub menu of the historical trend display

CTREND T
HISTORY .
—— Group name: Displays the group.

— ALL CHANNEL: Display the waveforms of all
channels.

- GROUP CHANNEL: Displays the waveforms of the
channels registered to groups.

SCALE ON: Displays the scale.
SCALE OFF: Clears the scale.

MESSAGE DISP2: Switches to message display 2.
MESSAGE DISP1: Switches to message display 1.

—— CURSOR TIME ON: Displays the time at the cursor
position at the lower right.

CURSOR TIME OFF: Displays the date/time of the data
at the right edge.

]7 Switches to the specified display.

Return to the display that was shown before the
historical trend.

i rﬁ:ﬁlgﬁ \ [T Displays the alarm summary in the loaded data file.
— Displays the message summary in the loaded data file.
“L— Displays the information of the loaded data file.

e

]— Expands/Reduces the time axis.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

IM 04L42B01-01E
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4.3 Displaying Past Measured Data (Historical Trend Display)

* Moving the Cursor and Scrolling the Waveform
2532511 30 . DisP N 1nin :
1

Moves the cursor to the left by 1 dot.
Hold down an arrow key to move

the cursor by 2 divisions.
Moves the cursor to the right by 1 dot. " y < divist

Use the up and down arrow keys on the vertical trend display.

¢ Displaying the Continuing Data
Approximately one screen of data is shown on the historical trend display. The
continuing data can be shown as follows:

Displayed
N | \_/—/
-« -

SAY

«@’ Move the cursor to the end of the waveform and press
P Q the arrow key yet again to shift a half a page and

” display the continuing data.

Move the cursor to the end of the waveform and press
the arrow key yet again to shift a half a page and
display the continuing data.

* Use the up and down arrow keys on the vertical trend display.
* Specifying the Display Range
Specify the display range. ltems inside the parentheses are for the vertical trend display.

1. Press the up (right) arrow key.

The waveform of the entire data range is displayed at the top (right ) section of the screen.

b pese g OIS I 0 (©)ER "
e =¢—— All data display (all of the

3| data in the display memory)
Loads as much of the

continuous data as the display

memory can hold and shows

the data when switching to the

.| all data display.

a > Frame indicating the

2 display range

~=— Displayed highlighted.
These icons are not displayed

[ T~ ) a0 .
EE‘. s . . if the scale is displayed.
18/01 20 =.--._. " P4

2. Press the left and right (up and down) arrow keys to set the display position by
moving the frame that indicates the display range.

3. Press the down (left) arrow key.
The specified range is displayed.
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4.3 Displaying Past Measured Data (Historical Trend Display)

¢ If the Data Does Not Fit in the All Data Display (Release Number 2 or Later)
Specify the range to be displayed in the all data display.
Below is the procedure to display data that is older than the data displayed currently.
ltems inside the parentheses are for the horizontal trend display.

1.

Press the up (right) arrow key.

The waveform of all the data in the display memory is displayed at the top (right) of the
screen. At the same time, the data area in the internal memory that can be loaded is
displayed. In addition, the data position of 8 MB that is displayed in the all data display is
indicated using a rectangular frame in the loadable data area.

S oA/ 14:29:30, e 01" I S X Loadable data in the
internal memory

— All data display

(all the display data in the
display memory amounting
— to 8 MB)

(o °-”U\Aframe indicating the range
shown in the screen.

1.1361 1.2223

The green arrow indicates
Lz 12 that loadable data exists in
the arrow direction.

v
A frame indicating the 8 MB
[ that is shown in the all data

1.1361

1.2223 .
11338 8.4777 dlsplay.
v

Press the left (down) arrow key to move the frame indicating the display range
to the edge of the all data display. If you press the left (down) arrow key again,
the message “Overwrite old data?” appears.

Select Yes and press DISP/ENTER to replace 4 MB of data in the display
memory.

Press the left/right (up/down) arrow key to move the frame indicating the
display range to specify the range you want to display.

Press the down (left) arrow key.
The specified range is displayed.

IM 04L42B01-01E
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4.3 Displaying Past Measured Data (Historical Trend Display)

Explanation

¢ Dividing the Screen into Halves and Displaying the Current Trend and

Historical Trend Simultaneously
This operation is possible only when the historical trend of the display data is being
displayed. Items inside the parentheses are for the vertical trend display.

*

This operation is not possible when the scale is displayed.

Press the down (left) arrow key.
The current trend is displayed in the right half (top half), and the historical trend is
displayed in the left half (bottom half) of the screen.

GROUP 1 F= ) =
2085/18/81 09:38:47 o i (SR
-] —— Current trend

Historical trend

To revert to the original screen, press the up (right) arrow key.

Writing Add Messages
For the operating procedure, see section 5.4.

ALL CHANNEL/GROUP CHANNEL
The waveforms of channels assigned to the group or waveforms of all channels that
are configured to record data are displayed on the current group display.

SCALE ON/OFF
Select whether to display the scale. The current value mark of the scale indicates the
value at the cursor position.

MESSAGE DISP 1 and MESSAGE DISP 2
Switches the message display method.

TIME AXIS > ZOOM+ and ZOOM-

The time axis can be expanded or reduced around the cursor position.

» Display data: 2 times the trend display to 1/60 minimum

« Eventdata: Reduction only, up to 1/60 minimum
The minimum magnification and the factor by which the display can be expanded
or reduced with one operation vary depending on the trend interval for the display
data and on the sampling interval for the event data. To expand or reduce further,
repeat the procedure.

4-8
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4.3 Displaying Past Measured Data (Historical Trend Display)

¢ INFORMATION (Information on the Displayed Measured Data)
The following information is displayed.

&% DisP NN 19nin +<
EVENT I @

Fi lenane
File type
Serial number

Batch number
Lot nunber

- Be@es2

- Henory » T Page switch mark

- Displa Qomment and text field are
displayed on the second and

* SoETR16a0 third pages when using the

- SAPL-1 batch function.

Use the left and right arrow

Start five 0 SN2 19:16:58 keys to switch the page.
End tine 1 2885/18/28 19:17:84
L
Display Description
File name Data in the internal memory is displayed as “Memory.” For a file
on the external storage medium, the file name is displayed.
Data type Display corresponds to display data, and Event corresponds to

event data.

Serial number

The serial number of the DX that was used.

Batch number, Lot number Displayed when the file is created using the batch function.

Start time and End time The start time and end time of recording.

User name

Name of the user who performed the operation. Displayed when
the login function was used.

Note

When measured data on the external storage medium is displayed, the serial number

corresponds to that of the DX that was used to save the data.

¢ Background Color of the Historical Trend
You can change the background color of the historical trend.
For the procedure to change the background color of the historical trend, see section

5.13.
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4.4 Display the Statuses of All Channels on One
Screen (Overview Display)

This section explains how to use the overview display.
For a description of the function, see section 1.3.

Procedure

¢ Showing the Display
1. Press DISP/ENTER to show the display selection menu.
2. Press the arrow keys to select OVERVIEW, and press DISP/ENTER.
The display appears.

* Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.
Sub menu of the overview display

OVERVIEW = ,
2065/16/8] 69:27:40 o> D win (SR o)

CURSOR OFF: Clears the cursor.
CURSOR ON: Displays the cursor.

—— JUMP TO ALM SUM: Switches to the alarm summary.

L JUMP TO TREND: Switches to the trend display of the
smallest group number that includes
the channel selected with the cursor.

EJUMP TO DIGITAL: Switches to the digital display of the :
1 smallest group number that includes;
the channel selected with the cursor.,

'JUMP TO BAR: Switches to the bar graph display of :
' the smallest group number that

, includes the channel selected with
1 the cursor.

(To show these items on the menu, see section 5.18.)

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.
¢ Showing the Trend, Digital, Bar Graph Display Containing the Specified
Channel
1. Press the arrow keys to move the cursor, and select a channel.
Soaslove 19:27:49 nse N w0 (S)ER *H

Cursor (white Frame)

2. Switch to the trend, digital, or bar graph display according to the procedure
described in “Changing the Displayed Contents.”
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4.5

Procedure

Displaying Various Information

This section explains how to display reports (/M1 and /PM1 options) and how to use the

status display.
For a description of the function, see section 1.3.

¢ Showing the Display

1. Press DISP/ENTER to show the display selection menu.

Press the up and down arrow keys to select INFORMATION.

2
3. Press the right arrow key to display the sub menu.
4

Press the up and down arrow keys to select the sub menu item.
To close the menu without changing the displayed contents, press the ESC key.

Sub menu of the information display

GROUP 1 €5 DisP N 5Onin
2085/12/83 14:54:41  GA EVENT I 59nin

2 T
s 0. 6008
n nnmu:
- — ALARM SUMMARY: Displays alarm summary.
= » See section 4.6.
Lut), MESSAGE SUMMARY:Displays message summary.

0.6000

» See section 4.7.

» See section 4.8.

] |- MEMORY SUMMARY: Displays memory summary.

—— MODBUS CLIENT: Displays Modbus client status.

EMODBUS MATER: Displays Modbus master status. I

5. Press DISP/ENTER.
The display appears.

* Displaying the Report
¢ Switching the Displayed Report Data

ERELAY: Displays relay status.
(To show these items on the menu, see section 5.18.)
— REPORT DATA: Displays report data.

The Index item on the report display shows “the number of the report data being

displayed/the number of report data saved in the internal memory.” The largest

report data number corresponds to the most recent report data.

Number of the report data being displayed

REPORT DATA
2805/16/01 B9:23:58

Index

Kind : Hourly Start : 26A6/18/81 BB:18:56

Timeup: 2WEG/16/81 HY:AA: A

Number of report data saved to the internal memory

Channe] Unit Stz Ave M Hin S
TI-181 °¢ - 4.5 253.9 -E0.8  3.311867E+85
ouT-102 u £ 8.066 B.727 -a.727  1.90d1dAE+A2
FI-183 w3/h L 265.1 416.b #3.3  7.GRBRRGEHHS
VA28 ¥ £ 52,4 .7 23,3 1.51B377EHAS
TI-285 o . 41d.5 553.9 200.8  1,199882E+86
PI-286 kPa £ 162,94 131.98 6884 2.976761E+4H5
AC-387 ¥ L 9.75 16.36 1,81 2.81994E+Ad
PUNP-308 Y < 183,13 196,35 167,26 5.297906E+05
HF-d@3 ¥ . 57, Bl B2.6  1.665LBIEHES
HA-a18 ¥ £ 3.3 7.4 3.3 125176856405

IM 04L42B01-01E
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4.5 Displaying Various Information

Carry out the procedure below to switch the displayed report data.
Up arrow key: Report data being displayed + 1.

Down arrow key: Report data being displayed — 1.

Left arrow key: Report data being displayed + 10.

Right arrow key: Report data being displayed — 10.

Note

The display is not updated even if a new report is created while displaying the report data.
Perform either of the operations below to display the most recent report data.

» Hold down the left arrow key until the latest report data is displayed.

» Press DISP/ENTER and display the report data again from the display selection menu.

* Switching the Report Channels
Up to 30 report channels can be shown on one screen. If there are more than 30
report channels, you can switch the displayed report channels.

Press DISP/ENTER to show the display selection menu.
Press the right arrow key to display the sub menu.
Press the up and down arrow keys to select CHANGE REPORT CH.

Press DISP/ENTER.
The displayed report channels are switched.

R b=

Relay Status Display
Lists the statuses of the alarm output relays and internal switches. You cannot change
the settings on this display.

R B 38:30:16 oisP NN 3nin @ o)
AL s16 Red: ON
. loi . 121 =5u2 =51-, Green: OFF
B ez 122 0 s
I 1e3 123 o st o si9
B 104 124 o s [ e
M o5 RES =sus =s21
$a7 s22
] 1ee 128 =P =
. [11 . 131 [ se9 I 524
112 132 [ st [ sz
= 113 = 133 [ su1 [ 525
= s12 [ s27
0] 114 0] 134 st [ sz
0l s s [ s14 I sz
I 118 I 136 B 55 0 s

Modbus Status Display

Lists the statuses of the Modbus client or Modbus master commands.

For the operating procedure, see the Communication Interface User's Manual
(IM04L41B01-17E).

Read cycle I 1s

Connect. retry : lEIminj Communication conditions
Conn. Data
No. Status First Last  Server name Registers
» READ @ Good 281 - 261 18.8.233.98 30001

READ @ Good 282 - 262 10.8.233.98 38082
READ @ Good 203 - 283 10.8.233.99 30083

1

;

4 —_— e—e—e— —
g | L Communication destination
g DX channels

8 Status

11 Command
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4.6 Using the Alarm Summary

Procedure

Explanation

This section explains how to use the alarm summary.
For a description of the function, see section 1.3.

* Changing the Displayed Contents

1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.

ALARN SUMHARY P . o
2805/1/8]. B9:23:27 oise I 0 (B)ER *)
Channel Type (> BtarnTi Sort symbol
S I T H 2085/10/81 09:22:19 ;
o 2085/10/81 09:21-38 A Ascending sort
PI-206 H 2885/18/81 B9:21:32 ¥ Descending sort
AC-387 1L 2805/18/81 B9:21:15
AC-307 2 20B5/10/81 £9:19:41
TI-181
e TI-181
AC-387
(11 Ac-387
= PI-286
i

AT10 Display name: Switches to the specified display

IBIGAES —— TO HISTORY/(DISP):

—l_L TO OVERVIEW: Switches to the overview display

CHANGE SORT KEY: Sort the alarm information by
channel or alarm time

ASCENDING ORDER: Sort in ascending order
DESCENDING ORDER: Sort in descending order

Switches to the historical trend display

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

Moving the Cursor (#) and Scrolling the Alarms

Scrolls the alarm information up by half a page
Moves the cursor up

SAY
‘@’ Scrolls the alarm information down by half a page
4 A\

I3
Moves the cursor down
Recalling the Historical Trend Display at the Point When the Alarm
Occurred

1. Select an alarm with the cursor.

2. Display the historical trend according to the procedure described in “Changing the
Displayed Contents.”

CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER

The alarms are sorted in ascending or descending order by the following keys. The

sort symbol is displayed next the sort item (see the figure above).

» Channel number: Sorts the alarms by channel number even if tags are being
used. Alarms in a channel are sorted by the alarm number.

» Time of alarm occurrence/release

IM 04L42B01-01E
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4.7 Using the Message Summary

This section explains how to use the message summary.
For a description of the function, see section 1.3.

Procedure

* Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.

HESSAGE. SUHERY = ,
2885/18/28 18:36:08 DIsP I nin

ssage - Group Sort symbol
— 2805/18/28 18:34:58 A11 i
A~ ure 285/16/28 18:34:08 A1 A Ascendlrrg sort
2685/18/28 18:33:49 A1 w Descending sort

i)
i)
s

7 OR

2 il Display name: Switches to the specified display
= IERIBVEI — TO HISTORY(DISP):  Switches to the historical trend display

CHANGE SORT KEY: Sort the messages by channel, time,
group, or user name

ASCENDING ORDER: Sortin ascending orde
DESCENDING ORDER: Sort in descending order

CHANGE DISP ITEM: Switches between “time and group”
and “user name”

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

* Moving the Cursor (=) and Scrolling the Messages

Scrolls the messages up by half a page
— Moves the cursor up

\/
‘@’ Scrolls the messages down by half a page
&

Moves the cursor down
* Recalling the Historical Trend Display at the Point When the Message
Was Written
1. Select a message with the cursor.

2. Display the historical trend according to the procedure described in “Changing the
Displayed Contents.”

Explanation

e CHANGE DISP ITEM
Switches between the following two message display methods.
* Message, time, and group
* Message, user name

e CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER
The messages are sorted in ascending or descending order by the respective key.
The sort symbol is displayed next the sort item (see the figure above).
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4.8 Using the Memory Summary

Procedure

This section explains how to use the memory summary.
For a description of the function, see section 1.3.

* Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.
HEHORY SUHHERY DISP N 59nin B&R

2085/12/83 13:85:15 G EVENT IS 59nin

(pa1/4BR> : 20R5/12/A3 12:56:21
(B157168) : 2085/12/83 12:45:18

fa : @DISPLAY DATA (O EVENT DATA - -
irt Time  End Time Data Factor The displayed data type is
B3 13:04:18 298¢ indicated with a green mark.

— B3 12:44:54 288

12 B3 12:44:82 200

L1,

+ Display name: Switches to the specified display

[—TO HISTORY: Switches to the historical trend display.
—— SELECT SAVE: Saves a selected file.

TO HISTORY

—L.M.SAMPLE SAVE: Saves all manual sampled data.

REPORT SAVE: Saves all report data.
(To show these items on the menu, see section 5.18.)

ALL SAVE: Saves all data.

CHANGE DATA KIND: Switch between display data
and event data.

FILENAME DISPLAY: Displays the file name.
For a description of file names,
see section 1.4.

TIME DISPLAY: Displays the times of the first and
last data in the file.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

¢ Moving the Cursor (=) and Scrolling the Memory Information

Scrolls the memory information up by half a page
— Moves the cursor up

GAL
‘@’ Scrolls the memory information down by half a page
5

Moves the cursor down
* Displaying the Historical Trend for the Data Specified by Memory
Summary
1. Select the data with the cursor.

2. Display the historical trend according to the procedure described in “Changing the
Displayed Contents.”

IM 04L42B01-01E
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4.8 Using the Memory Summary

¢ Saving the Data
Save the data in the internal memory to the CF card or the USB flash memory (/USB1
option).
For a description of the function, see section 1.4.

1. To save by selecting the file, select the desired data file with the cursor. This
operation is not necessary for other cases.

HEHORY SURHARY e

{pA1/48@) @ 20A5/18/28 18:34:54
(ga1/16@> - 20@5/18/28 19:68:80

: {DDISPLAY DATA
Start Tine End Time Data Factor
2085-10/28 18:56:82 20808510728 19:83:24 222 Sanmpling
=) 20p5/10/28 18:36:02 2085/18/28 18:56:80 688 Auto Save
I 2885/10/28 18:16:82 2805/18/28 18:36:00 688 Auto Save

2005/18/28 19:03:26

H.SANPLE DATA
REPORT DATA

SAMPLE DATA

Cursor
(Move using the
arrow keys)

2. Press DISP/ENTER to show the display selection menu.
3. Press the right arrow key to display the sub menu.

4. Select the sub menu item using the up and down arrow keys.
Sub menu items are SELECT SAVE, M\.SAMPLE SAVE, REPORT SAVE (/M1 and /PM1
options), and ALL SAVE.

5. Press DISP/ENTER.

* If you are using a CF card and a USB flash memory (/USB1 option), the message “Which
media do you want save to?” appears. Select the destination medium using the arrow keys,
and press DISP/ENTER.

The measured data is saved.

Note

To abort the data saving operation in progress, carry out the procedure below.
Press FUNC and press the Save Stop soft key.

Progress Display When Saving All Data of the Internal Memory (Release
Number 2 or Later)
If you carry out All Save* on the memory summary screen, a pop-up window appears
showing the progress of the save operation.

* Function for saving all data in the internal memory to a CF card or USB flash memory.

®H

HMEHORY SUHHARY
2B07/04/86 10:34:22

Bt s DN nin

M. $AMPLE DATA  (@@B/408) :
REPORT DATA (dea/16@) :
SAMPLE DATA  : @ DISPLAY DATAC.DAD)
Start Time End Tine Data Factor

=) 2B07/84/86 10:32:01

2B07/04/86 1B:25:85
2007/04/086 18:19:87
2B07/04/86 16:09:87
2B07/04/86 B9:59:87
2RR7/04/086 P9:49:87
2667/84/86 B9:39:07
2B07/04/86 89:29:87
2B07/04/86 B9:19:87
2007/04/86 B3:A9:87
2B07/04/86 088:59:87
2B07/04/86 B8-49:87
2B07/04/86 B8:39:87
2007/04/086 B8:29:87
2B07/04/86 08:19:87
2B07/04/86 B8-09:87

2B087/04/86 10:34:21
2B07/04/86 10:308:87
2BR7/04/86 10:24:19
2B07/04/86 10:19:86
2B07/04/86 10:09:86
2BR7/04/06 B9:59:06
2007/84/86 B9:49:06
2B07/04/86 B9:39:86

R0 An-n0-n

2B07/04/86 B8:29:86
2B07/04/86 B8:19:86

141 Sampling
383 Stop

313 Stop

688 Auto Save
688 Auto Save
668 Auto Save
608 Auto Save
608 Auto Save

688 Auto Save
688 Auto Save
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4.8 Using the Memory Summary

Explanation

Note

* The pop-up window appears only when the memory summary display is showing.

* If you press the ESC key, the pop-up window clears temporarily and reappears
approximately 10 seconds later.

* The time estimate for saving all data is indicated in the table below (when the memory is full
of data). It may take longer depending on the operating conditions of the DX.

Save Destination Time to Save All Data (Estimate)
CF Card USB Flash Memory
Standard memory 4 minutes 5 minutes (16 minutes)*
(internal memory size suffix code -1)
Large memory 10 minutes 15 minutes (40 minutes)*

(internal memory size suffix code -2)

*

Values for the DXs with firmware version 2.02 or later. Values inside the parentheses are
for the DXs with firmware version 2.01 or earlier.

» To abort the data saving operation in progress, carry out the procedure below.
Press FUNC and press the Save Stop soft key.

e Save directory

The data is saved by creating a directory each time the save operation is carried out.
Directory name: Specified string_YYMMDD_HHMMSS (where YY to SS is the date
of operation)

Save/Load > File list/delete File list example
[CF=7

Directory name Date / Time

DATA1A18 20@5/10/22 10:11
DATA1A27_851 028198351 2085/10/28 19-83
DATAB925 e —" 1 a1 |

Save directory

Display data or event data that is in the process of adding data cannot be saved.
The save operation explained here merely copies the data in the internal memory.
It does not save the unsaved data in the internal memory (see section 1.4).

Data saving is aborted when there is insufficient free space on the storage medium.
Use a storage medium with sufficient free space when saving data.

IM 04L42B01-01E
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4.9 Displaying a List of Operation Logs

Procedure

Explanation

Displays the following operation logs.
Login log, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP
log, and Modbus status log

* Displaying the Log

1. Press DISP/ENTER to show the display selection menu.
2. Press the up and down arrow keys to select LOG.
* To show LOG on the menu, see section 5.18.

3. Press the right arrow key to display the sub menu.

4. Press the up and down arrow keys to select the sub menu item.
To close the menu without changing the displayed contents, press the ESC key.
Sub menu items are LOGIN, ERROR, COMMUNICATION, FTP, MAIL, WEB, SNTP,
DHCP, and MODBUS.

5. Press DISP/ENTER.
The display appears.

e Login Log

The log number of the last line and the
total number of logs

5P T 1) )

fAction Factor Usernane

2085/18/27 13:28:49  NewTine KEY
2685/18/27 13:28:52 Tinethe KEY
2085/18/27 13:28:48  NewTine KEY
2085/01/81 BB:47-84 TineChy KEY

| L User name
Operation method (see the table below)

Operation (see the table below)

Date/time
Action Description
Login Login
Logout Logout
NewTime Time change while memory is stopped
TimeChg Time change through key operation
PowerOff Power OFF (power failure occurred)
PowerOn Power ON (recovered from a power failure)
TrevStart Start the operation of gradually adjusting the time
TRevEnd End the operation of gradually adjusting the time
TimeDST Switch the daylight savings time
SNTPtimset Time change by SNTP
Factor Description
KEY Key operation
COM Operations via communication
REM Operation through the remote control function
ACT Operation through event action
SYS Operation by the system
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4.9 Displaying a List of Operation Logs

e Error Log

ERROR L0G
2005/18/27 17:12:29

DIsP Wi ([©)

(013/813) Tine

20@5/18/27 16:60:80
2085/18/27 14:36:38
2085/18/27 14:36:18
2085/18/27 14:36:15

298 SNTP access fai lure.

232 There is no available data.
232 There is no available data
232 There is no available data.

2085/18/27 13:48:09 681 HMeasured data have been initialized.

!

Error n ge*
Error code*

Date/time

*

See section 11.1, “A List of Messages.”

e Communication Log

"COMMUNICATE LOG [ nien mmeemmm e . (M o |
2885/18/27 17:12:45 DIsP NI 36nin @

{888/808) Tine ID Username 170 H Link 0
2085/18/87 15:18:12 1 Adminl < {18858 byte)

2085/18/87 15:18:12 1 Adminl > S

2085/18/87 15:89:39 1 Adminl < {58 byte)

2085-/18/87 15:89:39 1 >

Adninl srﬁﬁl?
Message*

Input/output symbol (>: input, <: output)
User name

User ID number (0: serial, 1 to 3: Ethernet)
Date/time

* See the Communication Interface User's Manual (IM04L41B01-17E).

»
2
-
(2]
=
=}
«Q
o
T
(]
=
Q
=
o
=}
(7]
2]
=
(]
(]
=}
(7

* FTP Log
FTP_LOG — =
2805/18/27 17:53:49 oisP I 1h:5%nin (D)
{B64/884) Tine No. Code Flag  Filename
2085/18/27 17:51:33 P 851827_1738888. DAD

2085/18/27 17:29:83 P
2085/18/27 17:21:81 P
2085/18/87 11:36:82 282 HOSTNAME P

851827_1722560. DAD
FTP_TEST. TXT
8518861569480 DAD

File Name

FTP connection destination
(P: primary, S: secondary)

Error ge (detail code)*
Date/time

*

See section 11.1, “A List of Messages.”

e Web Log
WEB LOG P o
2085/16/27 17:53:11 oisP N 1r:sein SRR = )
{BB5/005) Time Request No.  Parameter
2005/16727 17:31:19  Key DISP/ENTER
2B85/18/27 17:31:15  Key DOWN
2B85/18/27 17:31:13  Key RIGHT
2885/18/27 17:38:59  Key DISP/ENTER
2885/18/27 17:30:48  Soreen TREND ~ GROUP=1

Operation (see the table on the next page)
Error code*

Requested operation (see the table below)
Date/time

*

See section 11.1, “A List of Messages.”

Request Description

Screen Screen switch

Key Key operation

Message Message assignment/write
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4.9 Displaying a List of Operation Logs

Parameter

Description

TREND

Trend display

DIGIT

Digital display

BAR

Bar graph display

HIST

Historical trend display

oV

Overview display

DISP

DISP/ENTER key

UP

Up arrow key

DOWN

Down arrow key

LEFT

Left arrow key

RIGHT

Right arrow key

FAVOR

Favorite Key

Messages

Character strings that are written.

e E-mail Log

WAL L0G = — =
2085/18/27 17:53:27 pis I 1h:5nin (S G =

{BB5/885) Tine Type

* l))
Recipient / Error

2885/18/27 17:23:49
2885/18/27 17:22:39
2885/18/27 17:22:18
2885/18/27 17:21:54

Test

fAlarn
Alarn
Alarn

266 1 Ethernet cable is not connected.

1 Haruo-Saitou
1 Haruo.Saitou
1 Haruo.Saitou

| I— Recipient (mail address, message)
Recipient (1: recipient 1, 2: recipient 2)

Error code*

Event (see the table below)

*

Date/time

See section 11.1, “A List of Messages.”

Type Description
Alarm Alarm mail
Time Scheduled mail
Report Report timeout mail
Fail Power failure recovery mail
Full Memory full mail
Test Test mail
Error Error message mail
¢ SNTP Log

SNTP LOG
2005/18/27 17:53:85
{B82/882) Tine

No. Code

oisP I 1h:Somin () G i

o)

2885718727 17:22:08
2685-16/27 16-00:80 298 LINK

SICCESS

] !

Error age (detail code)*

Error code*

Date/time

* See section 11.1, “A List of Messages.”
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4.9 Displaying a List of Operation Logs

e DHCP Log

DHCP L0G = — =
285/10/27 17:54:36 s> N thsonin (B S )
(617/817) Time No. Code

2085/18/27 17:54:29 566 NOREQUEST
2885/18/27 17:54:23 565 IPCONFIG
20085/10/27 17:54:29 564 RENEMED

2085/18/27 17:54:29 565 IPCONFIG

Error n age (detail code)*
Error code*

Date/time

*

See section 11.1, “A List of Messages.”

* Modbus Status Log

HODBUS LOG == —_ —
205/10/27 17:52:58 o N thsenin (Q)ER )
{B28/182) Tine Kind Factor  Command

2085/18/27 17:52:85 C © GoD MR
2665/18/27 17:52:85 C O Goop AL R
2885/18/27 17:52:84 C 9] 82 R
2885/18/27 17:52:84 C o LR

T— Command number, command type

(R: read, W: write)

Communication status*®

Communication type (C: client, M: master)
Date/time

* See the Communication Interface User's Manual (IM04L41B01-17E).

»
2
-
(2]
=
=}
«Q
o
T
(]
=
Q
=
]
=}
(7]
2]
=
(]
(]
=}
7]
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4.10 Showing the Four Panel Display

Procedure

This section explains how to use the four panel display.
For a description of the function, see section 1.3.

¢ Showing the Display

1.
2.

Press DISP/ENTER to show the display selection menu.

Press the arrow keys to select 4 PANEL. Then, select the desired four panel
name, and press DISP/ENTER.
The display appears.

» Switching the Display
Press the right arrow key to change the display in the order “four panel 1,” “four
panel 2,” “four panel 3,” “four panel 4,” “four panel 1,” and so on. Press the left arrow
key to switch the display in reverse order.

* Changing the Displays Assigned to the Four Panel Display
Carry out the procedure below on the four panel display.

1.

Press DISP/ENTER.
The title bar of one of the four panels turns dark blue.

Select the panel you wish to change the display using the arrow keys (the panel
of which the title bar is dark blue is the selected panel).
s/ 1o/ Bo:21 s> I win (5 *)

GROUP 1
TI-181 °C =|PI-206
21

OUT-162 V= AC-3a1
8.698 L
FI-1E8 n3/h=

va-264

TI-2685

The title section of the
selected quadrant
displayed in dark blue.

GROLP 1
1 23 45 6 7 8 918
L

Press DISP/ENTER to show the display selection menu.
Press the arrow keys to select the display to be assigned.

Press DISP/ENTER to assign the specified display to the selected panel.
To close the menu without assigning the display, press ESC.

Registering the Four Panel Display with a New Combination of Screens

Operate as described in “Changing the Name of the Four Panel Display” on next
page.

*

If you switch to other screens and return to the four panel display without registering the
display, the new combination of four panels returns to the original.
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4.10 Showing the Four Panel Display

¢ Expanding One the Panels to Full Screen

1.

2.

Aw

Press DISP/ENTER.

The title bar of one of the panels turns dark blue.

Select the panel you wish to expand using the arrow keys (the panel of which the
title bar is dark blue is the selected panel).

Press DISP/ENTER to show the display selection menu.

Press the right arrow key to show the sub menu.

Press the up and down arrow keys to select EXPAND.

To show EXPAND on the screen menu, see section 5.18.

oise NN iEnin (D) o)
OVERVIEW

Select EXPAND

This EXPAND is not shown under the initial conditions. To show, operate as follows:
Press MENU and select Menu customize > Display menu. Set EXPAND on the
display menu to View.

For the operating procedure, see section 5.18.

Press DISP/ENTER to expand the specified panel.
To close the menu without expanding the screen, press ESC.

¢ Changing the Name of the Four Panel Display
If you change the name of a four panel display, the specified name appears in the
display menu.
Carry out the following procedure when the four panel display is shown.

1.

Press FUNC to display the FUNC key menu.

2. Press the 4Panel soft key to display a list of four panel names.

HIX e -
2085/18/28 18:25:25 DisP N 16nin =
OYERVIEW

1

“T=[PI-286 &P
131.43

GROUP 1

1 2 3 456 7 8 918

W0

4Panel 1 |4Panel 2 |dPanel 3 | dPanel 4 NN

Press any of the 4Panel 1 to 4panel 4 soft keys to display a window used to enter
the display name.

Enter the display name (up to 16 characters, [Ala#[1])

Press DISP/ENTER to activate the specified display name and return to the four
panel display.

To cancel the change, press ESC.

IM 04L42B01-01E
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Chapter 5

Operations for Changing the Displayed Contents

5.1

Setting Display Groups

Assign channels and set the group name for each display group. Set lines at specified

positions in the waveform display range on the Trend display.

Setup Screen

Press MENU (switch to the setting mode) and select Group set, Trip line

Group nunber
= Group set
On/0ff On
Group name GROUP 1
CH set 81.82.B3.84.85.86. 7. 88.89.18
r Trip line
Position Color Line width
1 On 50 % [ | Red 2 dot
2 0ff
3 0ff
4 off

1 2 3 4 5 6 Next 1/6

¢ Group number
Select the target group number (1 to 36).

¢ Group set

¢ On/Off
Turn On the groups you want to use.

¢ Group name
Set the group name. (up to 16 characters, [A[a[#1])

* CH set
Set up to 10 channels from measurement channels, computation channels (/M1
and /PM1 options), and external input channels (/MC1 option).
» Enter the channel number using two or three digits.
» Separate each channel with a period.
» To specify a range of consecutive channels numbers, use a hyphen.

Example: To assign channels 1 and 5 to 8, enter “001.005-008.”

Nofte

« The trend, digital, and bar graph displays are shown in the specified order.
* Achannel can be assigned to multiple groups.
« The same channel cannot be assigned multiple times in a group.

IM 04L42B01-01E
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5.1 Setting Display Groups

Note

The channel settings of a display group can be copied to another group on a DX with release
number 2 or later.

GROUP 1 <
R /s 174334 e i I 1hor (D)
Group set, Trip line

Group number 1
= Group set
On/0f f On
Group name GROUP 1
CH set AA1.A82. BA3. AA4. AAS. AAG. AA7. BBS. AAY.A18
= Trip line
1 0ff
2 0ff
3 0ff
4 off
Input Clear Copy Paste
Procedure

1. Select the copy source channel settings.

2. Press the Copy soft key.

3. Select the copy destination channel settings.

4. Press the Paste soft key. The channel settings are copied.

e Trip line
Set lines at specified positions in the waveform display range on the Trend display.
e On/Off
Turn On the trip lines you want to display.
* Position
Set the position in the range of 0 to 100% of the display width.
e Color

The default colors are red, green, blue, and yellow. If you want to change the color,
select from the 24 available colors.

e Line width
Set the line width of the trip line in dots (1 to 3).
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5.2 Displaying Tags or Channel Numbers

Display the channels using tags or channel numbers.

Setup Screen

* Tag/Channel
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > Operating Environment

Environment > Operating environment

Operating environment

Tag/Channel
Language English

Remote Controller ID 2

Tag Channel
* Tag
Press MENU (switch to the setting mode) and select Meas Channel > Tag,
Memory sample, Alarm delay

GROLP 1 r= ,
She/a0ran ps:1522 e OIS DN min  (©) )

Heas Channel > Tag. Henory sample. Alarn delay
First-CH Last-CH [l

Tag
(Tas
Menory sanple
(Unlﬂff On

Alarm delay
(%ime 18 s

¢ Operating environment > Tag/Channel

Settings Description

Tag Displays tags. Channel numbers are displayed for channels that do not have tags
assigned.

Channel Displays channel numbers.

* First-CH/Last-CH
Set the target channels. The target channels are common with the other items that are
displayed on the screen.

* Tag > Tag
Set the tag. (up to 16 characters, [Ala[#[1])

IM 04L42B01-01E 5-3
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5.3 Setting the Trend Interval and Switching to the
Secondary Trend Interval

Setup Screen

Setup Items

Set the trend interval. Switch the trend interval to the secondary trend interval while the
memory sampling is in progress. Automatically write messages when the trend interval is
switched.

For a description of the function, see section 1.3.

¢ Switching the Trend Interval and Writing Messages (When Using the
Secondary Trend Interval)
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > View, Message, Input,
Alarm

Basic Setting Hode

Environment > View, Hessage, Input, Alarm

r Vieu — Input
Trend type T+ (Ualue on over-range Over
—m

Partial On

Trend rate suitching [IRNN Alarn
(Detect

0ff

r Hessage

Write sroup Comnon
Power-fail nessage On
Change message On
On 0tf

¢ Trend interval [/div] and Secondary interval [/div]
Press MENU (switch to the setting mode) and select Display > Trend/Save
interval

GROUP 1 = _
oo 80 po:17:00 g DI DN 1min ()

Display > Trend/Save interval

Trend / Save interval

Trend interval [/div]
o

Save interval 1h

Second interval [/div] 1nin

* View > Trend rate switching
On: Enables the function that switches the trend interval while the memory sampling
is in progress. The “Second interval [/div]” item is displayed in the setting mode.

When the trend rate switching function is On, the DX cannot be configured to record both the
display and event data (see section 6.1).

* Message > Change message
On: Writes the time the interval is switched and the new trend interval as a message
when the trend interval is switched.

IM 04L42B01-01E



5.3 Setting the Trend Interval and Switching to the Secondary Trend Interval

Procedure

¢ Trend interval [/div] and Second interval [/div]
Select the time corresponding to 1 division of the time axis on the trend display from
below: You cannot specify a trend interval that is faster than the scan interval.
15s*, 30s, 1min, 2min, 5min, 10min, 15min, 20min, 30min, 1h, 2h, 4h, and 10h
* Can be set on the DX2004 and DX2008.

Note

If the trend interval is set greater than or equal to 1h/div on a DX with release number 2 or later,
the month, day, and hour at the grid position are displayed on the screen. The display format
can be changed by setting the date format.

GROLP 1 F= _— =
2007/84/24 18:49:50 oisp N th:senin () BB
1h/div 0

Month, day, and hour
at the grid position.

¢ Switching the Trend Interval

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Normal speed soft key or Second speed soft key.
The trend interval is switched. A message is written on the trend display (when the change
message is turned ON).
Display example: 10:53 1min/div

IM 04L42B01-01E
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Setup Screen

Write messages.

* Message Write Group

5.4 Writing Messages

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > View, Message, Input,

Alarm

Basic Setting Mode

Environment > View, Hessage, Inpbut, Alarm

r View E—
Trend type ¥ (
Partial off
Trend rate suitching off

r Hessage e
Write group
Power-fai | message 0ff
Change message off

* Setting the Messages
Press MENU (switch to the setting mode) and select Message

Value on over-range

Alarn
(Detect

Hessage
Hessage No. 1-18
Characters
1 START
2 Temperature
3 Pressure
4 STOP
5
[
7
8
9
18

1-18 11-28 21-38 31-48

* Message

¢ Write group
This setting applies only for messages that are written using keys.

41-58

Settings

Description

Common

Write the message to all groups.

Separate

Write the message to the displayed group.

¢ Power-fail message

See section 5.17.

¢ Change message

See section 5.3.
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5.4 Writing Messages

* Message No.
Select the message number (1 to 100). Messages 1 to 10 are common with free
messages.” If a message is changed as a free message, the old message is
overwritten.
* Messages that are written by creating the message on the spot.

¢ Message > Characters
Set the message. (up to 32 characters, [Ala[#]1])

Procedure

* Writing Messages
Messages cannot be written when the memory sampling is stopped.

1. Display the group to write the message.

« If a screen unrelated to a group such as the overview is displayed, messages are written to
all groups even when Write group is set to Separate. For the four panel display, messages
are written to the displayed groups.

» Messages are written to all groups regardless of the displayed screen when Write group is
set to Common.

2. Press FUNC.
The FUNC key menu appears.

3. Press the Message soft key.
4. Press the soft key corresponding to the desired message number range

(example: [1-10]).
A list of message is displayed.

GROUP 1 = ,
2005/18/28 18:33:28 DIsP NN zZnin

Imin/diy

kPaz
69.54

5

2.17

y

N 167.97
J 3
3 52.8

fA-410 2
1 2 3 4 5 [ Next 142 | <)

YY.o

5. Press the soft key corresponding to the number of the message you want to write.
A message mark, time, and message are shown on the trend display.
Dh0s/50/16 14:08:51 ois I snin (B 6

1min/div

=

WTE'HIHI‘L-’ ‘HH\"“(I‘HH‘HII‘HHEI‘HII‘\HIU1!
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5.4 Writing Messages

* Writing Free Messages
Create a message on the spot and write it.
1. Display the group to write the message.
2. Press FUNC.
The FUNC key menu appears.
3. Press the Free message soft key.

4. Press a message number soft key.
The message entry window appears.

5. Enter the message. (up to 32 characters, [Ala[#1])

6. Press DISP/ENTER.
A message mark, time, and message are shown on the trend display.

e Writing Add Messages

Add messages to the past data positions. This operation can be carried out on the

past section of the data that is currently being memory sampled.

1. Carry out the procedure below to show the historical trend of the data that is
currently being memory sampled.

Press DISP/ENTER and select TREND HISTORY > (group name) > DISP/
ENTER

2. Press the arrow keys to move the cursor to the position you want to write the
message.

3. Write the message according to the procedure given in “Writing Messages” or
“Writing Free Messages.” Use the Add Message or Add Free Message soft key.

GROUP 1
2005/18/27 13:45:43

Add message

Cursor
(yellow line)

4.5

Explanation

¢ Display Color of Messages
The message colors on the trend display are shown below. You cannot change them.

No. 1 2 3 4 5 6 7 8 9 10

Color Red Green Blue Blue violet Brown Orange Yellow-green Light blue Violet Gray

The colors for messages 11 to 100 are repetitions of the colors above.

* Add Message
* The message timestamp is the time that the message is written. It is not the time
stamp of the data at the position where the message is written.

= Display example on the
MESSAGE SUMHARY = ; = =
265/16/27 13:45:34 s> I win (D) 5B )} message summary
(PB1/BB1>  Hessage Tine Group

= HOLD 2885/18/27 13:44:58 All

Add message
(displayed in blue)

« Up to 50 messages can be written.
» Messages cannot be added to data in the internal memory that has already been
saved to a file or data that has been loaded from the external storage medium.

5-8
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5.5 Changing the Channel Display Colors

Setup Screen

Change the channel display colors. The settings are applied to the trend and bar graph
displays.

Press MENU (switch to the setting mode) and select Meas Channel > Color

GROUP 1 = ,
2005/09/20 09:19:41 e 0157 NN L7nin

Meas Channel > Color

Group of channel

Ba1
Be2
883
Be4
B85
BB6
Ba?
Be8
Be9
pia

Color

Red
Green
Blue

B.violet

Browun
Orange
Y. green

Lightblue

Violet

Gray

B01-818

e Group of channel
Select the target channels.

e Color
To change the color, select from the following 24 colors.

B11-828

B01-616

831-p48

841-B48

)

Red, green, blue, blue violet, brown, orange, yellow-green, light blue, violet, gray, lime,

cyan, dark blue, yellow, light gray, purple, black, pink, light brown, light green, dark

gray, olive, dark cyan, and spring green

IM 04L42B01-01E
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5.6

Setup Screen

Displaying Channels in Display Zones

Specify a waveform display zone for each channel so that waveforms do not overlap.
For a description of the function, see section 1.3.

Press MENU (switch to the setting mode) and select Meas Channel > Zone,
Scale, Bar graph

GROUP 1 = ,
Shoao/an pocon-n R DI DI 1hin ()

Heas Channel > Zone. Scale, Bar graph

First-CH [0  Last-CH [}
r Zone —_—
Lover [ 3
Upper 188 %
r Scale —_—
Position 1
Division 18
r Bar graph
Base position Nornal
Division 18

First-CH/Last-CH
Select the target channels. The target channels are common with the other items that
are displayed on the screen.

Zone > Lower, Zone > Upper

Sets the zone in which the waveform is displayed. You can set Lower and Upper as
a position (%) when taking the maximum display width to be 100%. Set Upper greater
than Lower, and the zone width (Upper — Lower) greater than or equal to 5%.

Lower: 0to 95%

Upper: 5to 100%

5-10
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5.7 Displaying a Scale on the Trend Display

Setup Screen

Setup Items

Display a scale on the trend display.
For a description of the function, see section 1.3.

Scale Position and Number of Scale Divisions
Press MENU (switch to the setting mode) and select Meas Channel > Zone,
Scale, Bar graph

GROUP 1 = A
Sise poropse el D1 I 1in () )
Meas Channel > Zone. Scale. Bar graph
First-CH [@81 Last-CH [
= Zone —_—
Lower [ 1
Upper 188 %
r Scale —_—
Position
Division 18
r Bar grarh
Base position Normal
Division 18
0ff 1 2 3 4 5 Next 1/2

Number of Displayed Scale Digits and Current Value Indicator
Press MENU (switch to the setting mode) and select Display > Trend, Bar
graph, LCD, Monitor

GROLP 1 r= - -
o8e5/89/30 p9:o1:21 el DISP NN 17nin = )

Display > Trend. Bar graph. LCD. Monitor

Trend —_— F LCD —_—
Direction Horizontal Brightness 2
Trend clear Off Backlight saver
Hessage direction Horizontal Hode Off
Scale

Digit
Value indicator Hark
Trend line 2 dot | _ Honi tor
Grid Auto  div
Backaround
B el Display White
Historical trend Black
(Direction Vertical Scroll time 18s
Jump default display off

Showing the Scales

To show scales on the trend display, press DISP/ENTER (show the display
selection menu) > the right arrow key (show the sub menu), and select
SCALE ON (see section 4.2).

First-CH/Last-CH
Select the target channels. The target channels are common with the other items that
are displayed on the screen.

Scale > Position
Select the scale display position on the trend display from 1 to 10. Select Off if you do
not wish to display the scale.

IM 04L42B01-01E
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5.7 Displaying a Scale on the Trend Display

e Scale > Division

Select the number of main scale marks on the trend display from 4 to 12 and C10.
C10: The scale is equally divided into 10 sections by main scale marks, and scale
values are indicated at 0, 30, 50, 70, and 100% positions on the trend display.

The figure below is an example in which each scale is displayed with the position

shifted.
Horizontal Trend Display

F‘ Scale display position

r Y
10 9 8 7 6 5 4 3 2 1
100 100 [i00 [100 100 |
= ® - - - -

E S Y C

= SEEE ML

E O R =
il = E M E E -

E g = - 6 - [

= =S EREE

50 mit it B0 fmit 50 it 50
:_mt:jit i4 :nit: :nit: _mt
= = Sl

E B EEEBE L

= = L BEE

= = 2L L af
= = EE P L

Fasaasana
|0 @ﬁ ]

-

Number of scale divisions:
Number of scale divisions:
Number of scale divisions:
Number of scale divisions:
Number of scale divisions:

© oo ~NO O DN

Number of scale divisions:

Number of scale divisions: 1

Number of scale divisions: 1

Vertical Trend Display

‘25 uni t|5|] |75 100]
Lo o P g1 |_t|||||||| ||||||||1|
|||||||||||||||||||_t|um||||||||||||||||||||||1
L R |||||||||L|m|'|||t|\||||||||||||\|||| ||||||1
M ERann ||||||||||||||!tlum|||||||||||||||| |||||||||||||1|
||||||||||2|2‘|\|||||||||||||‘|1‘|:T'||||_t||||||||||\5|6\|||||||||||||| ||||||1|
||||\|\||ZLJ||||I|||||||||||4Ld|‘|||||u|n|'|||\||||||||||||\||||||||dﬂ||\||||||||||

unit 60 1i

unit
||\|||||||||||||||\||||||||||||_|| Bt oo g ot

9 ,1||||||||1||5|||||||‘||\||| ||3||3||I||||||||||TT|'|t|éﬁ|\|H||||||||||||5|?|| III|HI\|IIII|BI?II|IIII|IIII|%
i é-h unitéH 1
C10 [0 Lo o BT e o S o b b S oo fo i

—| Scale display position

<—Number of scale divisions:
<—Number of scale divisions:
<Number of scale divisions:
< Number of scale divisions:
<«Number of scale divisions:
< Number of scale divisions:
< Number of scale divisions:
< Number of scale divisions:
< Number of scale divisions:
< Number of scale divisions:

0
1

Number of scale divisions: 12
Number of scale divisions: C10

o N o b

9
10
1
12
Cc10
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5.7 Displaying a Scale on the Trend Display

Note

» If the scales of multiple channels are set to the same position, the scale of the channel
assigned first to the group is displayed.

Example: If the order of assignment of a group is 003.002.001, and the scale display

position of all channels is set to 1, the scale of channel 3 is displayed at display position 1.

» Even if some of the scale display positions are skipped, the scale is packed towards display
position 1.

Example: Suppose the assignment of channels to a group is 001.002.003, and the display

positions of the scales are set to 1, 3, and 6, respectively. The scales are actually displayed

at positions 1, 2, and 3, respectively.

* The scale is divided into 4 to 12 sections by the main scale marks. The section between
the main scale marks is divided into 10 subsections by medium and small scale marks.
However, small scale marks are not displayed in the following cases.

* When the resolution of the input range is smaller than the total number of small scale
marks.

* When zone display is used.

*  When partial expanded display is used.

* The scale values are displayed according to the following rules.

» If the number of scale divisions is 4 to 7 for the vertical trend display7, values are
displayed at all main scale marks. If the number of scale divisions is greater, the values
are displayed at every other main scale marks.

» Scale upper and lower limits are displayed at the ends of the scale.

» Scale values are displayed up to 3 digits excluding the minus sign. However, if the
integer part of values at the ends of the scale is both 1 digit or the integer part is zero, 2
digits are displayed.

Example: If the scale is —0.05 to 0.50, the lower limit is “~0.0” and the upper limit is “0.5.”

+ If the integer part of either end of the scale is 2 or 3 digits, the fractional part is truncated.
Example: If the scale is 0.1 to 100.0, the lower limit is “0” and the upper limit is “100.”

+ If the integer part of either end of the scale is 4 or more digits, the value is displayed
using a 3-digit mantissa and exponent like “x10” or “x10%",

Example: If the scale is 10 to 2000, the lower limit is “1” and the upper limit is “200 x 10”.

» The unit is displayed near the center of the scale. If partial expanded display is used,
the display position is offset from the center. For the vertical trend display, the number of
characters that can be displayed is up to six. For the horizontal trend display, the number of
characters that can be displayed is up to four.

¢ Trend > Scale > Digit
Fine: If the scale value is two-digit display, it can be changed to three digits. For
example, if the scale range is “49.0 to 51.0,” the scale values are displayed
using 3 digits as shown below.

4I9Iil:\l|llulHI|IIII‘IHI|IIHHgl'l?hlH‘IIH|H\HIZ|5I[\I'I|\]|HII‘I\H|IIII‘5II:\I'I‘I1|IHI‘IIII|II\I|IIII|I5:"I'II]|
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5.7 Displaying a Scale on the Trend Display

¢ Trend > Scale > Value indicator
The current value is displayed as a mark or a bar graph.

GROUP 1 = ,
2605/09/16 13:39:12 ISP NI 25nin
Inin/div

Bar graph

B0:4275-h §

aida ooz
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5.8

Displaying Alarm Point Marks and Color Scale

Band on the Scale

Display alarm point marks on the scale. Display the specified range with a color band.
For a description of the function, see section 1.3.

Setup Screen

Press MENU (switch to the setting mode) and select Meas Channel > Alarm
mark, Color scale band

GROUP 1 o] i
St o020 po-22r1y G D1 NN 17ein  (G) )
Heas Channel > Alarm mark. Color scale band
First-CH Last-CH 1
Alarm mark Color scale band
Mark kind Fixed Band area In
Indicate on Scale off Color Line
Alarn mark color Display position
Alarn 1 Red Lower 8.8
Alarn 2 Orange Ubper 18.8
Alarn 3 Orange
Alarn 4 Red

BBEAAS
2085/09/16 13:45:13

1min/div

DIsP B 17nin

y——— Alarm point mark

Color band
51.2

kD
467.4

kPa
1081. 4?
24. Bﬁ
155. 72

57.4
g ]
7.3

80:42 39-F <

(Zbg =t jpzat o4 157

First-CH/Last-CH
Select the target channels. The target channels are common with the other items that
are displayed on the screen.

Alarm Mark Indication

Displays marks indicating the values of the high and low limit alarms, delay high and
low limit alarms, and difference high and low limit alarms. This setting is common with
the bar graph display.

e Alarm mark > Mark kind

Settings Description Mark

Alarm Indicates green under normal conditions and red or
when an alarm is activated.

Fixed Displays a fixed color. 4

¢ Alarm mark > Indicate on Scale
To display alarm point marks, select On.

¢ Alarm mark > Alarm mark color > Alarm 1, Alarm 2, Alarm 3, and Alarm 4
If the Mark kind is set to Fixed, specify the color of the alarm point marks.

IM 04L42B01-01E
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5.8 Displaying Alarm Point Marks and Color Scale Band on the Scale

Color Scale Band

Displays a specified section of the measurement range using a color band on the

scale. This setting is common with the bar graph display.
* Color scale band > Band area

Settings Description

In Displays the area inside using the color band.
Out Displays the area outside using the color band.
Off Disables the function.

e Color scale band > Color
Set the display color.

e Color scale band > Display position > Lower and Upper
Specify the display position. Set a value within the span or scale range.
Lower:  Lower limit of the area.

Upper:  Upper limit of the area.

IM 04L42B01-01E



5.9 Partially Expanding the Waveform

Setup Screen

Partially expand a waveform (reduce the other sections) on the display.
For a description of the function, see section 1.3.

e Turning ON/OFF the Partial Expanded Display Function
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > View, Message, Input,
Alarm

r View — Input
Trend tyre T (Ualue on over-range Over
Partial

Trend rate switching 0ff Alarn
lrlletect

off

r Hessage

Write group Separate
Power-fai | message off
Change message off

On 0tf

* Partially Expanded Display Method
Press MENU (switch to the setting mode) and select Meas Channel > Partial

GROLP 1 r= -
2665/89/30 pe-oo-a1  ud DISP NN 17nin =

Meas Channel > Partial

First-CH Last-CH [
Partial —_—
On/0ff On
Expand 58 %
Boundary 8.

¢ View > Partial
If you select On, the Partial setup item appears in the setting mode.

¢ First-CH/Last-CH
Select the target channels.

* Partial > On/Off
To enable partial expanded display, select On.

¢ Partial > Expand
Set the position where the value specified by Boundary is to be displayed within the
display span in the range of 1 to 99.

IM 04L42B01-01E
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5.9 Partially Expanding the Waveform

e Partial > Boundary
Set the value that is to be the boundary between the reduced section and the
expanded section in the range of “minimum span value + 1 digit to maximum span
value — 1 digit.” For channels that are set to scaling, the selectable range is “minimum
scale value + 1 digit to maximum scale value — 1 digit.”
Example: Input range: —6 V to 6V. Expand: 30. Boundary: 0
The —6 V to 0 V range is displayed in the 0% to 30% range, and the 0 V
to 6 V range is displayed in the 30% to 100% range.
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5.10 Changing the Display Layout, Clearing of the

Waveform at Start, Message Display Direction,
Waveform Line Width, and Grid

Change the display layout, clearing of the waveform at start, waveform line width, and
grid.
For a description of the function, see section 1.3.

Setup Screen

Press MENU (switch to the setting mode) and select Display > Trend, Bar
graph, LCD, Monitor

GROLP 1 r= ,
She/a0ran po-ane e DI DN min  (©) )

Display > Trend. Bar graph. LCD. Honitor

Trend —_— F LCD —_—
Direction Horizontal Brightness 2
Trend clear Off Backlight saver
Hessage direction Horizontal Hode Off
Scale

Digit Normal
Value indicator Hark
Trend line 2 dot | _ Honi tor
Grid futo  div
Backaround
B h Display White
=P £R3 Historical trend Black
Direction Vertical Scroll time 108s
Jump default display off

Horizon |Vertical | Wide Split

* Trend > Direction
Set the display direction of the trends to Horizontal, Vertical, Wide, or Split.

¢ Trend > Trend clear

Settings Description
On Clears the displayed waveform when the memory sampling is started.
Off Does not clear the waveform when the memory sampling is started.

* Trend > Message direction
Set the display direction of messages to Horizontal or Vertical. When the trend is set
to Vertical, the message direction is fixed to Horizontal.

e Trend > Trend line
Set the line width of the trend in dots (1 to 3).

¢ Trend > Grid
Select the number of grids to be displayed in the waveform display area of the trend

display.

Settings Description

41012 Displays a grid that divides the display width into 4 to 12 sections.

Auto Displays the same number of grids as the number of scale divisions of the

first assigned channel of the group.

IM 04L42B01-01E
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5.11 Changing the Bar Graph Display Method

Setup Screen

Change the bar graph display method.
For a description of the function, see section 1.3.

* Display Direction

Press MENU (switch to the setting mode) and select Display > Trend, Bar
graph, LCD, Monitor

GROUP 1 r= : -
28R5/89/30 09:31:35  ed DISP NN 17nin = )

Display > Trend. Bar graph. LCD. Honitor

Trend = LCD —_—
Direction Horizontal Brightness 2
Trend ¢lear 0ff Backlight saver
Hessage direction Horizontal Hode off
Scale

Digit Nornal
Value indicator Hark
Trend line 2 dot | _ Honi tor
Grid Auto  div
Backar-ound
Bar graph Display White
Historical trend Black
(Direction Scroll time 10s
Jump default display off

Base Position and the Number of Scale Divisions
Press MENU (switch to the setting mode) and select Meas Channel > Zone,
Scale, Bar graph

BagA11 o] g
Sotae po:aes el U1 I 1in () N
Meas Channel > Zone. Scale. Bar graph

First-CH [681  Last-CH [}

r Zone —_—

Louer a2

Upper 188 2

r Scale

Position 1

Division 18

r Bar graph

Base position

Division 18

Normal | Center

Bar graph > Direction
Set the display direction of bar graphs to Horizontal or Vertical.

First-CH/Last-CH
Set the target channels. The target channels are common with the other items that are
displayed on the screen.

Bar graph > Base position
Set the base position of bar graphs to Normal, Center, Lower,* or Upper.*
The setting is applied when displaying the bar graph and when displaying the current
value on the scale using the bar graph.
* You can select Lower and Upper on DXs with release number 2 or later.
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5.11 Changing the Bar Graph Display Method

When the Display Direction of the Bar Graph Is Vertical

Normal

Value at the bottom of the bar graph: Span lower limit or span upper limit (or scale

lower limit or scale upper limit), whichever is less

Value at the top of the bar graph: Span lower limit or span upper limit (or scale lower

limit or scale upper limit), whichever is greater
Starting point of the bar: Bottom edge
Center
Value at the bottom of the bar graph: Same as with Normal.
Value at the top of the bar graph: Same as with Normal.
Starting point of the bar: Center
Lower
Value at the bottom of the bar graph: Span lower limit (or scale lower limit)
Value at the top of the bar graph: Span upper limit (or scale upper limit)
Starting point of the bar: Bottom edge
Upper
Value at the bottom of the bar graph: Same as with Lower.
Value at the top of the bar graph: Same as with Lower.
Starting point of the bar: Top edge
Normal Center Lower Upper

i VLT Vupper[] Vupper <

I4'

VS < VS - VIower < Vlower

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)

VL: Vlower or Vupper, whichever is greater
VS: Vlower or Vupper, whichever is less
< Starting point of the bar

/
Example: When the span lower and upper limits of the input
range are 0.0 and —100.0, respectively

Normal Center Lower Upper

0.0 0.0 1ooou 1000H
-100.0 @ -100.0L 0.0 0.0
NS /

IM 04L42B01-01E
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5.11 Changing the Bar Graph Display Method

When the Display Direction of the Bar Graph Is Horizontal
The span lower limit (or scale lower limit) becomes the left edge of the bar graph, and the
span upper limit (or scale upper limit) becomes the right edge of the bar graph.
 Starting point of the bar

Normal: Left edge or right edge, whichever is less

Center: Center

Lower: Left edge

Upper: Right edge

Normal Lower
Viwer  (Vigwer < Vupper) " uPPer Viower Vupper
[ ]
4 A
: (Vlower > Vupper) i
4
Center Upper
Viower Vupper Viower Vupper
[ I ] (—
4 A

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)
Starting point of the bar

/Example: When the span lower and upper limits of the input\
range are 0.0 and —100.0, respectively

0.0 —100.0
Normal

0.0 -100.0
Center [ I 1

0.0 -100.0
Lower IR ]

0.0 —100.0
| — ]
\_ Upper Y,

When Displaying the Current Value on the Scale Using the Bar Graph

Normal Center Lower Upper Viower v <V ) Vupper
: lower upper !
Vupper' """" 1 1~ < 1
Normal : (Vlower>vupper) E
| 4
— ]
I{. Center ? yy :
Lower —I ]
V. B - - 1 N P I : '
lower ™ < < Upper I:_‘

e Bar graph > Division
Select the number of main scale marks from 4 to 12.
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5.12 Using the Circular Display

Use a circular display in place of the trend display.
For a description of the function, see section 1.3.

Setup Screen

¢ Circular Display
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > View, Message, Input,
Alarm

View Input
Trend type | Circular | l Value on over-range Tver
Partial off
Trend rate switching I off Alarm

’-Detect off

e Hessage
Urite aroup Conman
Power-fai | messase ot
Change messase off

¢ Time per Revolution

Press MENU (switch to the setting mode) and select Display > Circular/
Save interval
hiavescn sp:an O 01PN i

'Display > Circular/Save interval

Circular / Save interval

Time per revolution [/rev][IILIN

Save interval 1h

Offset tine oft

th | &h 6h 8h 12h | 16h  |Next 1/2

¢ Operation at One Cycle
Press MENU (switch to the setting mode) and select Display > Circular, Bar
graph, LCD, Monitor
/8 65 oisp N 25in

'Display > Circular. Bar graph. LCD. Honitor

Cireular LED
Full circle action Allclear Brightness 2
Trend line 2 dot Backlight saver
Grid Auto  div Hode [ off
Bar graph
|IJirectiw| [Vertical ‘ ” Hoitor
Backaround
Display White
Historical trend Black
Seroll tine 18s
Jump default display off
Allelear | Divelear
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5.12 Using the Circular Display

Setup Items

View > Trend type
Select Circular.

Circular/Save interval > Time per revolution [/rev]
Select the time of revolution from 20min* to 4week.
* Selectable on DX2004 and DX2008.

Circular/Save interval > Save interval (when recording display data)
Select the size of a record data file. The recorded data is divided by the file size
specified here. The available settings vary in the range of 10min to 31day depending
on the Time per revolution setting.

*

For the setting procedure to record the event data, see section 6.1.

Circular/Save interval > Offset time

The time at the reference position on the circle can be offset in unit of an hour. The
available settings vary depending on the time of revolution setting. The figure below
is an example in which the time per revolution is 6h and indicates the time positions
when the offset time is Off and 1h.

Offset time set to Off Offset time set to 1h
Hour 0, 6, 12, and 18] Hour 5, 11, 17, and 23]
~1h
[Hour 5, 11, 17, and 23] [Hour 1, 7, 13, and 19| [Hour 4, 10, 16, and 22 [Hour 0, 6, 12, and 18]

[Hour 4, 10, 16, and 22| [Hour 2, 8, 14, and 20] [Hour 3, 9, 15, and 21| [Hour 1,7, 13, and 19|
[Hour 3,9, 15, and 21 [Hour 2, 8, 14, and 20
Time per Revolution Selectable Offset Times
20min, 30min, 1h —
2h 1h
6h 1h to 5h
8h 1hto 7h
12h 1hto 11h
16h 1h to 15h
1day, 2day, 1week, 2week, 4week 1h to 23h

Circular > Full circle action

Settings Description

Aliclear Clears the entire waveform when one revolution of waveform is recorded and
continues the recording of the next revolution.

Divclear Clears one division of the old waveform when the remaining amount of

waveform to be recorded falls to one division and continues the recording.

5-24

IM 04L42B01-01E



5.12 Using the Circular Display

Procedure

e Circular Display

1.
2.

Press DISP/ENTER to show the display selection menu.

Select TREND using the arrow keys and press DISP/ENTER.
The display appears.

¢ Changing the Displayed Contents

1.
2.
3.

4.

Press DISP/ENTER to show the display selection menu.
Press the right arrow key to display the sub menu.

Select the sub menu item using the up and down arrow keys.
GROUP 1 = .
2085/18/27 14:50:83 ois> 0 (SR

14:09:00 18/27 2h/rev

14:16:8 18727

Group name: Displays the group.

e —— 1/4 CIRCLE: Displays a quarter of the cycle.

|J2J FULL CIRCLE: Displays the full cycle.
),
o ; SCALE ON: Displays the scale.
o P | SCALE OFF:  Clears the scale.
i) Ve
= // I DIGITAL OFF: Clears the numeric display section.
= . / I DIGITAL ON: Displays the numeric display section.
Cl
M AUTO SCROLL ON: Automatically switches the displayed

groups.
AUTO SCROLL OFF: Does not automatically switch the
displayed groups.

Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press ESC.

* Displaying the Quarter Cycle Display
Select 1/4 CIRCLE as described in the “Changing the Displayed Contents.” The most
recent quarter cycle is displayed expanded.

37

-0.286

14:20:80 18,67

1h/rev 41.8

IM 04L42B01-01E
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5.12 Using the Circular Display

¢ Simplified Historical Trend
Press the up arrow key while showing the quarter cycle to show the historical trend

of the displayed quarter cycle.

GROUP 1
20805/18/87 14

1h/rev

Carry out the procedure below to switch the display in unit of quarter cycle.

Full cycle Quarter cycle . Simplified historical trend
1/4 CIRCLE Up arrow ki ):{ Up arrow key Up arrow key
D > =>
; <
FULL CIRCLE Down arrow i(ey Down arrow key Down arrow key

D D

FULL CIRCLE !

» Historical Trend
There are five methods to display the past measured data.
For a description of the function, see section 1.3.
For the procedure to recall from the display selection menu, see below.
For the procedure to display from the alarm summary, see section 4.6.
For the procedure to display from the message summary, see section 4.7.
For the procedure to display from the memory summary, see section 4.8.
To show the measured data stored on an external storage medium, see section 6.8.

¢ Showing the Display
Carry out the procedure below while memory sampling is in progress.

1. Press DISP/ENTER to show the display selection menu.

2. Select TREND HISTORY using the arrow keys and press DISP/ENTER.
One screen of data is displayed.

GROUP 1 — S
2085/18/87 14:33:02 oisP NN 2v:isnin (5

51— Cursor (yellow line)

5-26 IM 04L42B01-01E



5.12 Using the Circular Display

¢ Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.

3. Select the sub menu item using the up and down arrow keys.

GROUP 1 &
2005/10/07 14:

Group name: Displays the group.

—— SCALE ON: Displays the scale.
SCALE OFF: Clears the scale.

P

EMIT  » [TREND -
» Switches to the specified display.

Return to the display that was shown before the
historical trend.

= THEGR I Displays the alarm summary in the loaded data file.
LU — Displays the message summary in the loaded data file.

; L Displays the information of the loaded data file.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press ESC.
* Moving the Cursor
Move the cursor in the

\“/ past direction Hold down an arrow key to move the
‘@’ Move the cursor in the | €ursor by a division.

/"\ current direction

» Displaying the Continuing Data (Loading Data to the Display Memory)
Approximately one screen of data is shown on the historical trend display. The
continuing data can be shown as follows:

Displayed

\\/—’_x

Move the cursor to the end of the waveform and press
the arrow key yet again to display the continuing data.

Move the cursor to the end of the waveform and press
the arrow key yet again to display the continuing data.
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5.12 Using the Circular Display

¢ Specifying the Display Range
Select the display range.
1. Press the up arrow key.
The waveform of the entire data range is displayed at the top section of the screen. The
white frame indicates the data range that is currently displayed. The yellow horizontal line is
the cursor.

GROUP 1 = ,
2005/18/87 14:28:56 DIsP I 16nin

~— All data display
+—— Displayed data range
(White frame)

“#4— Cursor (yellow line)

2. Press the left and right arrow keys to move the cursor.

Y Cursor

a b

Displaygd :
N

H_/H_/

A B
A is selected when the cursor position is at a.
B is selected when the cursor position is at b.

3. Press the down arrow key.
The specified range is displayed.

* Selecting Another File
To display data from another file, select the file from the memory summary.

* Message
On the historical trend, up to eight newest messages that exist before the cursor

position can be displayed.
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5.12 Using the Circular Display

Explanation

¢ Scale Marks
The number of scale marks varies depending on the time corresponding to one cycle.
Scale marks consist of main scale marks and subscale marks. Main scale marks are
used to divide the cycle into sections; subscale marks are used to divide between the
main scale marks. The number of divisions created by main scale marks and subscale
marks are as follows:

Time/rev  Number of Divisions Number of Divisions Time per Display
Created by Main Scale Created by Subscale Scale Mark  Update Rate
Marks Marks

20min 5 4 1 min 0.5s

30min 5 4 1min30s 1s

1h 12 2 2min 30 s 2s

2h 12 2 5 min 4s

6h 12 2 15 min 10s

8h 8 2 30 min 20 s

12h 12 2 30 min 20s

16h 8 2 1h 40's

1day 12 2 1h 1 min

2day 12 2 2h 2 min

Tweek 7 4 6 h 4 min

2week 7 4 12 h 8 min

4week 4 7 24 h 20 min

* Event Data
When displaying event data using the historical trend, the time corresponding to one

cycle is automatically determined from the sampling interval (Sample rate) of the
event data to be displayed as follows:

Sample rate Time/rev Number of Divisions Created Number of Divisions Created
by Main Scale Marks by Subscale Marks
25 ms 1min/rev 6 4
125 ms 5 min/rev 5 4
250 ms 10 min/rev 5 4
500 ms 20 min/rev 5 4
1s 30 min/rev 5 4
2s 1 h/rev 12 2
5s 2 hirev 12 2
10s 6 h/rev 12 2
30s 12 hirev 12 2
60 s 1 day/rev 12 2
120 s 2 day/rev 12 2
300 s 1 week/rev 7 4
600s 2 week/rev 7 4
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5.13 Changing the Background Color of the Display

Change the background color of the display. This setting is applied to the operation
screens.

Setup Screen

Press MENU (switch to the setting mode) and select Display > Trend, Bar
graph, LCD, Monitor

GROUP 1 = ,
SN aosan pocas:os e DI I cein ()

Display > Trend. Bar graph. LCD. Honitor

Trend —_—y LCD —
Direction Horizontal Brightness 2
Trend clear 0ff Backlight saver
Hessage direction Horizontal Hode 0ff
Scale

Digit Nornal

Value indicator Hark

Trend line 2 dot | _ Honi tor

Grid Auto  div
Backsr-ound e |
Disnlay White

[ e Historical trend Black

Direction Vertical Scroll time 18s

Jump default display off

White Black

¢ Monitor > Background > Display
Set the background color of the operation screen to White (default setting) or Black.

* Monitor > Background > Historical trend
Select the background color of the historical trend display from the following:
Settings: White, Black (default setting), Cream, and Lightgray
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5.14 Automatically Switching Display Groups

Setup Screen

Setup Items

Automatically switch the displayed group at a specified interval.

Press MENU (switch to the setting mode) and select Display > Trend, Bar
graph, LCD, Monitor

GROUP 1 = ,
2805/09/20 p:35:37 e 0157 NN 26win

Display > Trend, Bar graph, LCD, Honitor

Trend

Direction Horizontal
Trend clear off
Hessage direction Horizontal
Scale

Digit Normal
Value indicator Hark
Trend line 2 dot
Grid Auto  div

Bar graph
(Direction Vertical

58 18s 28s 38s

Monitor > Scroll time

Set the switching interval from the available settings between 5 s and 1 min. The

r LCD E—
Brightness 2
Backlight saver

Hode off

r Honitor

Backaround

Display White
Historical trend Black
Scroll time 18s

Junp default diswlay Off

Inin

groups switch in ascending order.

Select whether to automatically switch on the operation display.

See section 4.2

IM 04L42B01-01E
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5.15 Automatically Reverting to the Specified
Display

Show a preset display when there is no operation for a specific time.
Setup Screen

Press MENU (switch to the setting mode) and select Display > Trend, Bar
graph, LCD, Monitor

GROUP 1 = _
oo 80 po:s5:a0 g U1 I zenin ()

Display > Trend. Bar graph. LCD. Honitor

Trend —_—y LCD —
Direction Horizontal Brightness 2
Trend clear 0ff Backlight saver
Hessage direction Horizontal Hode off
Scale

Digit Nornal
Value indicator Hark
Trend line 2 dot | _ Honi tor
Grid Auto  div
Backsround
Display White
Bar sraph Historical trend Black
Direction Vertical Scroll time 108s
Junp default display

0ff 1nin 2nin Snin 18min 2@min  [Next 172

Setup Items

¢ Monitor > Jump default display
Returns to a preset display if there is no key operation for a specific time.

Settings Description
1min to 1h Time until switching the display.
Off Disables the function.

Procedure

» Specifying the Display to be Shown
1. Show the operation display you want to designate.

2. Inthe operation mode, press FUNC.
The FUNC key menu appears.

3. Press the Standard display soft key.
The display is registered.
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5.16 Registering the Favorite Display

Procedure

Register a frequently used display to the Favorite key and enable the display to be
shown through simple operation.

(-ﬂ
@)

& &
D @ @D

Favorite key

* Registering the Display
Up to 8 displays can be registered.

1. In the operation mode, show the display you want to register.

2. Press FUNC.
The FUNC key menu appears.

3. Press the Favorite regist soft key. Then, press a registration number soft key.

4. Press the Regist soft key.

A window appears for you to enter the display name.

To delete a registration, press the Delete soft key.

5. Enter the display name (using up to 16 characters, [Ala[#]1]).

6. Press DISP/ENTER.
The display is registered.

¢ Switching the Display

The display switches in the registration order each time you press the Favorite key.

IM 04L42B01-01E
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5.17 Writing a Message When the DX Recovers
from a Power Failure

A message is written to the trend display when the DX recovers from a power failure
while memory sampling is in progress.

Setup Screen

* Power-fail message
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > View, Message, Input,

Alarm

Basic Setting Hode

r View —_— Input
Trend type ¥ (Ualue on over-range Over

Partial 0ff
Trend rate switching off Alarn
’]Jetect

off

r Hessage

Write group Comnon
Power-fail message

Change messase off

On 0ff

¢ Message > Power-fail message
Settings Description
On A message is written when the DX recovers from a power failure while memory
sampling is in progress.
Display example: 15:12 Power Off 2005/10/25 15:12:57
Off Disables the function.
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5.18 Changing the FUNC Key Menu and Display
Selection Menu

Setup Screen

Change the FUNC key menu that appears when the FUNC key is pressed and the
display selection menu that appears when the DISP/ENTER key is pressed.

* FUNC Key Menu

Press MENU (switch to the setting mode) and select Menu customize >
Function menu

-
s 155 R Ol N tor ()

Henu customize > Function menu

Number indicating
the display order

Free Hedia Snap Hanual

4 Trigger
nessage | eiect shot sanple b

AlarACK | Hessage

Save Save Save Hath Hath Hath Timer
display | event stop start reset ACK reset

Hessage
Password | Second Batch Text [Favorite

Hegloek| | ALopyt change speed field regist

Standard | System | Network Menu name

display info info White: Used
Gray: Not used

Display Menu
Press MENU (switch to the setting mode) and select Menu customize >
Display menu

GROUP 1 =
a8 16/28 19-15:50 e 01PN thor  (T)

Henu customize > Display menu

Separator

GROUP 34

Separate | Select Hide

£ EXPAND

Enabling/Disabling the FUNC Key Menu
Iltems whose menu name is white are shown.

1. Press the arrow keys to select a menu item.
2. Press the View or Hide soft key.

If you press the Hide soft key, the menu name is displayed in gray, and does not appear in

the FUNC key menu.
Changing the Display Order of the FUNC Key Menu

Menu items are displayed in order by number. In addition, menu items appear when

the corresponding function can be used.
1. Press the arrow keys to select a menu item.
2. Press the Select soft key.
The menu item is enclosed in a red frame.
3. Press the arrow keys to select the destination.

4. Press the Transfer soft key.
The menu item moves to the selected number position.

IM 04L42B01-01E
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5.18 Changing the FUNC Key Menu and Display Selection Menu

¢ Description of the FUNC Key Menus
For a description of each item, see the respective section.

Free Hedia Snap Hanual )
AlarhACK | Hessage nessage | eject shot sabdle Trigger
Sec.3.8 Sec.5.4 Sec.54 Sec.6.4 Sec.6.6 Sec.6.5 Sec.6.4
Sec. 2.12
Save Save Save Hath Hath Hath Timer
display | event stop start reset ACK reset

Sec.6.4 Sec.6.4 Sec.48 Sec.94 Sec.94 Sec.94 Sec.7.1

Password | Second Batch Text Favorite

Keglopk | Lopgut change speed field regist

Sec.8.1 Sec.8.3 Sec.8.3 Sec.53 Sec.6.3 Sec.6.3 Sec.5.16

dPanel Standard

display
Sec. 4.10 Sec. 5.15 Sec.2.5 Sec.2.5 Comm.* Comm.* Comm.*

FTP test * Communication Interface User’s Manual

Comm.*
* Enabling/Disabling the Display Menu and Sub Menu
ltems whose menu name is white are shown.
1. Press the arrow keys to select a menu item.
2. Press the View or Hide soft key.
If you press the Hide soft key, the menu name is displayed in gray, and does not appear in
the display selection menu.
¢ Changing the Display Menu/Sub Menu Positions
1. Press the arrow keys to select a menu item.

2. Press the Select soft key.
The menu item is enclosed in a red frame.

3. Press the arrow keys to select the destination.
4. Press the Transfer soft key.
The menu item moves to the selected position.
* Showing/Hiding Separators
1. Press the arrow keys to select a menu item.

2. Press the Separate soft key.
A separator (line) is displayed between the current item and the lower item.
If you select a menu item whose separator is already shown, this operation hides the
separator.
You can set up to three separators in the display selection menu and each sub menu.
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5.18 Changing the FUNC Key Menu and Display Selection Menu

¢ Description of the Display Selection Menus and Sub Menus
ltems with asterisk (*) are set to Hide by default.

Display Selection Menu Sub Menu Reference Section
TREND GROUP 1 to GROUP 36 Sections 4.2 and 5.12
1/4 CIRCLE Section 5.12

ALL CHANNEL/GROUP CHANNEL Sections 4.2 and 5.12
SCALE ON/OFF Sections 4.2 and 5.12

DIGITAL OFF/ON Sections 4.2 and 5.12
MESSAGE DISP2/1 Section 4.2
* TREND SPACE ON/OFF See sections 4.2 and 5.12.
AUTO SCROLL ON/OFF See sections 4.2 and 5.12.
EXPAND Section 4.10
TREND HISTORY GROUP 1 to GROUP 36 Section 4.3
DIGITAL GROUP 1 to GROUP 36 Section 4.2
AUTO SCROLL ON/OFF Section 4.2
EXPAND Section 4.10
BAR GROUP 1 to GROUP 36 Section 4.2
AUTO SCROLL ON/OFF Section 4.2
EXPAND Section 4.10
OVERVIEW CURSOR OFF/ON Section 4.4
JUMP TO ALM SUM Section 4.4
JUMP TO TREND Section 4.4
* JUMP TO DIGITAL Section 4.4
* JUMP TO BAR Section 4.4
EXPAND Section 4.10
INFORMATION ALARM SUMMARY Section 4.5
MESSAGE SUMMARY Section 4.5
MEMORY SUMMARY Section 4.5
* MODBUS CLIENT Section 4.5
* MODBUS MASTER Section 4.5
* RELAY Section 4.5
REPORT DATA Section 4.5
TO HISTORY Sections 4.6, 4.7, and 4.8

TO HISTORY(DISP)

Sections 4.6, 4.7, and 4.8

TO HISTORY(EV)

Sections 4.6, 4.7, and 4.8

TO OVERVIEW

Section 4.6

CHANGE SORT KEY

Sections 4.6 and 4.7

ASCENDING ORDER/
DESCENDING ORDER

Sections 4.6 and 4.7

SELECT SAVE' Section 4.8
M.SAMPLE SAVE Section 4.8
REPORT SAVE Section 4.8
ALL SAVE' Section 4.8
CHANGE DISP ITEM Section 4.7
CHANGE DATA KIND Section 4.8

FILENAME DISPLAY/TIME DISPLAY Section 4.8

CHANGE REPORT CH

Section 4.5

EXPAND

Section 4.10

1: The default setting is Hide on DXs before release number 2.

IM 04L42B01-01E
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5.18 Changing the FUNC Key Menu and Display Selection Menu

Display Selection Menu Sub Menu Reference Section
* Log LOGIN Section 4.9
ERROR Section 4.9
COMMUNICATION Section 4.9
FTP Section 4.9
MAIL Section 4.9
WEB Section 4.9
SNTP Section 4.9
DHCP Section 4.9
MODBUS Section 4.9
4 PANEL MIX Section 4.10
ALL TREND Section 4.10
ALL DIGITAL Section 4.10
ALL BAR Section 4.10
* EXPAND Section 4.10
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Chapter 6 Saving and Loading Data

6.1 Setting the Recording Conditions of the
Measured Data

Set the method for recording the measured data.
For a description of the function, see section 1.4.

Setup Screen

¢ Data Type
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select A/D, Memory

Basic Setting Hode Lk

Sean interval
Scan mode Normal
Sean interval 1s
A/D integrate futo

[ ]

Display | E+D Event

e Measurement Channels
Press MENU (switch to the setting mode) and select Meas Channel > Tag,
Memory sample, Alarm delay

GROUP 1 = ,
3 11:0:55 e USP INNEE Snin
. Nemory sanple. Alarn dalay

Alarn delay
[Tin [10s

¢ File Save Interval (Display Data)
Press MENU (switch to the setting mode) and select Display > Trend/Save

interval or Circular/Save interval
T-Y Display Circular Display

GROUP 1 = .
2p05/85/38 11:10:12 e 01" I Snin

| Display > Trend/Sava interval

Trend / Save interval Circular / Save interval
Trend interval [/div] [ 1min Time per revolution [Iruu]m
Save interval Save interval 1h
Second interval [/div] 1min Dffset tine off
18in | 2Bnin | 38win | Ih 2 | 3 [Mext 13 L dnin | th |2 | 6 [ 8
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6.1 Setting the Recording Conditions of the Measured Data

¢ Recording Conditions of Event Data

Press MENU (switch to the setting mode) and select Data save > Event data
HEMORY SUMHARY & DISP I 2fnin @ o)

2885/18/28 19:89:54 v EVENT I
Data save > Event data

Event data

Sample rate
Hode SingleTrigger
Data length 2day
Pre-trigger [1] 3
Trigger signal
Key On
1s 25 s 18s 38s 68s  |Next 1/2

* Memory > Data kind

Settings Description

Display Records display data.

E+D Records display data and event data.
Event Records event data.

* Memory sample > On/Off
Turn On the target channels.

¢ Trend/Save interval > Save interval (when recording display data)
Select the size of a record data file. The recorded data is divided by the file size
specified here. The available settings vary depending on the Trend interval setting.

Trend interval 15 s* 30s 1 min 2 min 5 min
Selectable range of |10 min to 10 min to 10 min to 10 min to 10 min to
auto save interval 3 days 7 days 14 days 14 days 31 days
Trend interval 10 min 15 min 20 min 30 min 1h
Selectable range of |10 min to 10 min to 1 hour to 1 hour to 1 hour to
auto save interval 31 days 31 days 31 days 31 days 31 days
Trend interval 2h 4 h 10 h

Selectable range of |2 hoursto |4 hoursto |8 hours to

auto save interval 31 days 31 days 31 days

* Selectable on the DX2004 and DX2008

¢ Trend/Save interval > Second interval [/div]
See section 5.3.

e Circular/Save interval
See section 5.12.

* Event data (when recording event data)

¢ Sample rate
Select the data recording interval from the available settings.

* Mode

Settings Description

Free Records data continuously.

Single Records data when the trigger condition is met.
Repeat Records data each time the trigger condition is met.
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6.1 Setting the Recording Conditions of the Measured Data

e Data length
Select the size of a record data file. The recorded data is divided by the file size
specified here. The available data lengths vary depending on the Sample rate

setting.
Sample rate 25 ms* 25 ms 250 ms 500 ms 1s
Selectable range |10 min to 10 min to 10 min to 10 min to 10 min to
of data length 4 hours 1 day 2 days 3 days 7 days
Sample rate 2s 5s 10s 30s 1 min
Selectable range (10 min to 10 min to 10 min to 1 hour to 1 hour to
of data length 14 days 31 days 31 days 31 days 31 days
Sample rate 2 min 5 min 10 min
Selectable range |1 hour to 1 hour to 1 hour to
of data length 31 days 31 days 31 days

* Selectable on the DX2004 and DX2008

* Pre-trigger
Specify the range when recording data before the trigger condition is met. Select
the range as a percentage of the data length from 0, 5, 25, 50, 75, 95, and 100%.
If you do not want to record the data existing before the trigger condition is met,
select 0%.
* Trigger signal > Key
Select On if you want to activate the trigger using key operation.

Nofte

» Triggers can be applied using event action (see section 7.1).
» If the trigger condition is already met when you press START, recording starts.
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6.2 Setting the Method for Saving the Data

Set the method for recording the measured data to the storage medium.
For a description of the function, see section 1.4.

Setup Screen

* Auto save
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Environment > Security, Media save, Batch

Basic Setting Hode

Environment > Security. Media save, Batch

r Security —
Key 0ff
Connunication off

r Save
Auto save
Hedia FIFQ off

r Batch
On/0ff 0ff

On 0ff

¢ File header, Data file name
Press MENU (switch to the setting mode) and select Data save > File
header, Data file name
SO h/oe 111405 e EVENT I @ )

Data save > File header, Data file name

File header
(Characters e — ‘

Structure Date
—

Data file name
(ldentified strings

Input Clear Copy
* Save directory
Press MENU (switch to the setting mode) and select Data save > Save directory
St a/28 18:17:31 o [ a0 () o)

Data save > Save directory

( Save directory

Directory name DATAB

Input Clear Copy
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6.2 Setting the Method for Saving the Data

Setup Items

Save > Auto save

Settings Description

On Automatically saves the measured data to the CF card. Specify On to
enable the media FIFO function.

Off Does not automatically save the data. Save the measured data manually

to the CF card or USB flash memory (/USB1 option).

Save > Media FIFO (Release Number 2 or Later)
This item appears if Auto save is set to On.

Settings Description

On Enable media FIFO. Constantly retains the most recent data files in the
CF card.

Off Disable media FIFO. Replace the CF card if the free space on the CF

card drops low.

File header > Characters

Set the header comment to be written to the data file. (Up to 50 characters, [Ala]#[1])
Data file name > Structure

Sets the structure of the file name when saving data.

Settings Description

Date Serial number + user-assigned character string + date
Serial Serial number + user-assigned character string

Batch Serial number + batch name (when using the batch function)

Data file name > Identified strings

Set the user-assigned section of the file name. (Up to 16 characters, [Alal#[1])
Symbols that can be used: #, %, (, ), +, -, ., @, °, and
For details on the data file name, see section 1.4.

Save directory > Directory name

Set the name of the directory on the storage medium for saving the data on the
external storage medium. (Up to 20 characters, [Ala[#[1])

Symbols that can be used: #, %, (, ), +, -, ., @, °, and _

Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and
LPT1 to LPTO.

IM 04L42B01-01E
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6.3 Using the Batch Function

Set the batch function.
For a description of the function, see section 1.5.

Setup Screen

* Batch Function
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Environment > Security, Media save, Batch

Basic Setting Hode

Environment > Security. Media save, Batch

r Security —
Key 0ff
Connunication off

r Save —
Auto save On
Hedia FIFQ off

r Batch
On/ff | On |
Lot-No. disit [
fAuto increnent On

On 0ff

¢ Data file name
Press MENU (switch to the setting mode) and select Data save > File
header, Data file name
St 11:10:0 R EVENT I ® N

Data save > File header, Data file name

( File header ‘

Characters

Data file name
’75tr-uctur‘e | Batch |

Date Serial Batch

e Text Field
Press MENU (switch to the setting mode) and select Data save > Batch text

GROUP 1 r=
20e5/89/38 11:18:30  er EVENT I @ )
Data save > Batch text

Text field number 1

Text field
Title of field [
Characters

Input Clear Copy
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6.3 Using the Batch Function

Setup Items

¢ Batch > On/Off
Select On to use the batch function.

e Batch > Lot-No. digit
Select the number of digits of the lot number from 4, 6, or 8. Select Off to disable the
lot number.

e Batch > Auto increment

Settings Description

On Automatically sets the lot number of the next measurement to “the lot number of
the current measurement + 1.”

Off Disables the operation described above.

* Data file name > Structure
Batch: Sets the name of the display data files or event data files to “batch name +
serial number.”
For details on the data file name, see section 1.4.

¢ Text field number
Select a number from 1 to 8.

¢ Text field > Title of field, Text field > Characters
Set the string.
Title of field: (Up to 20 characters, [Alal#[1]), Characters: (Up to 30 characters, [Ala[#[1])

Procedure

* Setting the Batch name and Comment

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Batch soft key.
A window appears for you to enter the batch name and comment.

3. Set the batch number. (Up to 32 characters, [Ala[#1])
Symbols that can be used: #, %, (, ), +,-, ., @, °, and _.

If you are using the lot number, set the lot number.
4. Setbatch comments 1, 2, and 3. (Up to 50 characters each, [Ala[#]1))
5. Press DISP/ENTER.
Nofte

Batch numbers and lot numbers cannot be changed after memory start.

* You can change the comment as many times as you wish before executing memory start.
After memory start, only the comments that are not specified can be entered. You can
change the comment as many times as you wish while the window for setting the comment
is displayed. The last specified comment is valid.

* The comment is cleared when memory stop is executed.

* The batch number, lot number, and comments are saved to the display data file or event
data file. They are not saved to the setup file.

¢ Displaying the Text Field Settings

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Text field soft key.
The text field settings are displayed.
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6.4 Starting/Stopping the Recording and Saving
the Measured data

Procedure

Start the recording and save the measured data to the external storage medium.
For a description of the function, see section 1.4.

e Starting the Recording (Memory Start)

Press START. The internal memory icon in the status display section changes from

the stop icon to memory sampling icon.

»  When recording display data or event data in free mode, recording starts.

*  When recording event data in trigger mode, the DX enters the trigger-wait
condition.

Applying a Trigger to Start the Recording
Carry out the procedure below when the DX is waiting for a trigger.

Trigger through Key Operation
The procedure below can be carried out when recording event data in trigger mode
and the DX is configured so that the start trigger is applied through key operation.

1. Press FUNC.
The FUNC key menu appears.

2. Press the Trigger soft key.
The recording starts.

Trigger by an Event (Event action function must be configured. See

section 7.1.)
Recording starts when an event occurs.

Automatically Saving Measured Data

The save destination is the CF card.

Have the CF card inserted in the slot at all times. While the memory sampling is in
progress, the measured data recorded in the internal memory is automatically saved
to the CF card.

Action when Media FIFO is not enabled: If data storage to the storage medium is not
complete such as due to insufficient free space, the unsaved data is saved the next
time the data is automatically saved.

Saving the Display Data or Event Data during Memory Sampling through

Key Operation

The save destination is the CF card.

This operation can be carried out when recording display data or when recording

event data in Free mode. Unsaved measured data is saved to the CF card.

* If this operation is carried out when auto save is Off, the data in the internal memory is
divided, and a file is created.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Save display or Save event soft key.
The display data or event data is saved to the CF card.
Save operation

/ /\t/\ﬁ Jime

I I I I v

File File File
Saved the previous time [ Saved this time ]
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6.4 Starting the Recording and Saving the Measured data

¢ Saving Measured Data Manually (Collectively Stroring Unsaved Data)

The
For

1.

No

save destination is the CF card or USB flash memory (/USB1 option).
the procedure to save data to the USB flash memory, see section 2.12.

Insert the storage medium.
A confirmation window containing the message “There is data which is not saved to media.
Do you want to store to media?” appears.

Select Yes and press DISP/ENTER.
Unsaved data in the internal memory is saved to the storage medium.

Carry out the procedure below to remove the storage medium.
Press FUNC (display the FUNC key menu) > Media eject soft key > CF soft

key
When the message “Media can be removed safely” appears, remove the storage medium.

le

If there is not enough free space on the storage medium, the message “Not enough free
space on media” appears, and the data is not saved. If this message appears, replace the
storage medium. Then, carry out the procedure again.

You cannot abort the data save operation while it is in progress.

» Stopping the Recording (Memory Stop)

1.

2.

Press STOP. A confirmation window is displayed.
GROUP 1 & )
2895/18/28 19:61:07 isp I 1dnin

Imin/div

Select Yes using the arrow keys and press DISP/ENTER.

On models with the computation function (/M1 or /PM1 option), select Mem+Math
or Memory, and press DISP/ENTER.
The internal memory icon in the status display section changes to the stop icon.

* Saving the Data in the Internal Memory Collectively or Selectively
through Key Operation

See

section 4.8.
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6.4 Starting the Recording and Saving the Measured data

Explanation

e Operations That Start Simultaneously with Memory Start
» Waveform display updating on the trend display.
* Report (/M1 and /PM1 options)
» The computation function (/M1 and /PM1 options) can be configured to start
simultaneously with memory start.
See section 9.4.

* Operations That Stop Simultaneously with Memory Stop
» Waveform display updating on the trend display.
* Report (/M1 and /PM1 options)
» Computation function (/M1 and /PM1 options): When selected in the procedure
described above.

¢ Performance While Data Is Being Saved

If the internal memory or external storage medium is continuously accessed, the

following phenomena may occur. When such phenomena occur, the storage medium

access indicator frequently illuminates.

» Files being saved to the external storage medium drop out.

» Accessing the DX through communications takes a long time

In such case, take the following measures.

+ If you are creating data files at short intervals consecutively using the event action
function, increase the data file save interval.

« If you are creating numerous files in a single directory on the external storage
medium, change the destination directory name at approximately every 1000 files.

6-10 IM 04L42B01-01E



6.5 Manually Saving the Measured Data (Manual
Sample)

Setup Screen

Procedure

Explanation

Save the instantaneous values of all channels (excluding those set to Skip or Off)
through key operation. On models with the external input channels (/MC1 option), the
instantaneous values of specified channels (among 120 channels) are saved.

For a description of the function, see section 1.4.

¢ Channel to be Manual Sampled

This setting applies to models with the external input channels (/MC1 option).
Press MENU (switch to the setting mode) and select Data save > Manual
sample

Sty 12217 G D1 N 20nin  (T)

Data save > Hanual sample

Hanual sanple number
( HanualSanple

On/0ff On
Channel i1

Manual sample number
Select a number from 001 to 120. The instantaneous values are output in this order.

ManualSample

e On/Off
Select On when assigning a channel to the manual sample number.

e Channel
Enter a channel number of a measurement channel, computation channel (/M1 and
/PM1 options), or external input channel (/MC1 option).

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Manual sample soft key.
Manual sampling is executed.

Number of Manual Sampled Data Set in the Internal Memory
The number of manual sampled data set in the internal memory is displayed on the
memory summary display (see section 1.9)

Saving Measured Data to the CF Card

» If auto save is On, the manual sampled data is saved to the CF card when you
carry out manual sampling.

» If auto save is Off, save the manual sampled data to the CF card according to the
procedure for manually saving the data (see section 6.4).

» The manual sampled data can be saved manually to a CF card or USB flash
memory (/USB1 option) regardless of whether the auto save function is set to On/
Off. For the manual save operation, see section 4.8.

IM 04L42B01-01E
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6.6 Saving the Screen Image Data (Snapshot)

Save the current screen image data to the CF card. This operation is called snapshot,
and the screen image data file is called snapshot data file.
For a description of the function, see section 1.4.

Procedure

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Snap shot soft key.
The snapshot data file is saved to the CF card.
Image of the soft keys and the message window are not saved.

Note

If you assign the snapshot function to the USER key, you can carry out snapshots in all modes
(operation mode, setting mode, and basic setting mode). However, error messages are not

saved.

Explanation

¢ File Format and Size
The snapshot data file is in PNG format.
The maximum size of a snapshot data file is approximately 15 KB.

¢ File Name
See section 1.4.
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6.7 Managing the Files on the Storage Medium

This section explains how to display a list of files on the storage medium, check the free
space, delete files and directories, and format the storage medium.

Procedure

* Displaying a List of Files on the Storage Medium, Deleting Files, and
Checking the Free Space
Carry out the procedure below to show the display.
Press MENU (switch to the setting mode); select Save/Load > File list,

delete; press the CF or USB soft key*; and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

HEHORY SUHHARY r=
288770475 18:03:58 oo 0ISP NN 1hour

Save/Load > File list/delete

Directory name Date / Time

2007/84/85 17:54

DATAG
DATAR_A7A222.1 32829

DATAA_A78222_182687 208
Free space 442544 Kbytes
Delete Sort

Displaying a List of Files in a Directory and Checking the Free Space
Press the arrow keys to select a directory, and press DISP/ENTER. The files in the
directory are displayed. The root directory is denoted by [/].

ity Toas:a g D1 N tror (@)

Save/Load > File list/delete

ejeq Buipeo] pue Buireg

CF-/DATALS
File name ~ Date / Time

BAAA3S_SAMPLEASAL12_218857H_.. DAR

BBA197_SAMPLERSA112_21A852. DAD

BAA198_SAHPLEASAL

211944.
_212944.

2805/81/
2805/81/
2805/81/
2885/81/
2B05/81/
2805/81/
2805781/
2005/81/
K 14 2805/81/
BAA211_SAHPLEASAL . 2005/81/
Free space 442512 Kbytes

Sorting Files and Directories (Release Number 2 or Later)

The files and directories can be sorted by the update date/time.

Each time you press the Sort soft key, the files and directories are sorted in order from
the oldest or the latest update date/time. A mark indicating the sort order is displayed
by Date/Time.
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6.7 Managing the Files on the Storage Medium

Explanation

Deleting a File

Press the arrow keys to select the file to be deleted, and press the Delete soft key.
A confirmation window appears. Select Yes, and press DISP/ENTER.

The file is deleted.

Deleting a Directory

First, delete all the files in the directory.

Select the directory you want to delete. The rest of the procedure is the same as
deleting a file.

Checking the Free Space

The free space on the storage medium is shown at the lower right of the screen.

¢ Formatting the Storage Medium

1. Carry out the procedure below to show the display.

Press MENU (switch to the setting mode); select Save/Load >Format; press the
CF or USB soft key*; and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

25/A9/3A 11:21:17

Save/Load > Format

Format
(Uolume nane _

Input Clear Copy
Enter the volume name and press DISP/ENTER. (Up to 11 characters, [A[1])
A confirmation window opens.

Select Yes and press DISP/ENTER.
The storage media is formatted.

¢ Format Type

Size Type
Storage medium smaller than or equal to 512 MB FAT16
Storage medium greater than 512 MB FAT32
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6.8 Loading and Displaying the Measured Data in
the Storage Medium

Procedure

Load the display or event data file saved on the external storage medium and display the
waveform. The loaded data is shown on the historical trend display.
For the operations on the historical trend display, see section 4.3.

* Loading a File

1. Carry out the procedure below to show the display.

Press MENU (switch to the setting mode); select Save/Load >Load display or
Load event data; press the CF or USB soft key*; and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

HEHORS SUHRRY =
Dau o0 G VI N tor (&)

Save/Load > Load display data

ICF=/
D 0 D
DATAB 2007/04/85 17:54
DATAL 2007/04/85 18:02
DATA2 2B07/83/15 15:68)
DATA3 2B07/83/28 28:11
DATA4 2B07/84/83 18:39)
DATAS 2B7/04/84 18:35
DATAG 2BA7/04/84 15:51
DATABE 2007/04/85 18:04)
DATAB_A7A222_1326829 2PR7/82/22 13:28
DATAB_B7B222.182687 2807/82/23 B8:53
Free space 442496 Kbytes
Sort

2. Press the arrow keys to select a directory, and press DISP/ENTER. The files in
the directory are displayed. The root directory is denoted by [/].

3. Press the arrow keys to select a file, and press DISP/ENTER.
The file is loaded, and the waveform is displayed in the historical trend.
HEMORY SUHHARY =
268 7w

7/84/85 18
d display data

CF:/DATAL/
File name Date 7 Tine
BEA197_SANPLEASA112_216852. DAD

B@A199_SANPLEASAL
B8A288_SAHPLEASAL 5/81/:
AAA2A1_SAHPLEASAL 5/81/
5/81/
5/81/
5/81/
5/81/
2605/81/
2005/81/
2B65/81/
. 2BB5/81/
B@88218_SANPLEASAL 2BB5/81/
B8A211_SAHPLEASAL 2BB5/81/
AAA212_SAHPLEASAT12_232944. 2005/81/
Free space 442488 Kbytes

Nofte

« The display data extension is .dad; the event data extension is .dae.
» For details on how to use the Sort key, see section 6.7.
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6.9 Saving/Loading the Setup Data

Save the setup data to the external storage medium or load the setup data from the
external storage medium.

Procedure

¢ Saving the Setup Data
1. Carry out the procedure below to show the display.

Press MENU (switch to the setting mode); select Save/Load > Save settings;
press the CF or USB soft key*; and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

GROUP 1 r= -
o005/9/38 11:24-14  hed DIsP I 20nin =

Save/Load > Save settings

Save settings
(File nane oFr I

Space Del Bs Ins A7l

2. Set the file name. (Up to 32 characters, [Ala[#[1])
Symbols that can be used: #, %, (, ), +,-, ., @, °, and _.
Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to LPTO9.
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is saved.

* Loading the Setup Data for the Setting Mode
1. Carry out the procedure below to show the display.
Press MENU (switch to the setting mode); select Save/Load >Load settings;
press the CF or USB soft key; and press DISP/ENTER
Saiits Toaes R VIS N tror (&)
Save/Load > Load settings

[CF=/
File name Date / Time
28087/83/13 B9:06
. 2887/83/13 09:A7
AAAAAAR. PDL 2887/03/23 09:53
Free space 442464 Kbytes

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.
* Setup data files are stored in the root directory [/].
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is loaded.

Note

For details on how to use the Sort key, see section 6.7.
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6.9 Saving/Loading the Setup Data

¢ Loading the Setup Data for the Setting Mode and Basic Setting Mode
1. Carry out the procedure below to show the display.

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode); select Load settings, Initialize > Load settings; press the
CF or USB soft key; and press DISP/ENTER

Basic Setting Hode

Load settings. Initialize > Load settings

File name

Free space 442448 Kbytes

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.
* Setup data files are stored in the root directory [/].
To cancel the operation, press ESC.

3. Press DISP/ENTER.

The setup data is loaded.

Note

For details on how to use the Sort key, see section 6.7.

Explanation

e Setup Data File
» The extension is .PDL.
» The maximum size of a single setup data file is approximately 200 KB.
» The following settings are also saved.
» Current monitor display conditions
» Monitor auto recovery registration data
» Favorite key registration data

¢ Loading Setup Data

» Only the setup data of the setting mode is loaded in the setting mode. However,
settings that contradict the setup data of the basic setting mode are not loaded.

» The monitor display conditions, monitor auto recovery registration, and favorite key
registration are also loaded.

+ If the contents of the loaded setup data is invalid, check the error log (see section
4.9).

» Operations through keys, communications, and remote control input are not
executed while the setup data is being loaded.
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Chapter 7  Customizing the Action (Event Action)

7.1 Setting the Event Action Function (Including
Remote Control (/R Option) and USER Key)

A specified action is carried out when an event occurs. This function is called event action.
The remote control function (/R1 option) and the USER key are set by the event action.
For a description of the function, see section 1.6.

Setup Screen

* Event and Action
Press MENU (switch to the setting mode) and select Timer, Event action >
Event action
sraz e 01PN 29in

“sction > Event action
Logic box nunber 1]

Event-Action
Event Remote
Renote nunber 1
Action DisplayGroupChange
Group nunber: 1

j 1 [ 2 [ 3 [ & [ 5 [ 6 [Nxtisz]
e Timer
Press MENU (switch to the setting mode) and select Timer, Event action >

Timer
* When set to absolute time * When set to relaive time

GROLP 1 = o
2895/83/38 11:28:86 e 01" N 26nin

Tiner. Event sction > Tiner

Tiner No. {1 |
Tiner
Hode [Relative
Interval [TH[]
Reset at Hath Start On

¢ Match Time
Press MENU (switch to the setting mode) and select Timer, Event action >
Match time timer
Shvoivan 11:22:0 G0 015 N i

Tiner. Event action » Match tine timer

Tiner numbar 1]
Hatch time timer
Kind Honth
Dav 1
Hour :Hinute [HT]
Timer action Repeat

(uonoy juanz) uondy ay} buiziwolysno H
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7.1 Setting the Event Action Function (Including Remote Control (/R Option) and USER Key)

* Logic box number
You can set up to 40.

¢ Event-Action > Event
The condition to execute the action.

Settings Description

None Not use.

Remote Select the remote control input terminal number.
Relay Select the alarm output relay number.

Switch Select the internal switch number.

Timer Select the timer number.

Matchtime Select the match timer number.

Alarm -

USER-Key -

¢ Event-Action > Action
The action to be executed when an event occurs.

Settings Description

Memory -

Start -

Stop -

Trigger Can be specified when the DX is configured to record event data.

AlarmACK Cannot be specified when the event is set to Relay, Switch, or Alarm.

Math Can be specified on /M1 and /PM1 options.

MathStart Can be specified on /M1 and /PM1 options.

MathStop Can be specified on /M1 and /PM1 options.

Math rst Can be specified on /M1 and /PM1 options.

SaveDisp Can be specified when the DX is configured to record display data.

SaveEvent Can be specified when the DX is configured to record event data.

Message Set the message number to write the message and the destination. Set the
message destination to all groups (All) or a group number.

Snapshot -

Rate1/2 Can be specified when the function for switching between the trend interval
and the secondary trend interval is enabled.

M.sample -

TimerRst Cannot be specified when the event is set to Timer.

Group Specify the number of the group to be displayed.

Flag Can be specified on /M1 and /PM1 options.

Time adj Can be specified only when the event is set to Remote.

PnlLoad Can be specified only when the event is set to Remote.
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7.1 Setting the Event Action Function (Including Remote Control (/R Option) and USER Key)

Timer
Timer used by event action. Used also in the TLOG computation of the computation
function.
* The timer cannot be changed while memory sampling or computation is in progress.
¢ Timer No.
Up to four timers (1 to 4) can be set.
When Using an Absolute Timer
* Mode
Select Absolute.
e Interval
Select the interval from the available settings between 1min to 24h.
* Ref.time
Set the time in the range of hour 0 to hour 23.

When Using a Relative Timer
* Mode
Select Relative.
* Interval
Set the interval in the range of 00:01 (1 min) to 24:00 (24 hours).
¢ Reset at Math Start
On: Resets the timer when computation is started. The resetting of the timer is not

considered to be a timeout. Even if the timer is used as an event, the action is not
executed.

Match Time Timer
Set the time match condition used in event action.

*

The condition cannot be changed while memory sampling or computation is in progress.
e Timer number
You can set up to four match time conditions (1 to 4).

¢ Kind

Settings Description

Day Set the time match condition of a day.
Week Set the time match condition of a week.
Month Set the time match condition of a month.

Set the items with check marks in the following table depending on the Kind setting.
Kind

Day Week Month

Day v

Day of week

Hour:Minute v v v

Setup Item

e Day
Set the day.
* Weekday
Set the day of the week.
* Hour:Minute
Set the time in the range of 00:00 to 23:59.
* Timer action

Settings Description

Single Executes the action once when the condition is met.

Repeat Executes the action at every specified time.

IM 04L42B01-01E
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7.1 Setting the Event Action Function (Including Remote Control (/R Option) and USER Key)

Procedure

* Resetting the Relative Timer

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Timer reset soft key.

3. Press the soft key corresponding to timer you want to reset. Select All to reset all
timers.
The relative timer is reset.

Explanation

* Resetting the Relative Timer
Restarts the timer.
» The resetting of the timer is considered to be a timeout. (If the timer is used as an
event, the action is executed.)
 If the timer is used in TLOG computation on the /M1 or /PM1 math option and
mathreset is specified, the computed result is reset.
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7.2 Setup Examples of Event Action

Example 1: Starting/Stopping the Memory Sampling through Remote Control
(/R1 Option)

Starts/Stops the memory sampling when a signal is applied to remote control input
terminal 2. Use logic box number 1.
¢ Setup Screen and Setup Items
Press MENU (switch to the setting mode) and select Timer, Event action >
Event action

GROUP 1 & A
i nsvo 1125 e 01 I in (5]
Timer, Event action > Event action

Logic box number

Event-fiction

Event Remote
Remote nunber 2
fAction HemoryStart/Ston
1 2 3 4 5 6 Next 1/7

<Operation>

If the input to the remote control input terminal 2 is turned ON when memory sampling
is stopped, memory sampling starts. If the remote control input is turned OFF when
memory sampling is in progress, memory sampling stops.

Example 2: Writing a Message When an Alarm Occurs

Write the message “Channel 1 Alarm” to group 1 when an alarm occurs on channel 1.
Use logic box number 2.

¢ Setup Screen and Setup Items
Press MENU (switch to the setting mode) and select Timer, Event action >
Event action

GROLP 1 r= -
2665/89/39 11:00:42 d DISP NN 2fnin =

Tiner. Event action > Event action

Logic box number n
Event-fction

Event Suwitch
Switch No- $83
fAction HMessage
Hessage No-
Write to Select
Group number 1
1 2 3 4 5 6 Next 1/7

<Other Settings>

» Set an alarm to channel 1 and output to internal switch 3.
* Register “Channel 1 alarm” in message number 4.

For the procedure to set the alarm, see section 3.7.

For the procedure to set the message, see section 5.4.
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7.2 Setup Examples of Event Action

Example 3: Saving the Data Every Day at Hour 17

Save the recorded data to the CF card every day at hour 17. Use logic box number 3.
Use match time condition 1.

e Setup Screen and Setup Items
Logic box number 3
Press MENU (switch to the setting mode) and select Timer, Event action >
Event action

GROUP 1 = .
2005/09/20 11:30:38 ‘e 015P I 28nin

Timer, Event action > Event action

Logic hox number 13}

Event-fiction

Event HatehT imeT i mer
Hateh Time Timer No. 1

fAction SaveDisplay

1 2 3 4 5

Match Time Condition
Press MENU (switch to the setting mode) and select Timer, Event action >
Match time timer

GROUP 1 = ,
2005/09/30 11:30:54  ‘pue 015P I 28nin

Timer, Event action > Hatch time timer

Tiner nunber
Hatch time timer
Kind Day
Day 1
Hour:Hinute 17:60
Tiner action Repeat
1 2 3 4
<Other Settings>

Set the display data to be saved automatically. Set the file save interval to 1day or
longer. If a file save interval shorter than 1day is specified, the data is also saved at the

file save interval.

For the procedure to set the recording conditions of the display data, see section 6.1.
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7.2 Setup Examples of Event Action

Example 4: Releasing the Alarm Output Using the USER Key (Alarm

Acknowledge Operation)
Release the activated alarm output by pressing the USER key. Use logic box number 4.
¢ Setup Screen and Setup Items
Press MENU (switch to the setting mode) and select Timer, Event action >
Event action

GROLP 1 r= :
a1 161042 o D1 I 2ein ()

Tiner. Event action > Event action

Logic box number n
Event-fiction

Event | Userey

Action | ATarnACK

1 2 3 4 5 6 Next 1/7

<Operation>
Press the USER key to release the activated alarm indication and relay output.

<Related Settings>

Set the alarm indication and alarm output relay operation to Hold.

For the procedure to set the alarm indication operation and alarm output relay operation,
see section 3.5.
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Chapter 8 Using the Security Function

8.1 Disabling the Key Operation (Key Lock
Function)

Setup Screen

Disable the key operation.
For a description of the function, see section 1.7.

» Selecting the Key Lock Function
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > Security, Media save,
Batch

Environment > Security, Hedia save, Batch

r Security
Key
Communication off
Save
(Hutu save off
Batch
On/0ff off

0ff Login | Keylock

* Key Operation to Be Disabled

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Keylock

Basic Setting Mode

Keylock
r Keylock

Passuord _

Key action fAction of Function

START Free AlarnACK Free
STOP Free Hessage / Batch Free
HENU Free Hath Free
USER Free Data save Free
DISP/ENTER Free E-mail 7 FTP Free
FAYORITE Free Time set Free
Hedi a/USB Display Function Free
External nedia [ Free

Input Clear Copy

¢ Security > Key

Select Keylock.

Settings Description

Keylock Enables the key lock function. The Keylock item is displayed in the
basic setting mode menu.

Login Enables the login function. See section 8.2.

* Keylock > Password

The password used to release the key lock. (Up to 8 characters, [Ala[#]1])

* Keylock > Key action, Media/USB, Action of Function

Select whether to lock each item.

Settings Description
Free Key lock not applied.
Lock Disables the operation.
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8.1 Disabling the Key Operation (Key Lock Function)

Procedure

* Locking the Keys
1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Keylock soft key.
The key lock is activated. The key lock icon appears in the status display section.

* Releasing the Key Lock
1. In the operation mode, press FUNC.
The FUNC key menu appears.
2. Press the Keylock soft key.
A window appears for you to enter the password.

GROLP 1 r= -
o095/89/38 11:34-0n  hed DIsP I 20nin

e

3. Enter the password and press DISP/ENTER.

The key lock is released. The key lock icon in the status display section
disappears.
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8.2 Enabling Only Registered Users to Operate the
DX (Login Function)

Only registered users can operate the DX.
For a description of the function, see section 1.7.

Setup Screen

* Login Function

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > Security, Media save,
Batch

Basic Setting Hode

Save
Auto save 0ff
- Batch
On/0ff off

off Legin | Heylock

* Logout Method

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Login > Basic settings

liser basic settings

futo logout
Operation without Losin 0t

uonoun4 Ayinosag ayj buisn n

off 1min 2nin Snin 1Brin

* Registering Administrators

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Login > Admin settings

Basic Setting Mode

Admin nunber [T
Adnin settings
Hode m
User name Adminl
Passuord keciiiids

0ff Key Keyt+Conn
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8.2 Enabling Only Registered Users to Operate the DX (Login Function)

Setup Items

* Registering Users

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Login > User settings

Basic Setting Hode

Login > User settings

User nunber 1
User settinns ——
Hode | Key |
User name Userl
Password fesdidid]
Authority of user off
0ff Key Conn Web Key+Conn

e User Privileges

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Login > Authority of user

thernet

Login > Authority of user

futhority of user

r Authority of user

Key action fAction of Function

START Free AlarnACK Free
STOP Free Hessage / Batch Free
HENU Free Hath Free
USER Free Data save Free
DISP/ENTER Free E-nail / FTP Free
FAYORITE Free Time set Free
HediasUSB Display Function Free
External media [ Free

1 2 3 4 5 6 Next 1/2

The login function can be set separately for login through keys and login through
communications.

e Security > Key

Select Login.

Settings Description

Login Enables only registered users to operate the DX using keys. The Login
item is displayed in the basic setting mode menu.

Keylock Enables the key lock function. See section 8.1.

Off Disables the security functions.

¢ Security > Communication

Settings Description

Login Enables only registered users to operate the DX via communications. The
Login item is displayed in the basic setting mode menu.

Off Disables the security functions.

* User basic settings > Auto logout

Settings Description
Off Does not log out until the logout operation is executed.
1min to 10min Automatically logs out when there is no key operation for a specified time.
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8.2 Enabling Only Registered Users to Operate the DX (Login Function)

User basic settings > Operation without login
Sets the operation that the user can carry out when logged out.

Settings Description
Off Only login operation is available.
Display Allows the user to switch the operation screen in addition to the login operation.

Admin number
Up to five administrators can be registered. Be sure to register at least one
administrator. At least one administrator must be registered to use the login function.

Admin settings > Mode
The available settings vary depending on the Security setting.

Settings Description

Off Not register.

Key Log into the DX using keys.

Comm Log into the DX via communications.

Web Log into the operator page and monitor page of the DX using a Web browser.

Key+Comm Log into the DX using keys and via communications.

Admin settings > User name

Set the user name. (Up to 20 characters, [Ala[#[1])

* You cannot register user names that are already registered.

* You cannot register “quit” or a user name containing all spaces.
Admin settings > Password

Set the password. (Up to 8 characters, [Ala[#[1])

Gkkkkkkkk V
as .

* You cannot register “quit” or a password containing all spaces.

User number
Up to 30 users can be registered.

User settings > Mode
The available settings vary depending on the Security setting.

Settings Description

Off Not register.

Key Log into the DX using keys.

Comm Log into the DX via communications.

Web Log into the monitor page of the DX using a Web browser.

Key+Comm Log into the DX using keys and via communications.

User settings > User name, Password
Same as the administrator settings.

e Authority of user

Settings Description

Off No limitations on the operation.

1to 10 Registration number of the operation limitation.

Authority of user > Key action, Media/USB, Action of Function
See section 8.1.

IM 04L42B01-01E

8-5

uonoun4 Ayinosag ayj buisn H



8.3 Logging in and Logging Out

Procedure

This section explains the procedure to log into the DX using keys. For the

procedure

to log into the DX via communications, see the Communication Interface User’s

Manual (IM04L41A01-17E).

* Logging In
1. In the operation mode, press FUNC.
A list of registered user names appears.

GROUP 1 = _
S g 11:a7:0 G D1sP I 2 ()

Userl

2. Press the arrow keys to select a user name, and press DISP/ENTER.
A window appears for you to enter the password.

GROUP 1 r= _
onas/e0/38 11:37:53  “ped DIsP I 2fnin =

Userl

S
[ o

3. Enter the password* and press DISP/ENTER.

The DX is ready to be operated using keys. The name of the user that is logged in

is displayed in the status display section.
* The password that you enter is displayed as

fkkkkokkokk

* Logging Out
Using Keys
1. In the operation mode, press FUNC.
The FUNC key menu appears.
2. Press the Logout soft key.

You are logged out from the DX. The user name in the status indication section

disappears.

Auto Logout

If auto logout is enabled, you are automatically logged out if there is no key operation

for a specified time.

8-6
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8.3 Logging in and Logging Out

¢ Changing the Password

Using Keys
1. In the operation mode, press FUNC.
The FUNC key menu appears.
2. Press the Password change soft key.
A window appears for you to enter the current password.
3. Enter the current password and press DISP/ENTER.
A window appears for you to enter the new password.
4. Enter the new password and press DISP/ENTER.
A window appears for you to enter the new password again.
5. Enter the new password and press DISP/ENTER.

The window closes, and the new password is activated.

IM 04L42B01-01E
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Chapter 9 Computation and Report Functions (/M1 and /PM1 Options)

9.1 Setting the Expression, Measurement Range,
Alarm, Tag, and Data Storage on Computation
Channels

Set the computation details, measurement range, tag, and alarm. You cannot set
expressions or constants while memory sampling or computation is in progress.
For a description of the function, see section 1.8.

Setup Screen

* Expression and Alarm
Press MENU (switch to the setting mode) and select Math Channel >
Calculation expression, Alarm

[

Calculation expression

Span Lover  Span Upper  lnit
[ -288.08 200.00 |

= Hath alars

1
2
3
4

¢ Constants Used in Expressions
Press MENU (switch to the setting mode) and select Math Channel >
Constant

¢ Tag and Alarm Delay Time of Computation Channels
Press MENU (switch to the setting mode) and select Math Channel > Tag,
Memory sample, Alarm delay
5 G DISP N lhour

o " ]

Alarn delay
[Tila [1is

Input | Clear Copy
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9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Measurement Channels

Conditions of TLOG Computation and Rolling Average

Press MENU (switch to the setting mode) and select Math Channel > TLOG,
Rolling average

aby10/17 gs:16:22 el 015 NN 1hour

' Hath Channal > TLOG. Rolling averase
First-CH ITTH Last-CH 181

- Rolling averase -
On/0ff On
Interval 18s
Hunber of sanples 1

Display for Computation Errors and Handling of Overflow Data in
Statistical Computation

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Environment > Math, Report

Basic Settina Hode

- Mh —
Yalue on Error | +0ver |
Value on Ouerflow

SUH, AVE I Skip

HAK. HIN. P-P Ouer
v Report S
Report salect

1 Ave

2 Hax

3 Hin

4 Sun
File tupe Separate

First-CH/Last-CH
Set the target channels.

Calculation expression and Span
e Math On/Off
Select On for channels to be used.
¢ Calculation expression
Enter the expression using up to 120 characters.

Pressing the Input soft key displays a window used to enter the expression. Use
the numeric keys to enter numbers and operators.

=

[iEBREEERE

For details on how to write expressions, see section 9.2.

Nofte
You cannot use both the USB keyboard (/USB1 option) and the DX keys to enter the equation.
If you press a DX soft key, for example, while you are entering an equation from the USB
keyboard, the entered equation is cleared.
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9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Measurement Channels

¢ Span Lower, Span Upper
Set the measurement range.
Selectable range of values: —9999999 to 99999999
Selectable decimal places: X.XXXX, XX. XXX, XXX.XX, XXXX.X

e Unit
Set the unit of the computed value. (Up to 6 characters, [Ala[#]1])

e Alarm
The available alarm types are high limit alarm, low limit alarm, delay high limit alarm,
and delay low limit alarm.
The range of alarm values is as follows:

Type Value
H, L Tt Within —9999999 to 99999999 excluding the decimal point

For details on setting alarms, see section 3.7.
* If the Math On/Off or calculation expression is changed, the alarms for that channel are turned
Off.

e Alarm delay > Time
Set the alarm delay time using an integer in the range of 1 to 3600 s.

* Tag > Tag
Set the tag. (Up to 16 characters, [Ala[#]1])

¢ Constant

*  Number of constant
Select the constant (K01 to K60) to set.

* Value
The selectable range is as follows:
—9.9999E+29 to —1.0000E-30, 0, 1.0000E-30 to 9.9999E+29
The number of significant digits of a constant is five. When specifying the
constant using exponential notation, set the mantissa less than or equal to 5
digits and the exponent less than or equal to 2 digits.

e TLOG

e Timer No.
Select the timer number to use.
For details on setting the timer, see section 7.1.

e Sum scale
Set the sum scale to /s to /h to match the unit of the measured value.
Example: If the unit of the measured value is “mS/min,” select /min.
Off: Sums as-is the measured data per scan interval.

e Reset
To reset the TLOG computed value at each interval, select On.
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9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Measurement Channels

* Rolling average

e On/Off
To take the rolling average of the measured results, select On.

* Interval
Select the sampling interval when taking the rolling average from the following:
The sampling interval takes on a value that is an integer multiple of the scan
interval. For example, if the sampling interval is set to 5 s when the scan interval
is 2 s, the actual sampling interval is 6 s.

*  Number of samples
Set the number of samples for the rolling average using an integer between 1

and 1500.
The rolling average time is equal to the sampling interval x the number of
samples.

Nofte

If the number of data points to be averaged has not reached the specified number of
samples immediately after computation is started, the average of the available data is
calculated.

« Computation error data is excluded from the rolling average computation.

« If the computed data exceeds the upper or lower limit, the data is clipped at the upper or
lower limit, and the rolling average is computed. The upper and lower limit is “£100000000”
excluding the decimal point. The decimal place is the same as that of the span lower limit.

Memory sample > On/Off
Turn On the target channels.

Math

e Value on Error

Specify whether to set the display for a computation error to +Over or —Over.
¢ Value on Overflow > SUM, AVE

Specify how to handle overflow data when it is detected in the SUM or AVE

computation of TLOG or CLOG. This setting is also applied to report generation.
Settings  Description

Error Sets the computed result to computation error.
Skip Discards the overflow data and continues the computation.
Limit Uses a limit value in place of the overflow data and continues the computation.

¢  Value on Overflow > MAX, MIN, P-P
Specify how to handle overflow data when it is detected in the MAX, MIN, or P-P
computation of TLOG or CLOG. This setting is also applied to report generation.

Settings  Description

Over Uses the overflow data as-is.

Skip Discards the overflow data and continues the computation.
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9.2 Writing Expressions

Common ltems

This section explains the meaning and how to write expressions.

Follow the rules below when writing expressions.

Use up to 120 characters to write expressions.

The precedence of computing terms can be specified using parentheses.

Specify the channels in the expression using channel numbers.

Example: 1, 12, 101, and 201

The one-digit number of constants (K), communication input data (C), remote input
terminal status (D), pulse input (P, Q), internal switch (S), alarm output relay status (1),
and flag (F) in the expression can be denoted as in “01” and “1.”

Example: KO1, K1, C01, C1, D01, D1, P01, P1, Q01, Q1, S01, S1, 101, I1, FO1, and F1.
The data of the previous scan is used in the computation for its own channel number
and channel numbers greater than its own channel number in the expression.
Special computation (HOLD, RESET, and CARRY) and conditional expressions are
written at the beginning of the expression.

Order of Precedence in Computations
The order of precedence of computation in expressions is as follows:

Type Computing Element
(high order of precedence)
Function ABS(), SQR(), LOG(), LN(), EXP(),

TLOG.MAX(), TLOG.MIN(), TLOG.
AVE(), TLOG.SUM(), TLOG.P-P(),
CLOG.MAX(), CLOG.MIN(), CLOG.
AVE(), CLOG.SUM(), CLOG.P-P()

Special computation and conditional expression PRE, HOLD, RESET, CARRY, [a?b:c]
Power >

Logical negation NOT

Multiplication and division *

Addition and subtraction +, -

Greater than and less than .GT., .LT,, GE., LE.

Equal and not equal .EQ., .NE.

Logical product AND

Logical sum and exclusive logical sum OR, XOR

(low order of precedence)

Limitations
The following limitations exists in writing expressions.

Type Limitations

TLOG computation A computing element cannot be written inside the parentheses.
Only one TLOG computation can be specified in a single expression.

CLOG computation Number of channels that can be written in the parentheses is 30 channels or less.
A computing element cannot be written inside the parentheses.
Only one CLOG computation can be specified in a single expression.

PRE A computing element cannot be written inside the parentheses.
HOLD(a):b Can only be written at the beginning of an expression.

Only one HOLD computation can be specified in a single expression.
RESET(a):b Can only be written at the beginning of an expression.

Only one RESET computation can be specified in a single expression.
CARRY(a):b Can only be written at the beginning of an expression.

Only one CARRY computation can be specified in a single expression.
Only TLOG.SUM can be written in “b.”

Conditional equation RESET, CARRY, or HOLD cannot be written to “a,” “b,” or “c.” Other computing
[a?b:c] elements cannot be combined (example: [a?b:c]+001). However, conditional
equations can be specified for a, b, and c.
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9.2 Writing Expressions

Four Arithmetic Operation

Expression Example
+ Addition 001+002
(Determines the sum of the measured values of channel 1 and channel 2.)
* Subtraction 001-002
(Determines the difference of the measured values of channel 1 and
channel 2.)
* Multiplication 001*K03
(Multiplies constant KO3 to the measured value of channel 1.)
» Division 001/K02
(Divides the measured value of channel 1 by constant K02.)

Power and Other Computations

Expression Example
+ Power 001**002
(Determines the measured value of channel 1 to the power of the
measured value of channel 2.)
» Square root SQR(002)
(Determines the square root of the measured value of channel 2.)
» Absolute value ABS(002)
(Determines the absolute value of the measured value of channel
2)
«  Common logarithm LOG(001)
(Determines the common logarithm (log10) of the measured value
of channel 1.)
* Natural logarithm LN(001)
(Determines the natural logarithm of the measured value of
channel 1.)
» Exponent EXP(001)
(Determines e to the power of the measured value of channel 1.)

Relational Computation

Expression Example

002.LT.003

If the measured value of channel 2 is less than the measured value of channel 3, the
computed result is “1.” Otherwise, the result is “0.”

002.GT.003
If the measured value of channel 2 is greater than the measured value of channel 3, the

computed result is “1.” Otherwise, the result is “0.”

002.EQ.003
If the measured value of channel 2 is equal to the measured value of channel 3, the

computed result is “1.” Otherwise, the result is “0.”

002.NE.003
If the measured value of channel 2 is not equal to the measured value of channel 3, the

computed result is “1.” Otherwise, the result is “0.”

002.GE.003
If the measured value of channel 2 is greater than or equal to the measured value of

channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.LE.003
If the measured value of channel 2 is less than or equal to the measured value of channel 3,

the computed result is “1.” Otherwise, the result is “0.”

9-6
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9.2 Writing Expressions

Logical Computation

Checks whether the two data values, e1 and e2 (e1 only for NOT), are zeroes or non-
zeroes, and computes according to the conditions.

AND

Logical product

(Syntax)
(Condition)

(Explanation)

OR

Logical sum
(Syntax)
(Condition)

(Explanation)

XOR
Exclusive OR
(Syntax)
(Condition)

(Explanation)

NOT

Logical negation

(Syntax)
(Condition)
(Explanation)

e1ANDe2
If the two data values e1 and e2 are both non-zeroes, the computed
result is “1.” Otherwise, it is “0.”

e1=0,e2=0 — e1ANDe2 =0
e1#0,e2=0 — e1ANDe2 =0
e1=0,e2#0 — e1ANDe2 =0
e1#0,e2#0 — e1ANDe2 =1
e10Re2

If the two data values e1 and e2 are both zeroes, the computed result
is “0.” Otherwise, it is “1.”

e1=0,e2=0 — e10Re2 =0
e1#0,e2=0 — e1ORe2 =1
e1=0,e2#0 — e10ORe2 =1
el1#0,e2#0 — e1ORe2 =1
e1XORe2

If the two data values e1 and e2 are zero and non-zero or non-zero
and zero, the computed result is “1.” Otherwise, it is “0.”

e1=0,e2=0 — e1XORe2=0

e1#0,e2=0 — e1XORe2 =1

e1=0,e2#0 — e1XORe2 =1

e1#0,e2#0 — e1XORe2 =0

NOTe1

The result is the inverse of the status of data e1 (zero or non-zero).
e1=0 — NOTe1 =1

e1#0 — NOTe1=0

Expression Example
01-020R03.GT.04
Determines the OR of the computed results of “01-02” and “03.GT.04".

IM 04L42B01-01E
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9.2 Writing Expressions

TLOG Computation

In the explanation below, an expression containing a computing element in e1, an
internal switch (S), a relay (1), or flag (F) cannot be written. In addition, only one TLOG
computation can be specified in a single computing equation.

TLOG.MAX()

Maximum value

(Syntax) TLOG.MAX(e1)

(Condition) Determines the maximum value of channel e1.
TLOG.MIN()

Minimum value

(Syntax) TLOG.MIN(e1)

(Condition) Determines the minimum value of channel e1.
TLOG.AVE()

Average value

(Syntax) TLOG.AVE(e1)

(Condition) Determines the average value of channel e1.
TLOG.SUM()

Sum value

(Syntax) TLOG.SUM(e1)

(Condition) Determines the sum of channel e1.
TLOG.P-P()

Maximum - minimum value

(Syntax) TLOG.P-P(e1)

(Condition) Determines the maximum - minimum value of channel e1.

Expression Example
TLOG.MAX(01)+K01*SQR(02)

Examples of Equations That Are Not Allowed
TLOG.AVE(01)+TLOG.AVE(02)
Reason: TLOG appears twice in one equation.

TLOG.AVE(ABS(01))
Reason: A computing element is used inside the parentheses.

9-8
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9.2 Writing Expressions

CLOG Computation

Only data of measurement channels, computation channels, and external input channels
can be used in the CLOG computation. Up to 30 channels can be written in the
parentheses.

In the explanation below, an expression containing a computing element cannot be
written to e1, etc. In addition, only one CLOG computation can be specified in a single
computing equation.

CLOG.SUM()

Sum value

(Syntax) CLOG.SUM(e1.e2.e4-e6)

(Condition) Determines the sum of the data of channels e1, €2, e4, €5, and e6 that
are measured at the same time.

CLOG.MAX()

Maximum value

(Syntax) CLOG.MAX(e1.e2.e4-e6)

(Condition) Determines the maximum value among the data of channels e1, e2,
e4, e5, and eb6 that are measured at the same time.

CLOG.MIN()

Minimum value

(Syntax) CLOG.MIN(e1.e2.e5.e7)

(Condition) Determines the minimum value among the data of channels e1, e2, €5,
and e7 that are measured at the same time.

CLOG.AVE()

Average value

(Syntax) CLOG.AVE(e1-€6)

(Condition) Determines the average value among the data of channels e1 to e6
that are measured at the same time.

CLOG.P-P()

Maximum - minimum value

(Syntax) CLOG.P-P(e1.e2.e5.e7)

(Condition) Determines the difference between the maximum and minimum values

among the data of channels e1, e2, €5, and e7 that are measured at
the same time.

Expression Example
CLOG.MAX(001.002.104-106)+K01*SQR(002)

Examples of Equations That Are Not Allowed
CLOG.AVE(001.003.005)+CLOG.AVE(002.004.006)
Reason: CLOG appears twice in one equation.

CLOG.AVE(001.ABS(001))
Reason: A computing element is used inside the parentheses.
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9.2 Writing Expressions

Special Computation

PRE()
(Syntax)
(Condition)

HOLD(a):b
(Syntax)
(Condition)

RESET(a):b
(Syntax)
(Condition)

CARRY(a):b
(Syntax)
(Condition)

(Description)

PRE(e1)
Determines the previous value of e1.

HOLD(a):b
When a is zero, b is carried out to derive the computed value.
Otherwise, the previous computed value is held.

RESET(a):b

When a is zero, b is carried out to derive the computed value.
Otherwise, the previous computed value of b is reset, and b is carried
out to derive the computed value.

CARRY(a):b

Only TLOG.SUM can be specified for b. If the computed value X of b is
less than a, the computed result is X. If X is greater than or equal to a,
the computed result is the excess (X — a).

When a value such as the flow rate is summed and the threshold value
is reached or exceeded, the sum value is reset while carrying over the
amount that exceeded the threshold value.

Expression Example
Expression that sums the values of channel 1 and resets the value when it reaches or

exceeds 10000

K01 = 10000

CARRY/(K01):TLOG.SUM(001)

Examples of Equations That Are Not Allowed
002+HOLD(K01):TLOS.SUM(001)
Reason: HOLD is not at the beginning of the expression.

RESET(101.GT.K01):TLOG.SUM(001)+RESET(101.GT.K01):002
Reason: RESET appears twice in one equation.

Conditional Expression

[a?b:c]
(Syntax)
(Condition)

[001.GT.K01?002:003]

If the measured value of channel 1 is greater than constant K01, the
computed result is the measured value of channel 2. Otherwise, the
computed result is the measured value of channel 3.

Examples of Equations That Are Not Allowed
[001.GT.K01?002:003]*K02
Reason: Used in combination with another computing element.

Nested Conditional Expressions

A conditional expression can be written to Expression,, Expressionz, and Expressions
in the equation [Expression,?Expression,:Expressions]. For example, the following
expression is allowed: [Equation,?[Equation,_?Equation,_,:Equation,_s]:[Equations.
1?Equations_,:Equations_]]

Expressions can be nested as long as the number of characters of the expression does
not exceed 120 characters.

9-10
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9.3 Displaying the Computation Channels

Setup Screen

Computation channels can be assigned to groups and displayed in a similar manner to
measurement channels.

For a description of the function, see section 1.8.

e Color
Press MENU (switch to the setting mode) and select Math Channel > Color

GROUP 1 =
1017 po:1g:0p e D1e I thor (S

Hath Channel > Color

Group of channel
r Color —
181 | ] Red
1e2 B [ Green
183 | ] Blue
104 B [B.violet
185 B [ Brown
186 Orange
187 Y. green
168 Lightblue
169 Violet
118 [ | Gray

181-116 | 111-128 | 121-138

¢ Zone Display, Scale Display, and Bar Graph Display
Press MENU (switch to the setting mode) and select Math Channel > Zone,
Scale, Bar graph

GROUP 1 =
o117 pocigcie e DI N thor (S

Hath Channel > Zone. Scale, Bar graph

131-148

141-158

161

First-CH 0N Last-CH

r Zone

Lower [ 4
Upper 108 %
r Scale

Position 1
Division 18
r Bar graph

Base position Normal
Division 18

» Partial Expanded Display

151-168

Press MENU (switch to the setting mode) and select Math Channel > Partial

GROLP 1 r=
R 517 mo-1a-y  ed isp NN 1hor ()

Hath Channel > Partial

161

First-CH it  Last-CH
Partial
On/0ff On
Expand 58 %
Boundary 8.
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9.3 Displaying the Computation Channels

Setup Items

Alarm Marks and Color Scale Band
Press MENU (switch to the setting mode) and select Math Channel > Alarm

mark, Color scale band

GROLP 1 =
ona5/18/17 9:15:43  ed 01SP NN 1hour

Hath Channel > Alarm nark, Color scale band
First-CH Last-CH

1m

Color scale band

Band area

Color

Display position
Lower

Upper

@

[
[ Tine

8.68
1.00

Alarn mark —_—

Hark kind Fixed
Indicate on Scale off
Alarn mark color

Alarm 1 Red
Alarm 2 Orange
Alarm 3 Orange
Alarm 4 Red

Channel Numbers, First-CH, and Last-CH
Select the target channel range.

Channel Display Color

See section 5.5.

Zone Display
See section 5.6.

Partial Expanded Display

See section 5.9.

Bar Graph Display Method

See section 5.11.

Scale
See section 5.7.

Alarm Marks and Color Scale Band

See section 5.8.
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9.4 Starting/Stopping Computation, Resetting
Computation, and Releasing Computation Data
Dropout Display

Setup Screen

Procedure

* Action Taken When the START Key Is Pressed
Press MENU (switch to the setting mode) and select Math Channel > Math
start action

GROLP 1 r=
a7 g1 e D1 I thor ()
Hath Channel > Hath start action

Hath start action
’7hath start Start

0ff

Start Rst+St

¢ Math start action > Math start

Settings Description

Off Does not start the computation even when the START key is pressed.

Start Starts the computation when the START key is pressed.

Rst+St Resets the computed result up to then and starts the computation when the

START key is pressed.

» Starting the Computation

Starting the Computation Simultaneously with the Memory
Sampling
Press START. Computation starts simultaneously with the start of the memory

sampling. The computation icon appears in the status display section.
* Math start must be set to Start or Rst+St.

Starting Only the Computation
In the operation mode, press FUNC.
The FUNC key menu appears.
Press the Math start soft key.

Computation starts, and the computation icon is displayed in the status display
section.

IM 04L42B01-01E
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9.4 Starting/Stopping Computation, Resetting Computation, and Releasing Computation Data Dropout Display

¢ Stopping the Computation

e Stopping the Computation Simultaneously with the Memory
Sampling

1. Press STOP.
A confirmation dialog box appears.

GROLP 1 = -~
2005/18/17 99:54:18 ois> e e B)ER

ImifiFdiv

52.0
412.3

kPaZ

182.47

bH

L 9.6?
182.95

3

97.5
Z
2. Select Mem+Math and press DISP/ENTER.

The memory sampling and computation stop, and the computation icon in the
status display section disappears.

¢ Stopping Only the Computation

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Math stop soft key.
The computation stops, and the computation icon in the status display section
disappears.

Nofte
When the computation is stopped, the computed data of the computation channel is held at the
value that existed immediately before the computation is stopped. When memory sampling is in
progress, the held value is recorded.

Resetting the Computed Results on All Computation Channels
This operation can be carried out when the computation is stopped. You can carry out this
operation even while the computation is in progress on DXs with release number 2 or later.
1. In the operation mode, press FUNC.

The FUNC key menu appears.
2. Press the Math reset soft key.

The computed results of all computation channels are reset.

Releasing the Computation Data Dropout Display
This operation can be carried out when a computation data dropout occurs. When a
computation data dropout occurs, the computation icon turns yellow.
1. In the operation mode, press FUNC.
The FUNC key menu appears.
2. Press the Math ACK soft key.
The computation icon returns to white.
* Math ACK is displayed in the FUNC key menu only when a computation data dropout occurs.

Nofte
A computation data dropout occurs when the computation process cannot be completed within
the scan interval. If computation data dropout occurs frequently, lessen the load on the CPU by
reducing the number of computation channels or setting a longer scan interval. If a computation
data dropout occurs during memory sampling, the data immediately before the dropout is
recorded as the computed data of the scan interval in which the dropout occurred.

9-14
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9.5 Creating Reports

Set how the reports are created.
For a description of the function, see section 1.8.

Setup Screen

* Report Computation Type
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to

r Hath

Value on Error +0ver

Value on Querflow
SUH, AVE Skip

HAX. HIN. P-P Over

i

= Report
Report select
| fve |
2 Hax
3 Hin
[ Sun
File type Separate
Haix Hin fve Sun Inst

* Report Type and Time of Creation
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Report > Basic settings

Ethe

Report > Basic settings

Report set —
Report kind
Date 1
Time Chour) [
0ff Hour Day Hour+Day | Day+ieck |Dav+itonth

¢ Source Channels
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to
the basic setting mode), and select Report > Report settings

Basic Setting Mode

Report > Report settings

Report Channel nunber

Report CH
On/0ff On
Channel 1
Sunm scale /s
REL RE2 RE3 RA4 RES RE6  |Next 1/18
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9.5 Creating Reports

Report > Report select > 1, 2, 3, and 4
Select the type of data to output as reports.

Settings Description

Off Does not output reports.

Ave Outputs the average value.

Max Outputs the maximum value.

Min Outputs the minimum value.
Sum Outputs the sum value.

Inst Outputs the instantaneous value.

Report > File type
Set this item when creating two types of reports such as daily report and monthly

report.

Settings Description

Separate Saves each type of report to a separate file.
Combine Saves the report data of two types in a single file.

Report set > Report kind
Select the type of report to be created.

Settings Description

Hour Creates hourly reports.

Day Creates daily reports.

Hour+Day Creates hourly and daily reports.
Day+Week Creates daily and weekly reports.
Day+Month Creates daily and monthly reports.

Report set > Date/Day of the week and Time (hour)

Set the date or day of the week and the time when the report is to be created. The
specified date/time is when the report file is divided. Set the values in the range

indicated below. Items with a dash are invalid.

Report Type Date Day of Week Time

Hour - - 0 to 23
Day 1 to 28* - 0to 23
Hour+Day - - 0to 23
Day+Week - SUN to SAT 0 to 23
Day+Month 1to 28* - 0 to 23

*

You cannot specify 29, 30, or 31.
Report Time and Date/Time When the Report File Is Divided

Example: When the Date of a daily report is set to 1 and the Time (hour) is set to

18:00

A daily report is created every day at hour 18.
The file storing the report is divided at 18:00 on day 1 of each month.

9-16
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9.5 Creating Reports

Procedure

Report Channel number
The report is output in order by this number.

Report CH > On/Off
Select On for the report channels to be used.

Report CH > Channel
Set the channel to assign to the report channel. All channels can be assigned, but
reports are not created for channels set to Skip or Off even if they are assigned.

Report CH > Sum scale

Set the sum scale to /s to /day to match the unit of the measured value.
Example: If the unit of the measured value is “m3/min,” select /min.

Off: Sums as-is the measured data per scan interval.

Handling of Overflow Data
See section 9.1.

Starting/Stopping the Report Function
Starting the memory sampling starts the report function. Likewise, stopping the
memory sampling stops the report function.

Displaying the Reports
See section 4.5.

Saving the Reports
See section 1.4.
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Chapter 10 Using External Input Channels (/MC1 Option)

10.1 Setting External Input Channels

Setup Screen

External input channels can be used on the DX2010, DX2020, DX2030, DX2040, and
DX2048. The data of other devices loaded using the communication function can be
displayed on the DX and saved.

¢ Setting the Input
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch
to the basic setting mode), and select Communication (Ethernet) or
Communication (Serial) > Modbus client or Modbus master > Command
settings

tting Hode

Client command number

— Conmand settings
Client settings Server sa‘ttmus
F.rst Lxst Server  Resisters
1 R I 30881 [NTIE
2 R g2 INT1E
3[R 2&3 = 2&3 [T 3RR83 INT16
4 |[Dff
5 oft
6 [0ff
T |off
8 [Off
1-8 9-16

* Input Range and Alarm
Press MENU (switch to the setting mode) and select Ext. Channel > Range,
Alarm

®

First=CH [281  Last-CH [281

On/0tHf Lover Upper Unit

Ext. range
{m [-zoee8 [ 2088 |

Ext. alarn

N
alan
EHEE
== =

¢ Tag, Memory Sample, and Alarm Delay Time
Press MENU (switch to the setting mode) and select Ext. Channel > Tag,
Memory sample Alarm delay

®

[mn::m - [orr

Alarn delay
[Tin [10s

IM 04L42B01-01E
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10.1 Setting External Input Channels

¢ Channels to Manual Sample
See section 6.5.

* Setting the Input
The measured values of external instruments are loaded using the Modbus client or
Modbus master function to be used as external input channel inputs.
For the setup procedure, see the Communication Interface User’s Manual
(IM04L41B01-17E).

* First-CH/Last-CH
Select the target channels. Channel numbers are 201 to 440.

* Ext. range > On/Off
Select On to use the external input channel.

e Ext. range > Span Lower and Span Upper
Measurement range.
Selectable range of values: —30000 to 30000
Decimal place: Down to four digits to the left of the decimal point

e Ext. range > Unit
Set the unit. (Up to 6 characters, [A[a[#]1])

e Alarm
The available alarm types are high limit alarm, low limit alarm, delay high limit alarm,
and delay low limit alarm.
The range of alarm values is as follows:

Type Value Example of a Range of Alarm Values

H, L Within —30000 to 30000 Within —3000.0 to 3000.0 when the span
excluding the decimal point. is 0.0 to 100.0.

T, t Same as H and L Same as H and L

For details on setting alarms, see section 3.7.

*

If the external input channel On/Off or span setting is changed, the alarms for that channel
are turned Off.

e Alarm delay > Time
For details on setting the alarm delay time, see section 3.7.

* Tag
For details on setting tags, see section 5.2.

¢ Memory sample > On/Off
Turn On the target channels.
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10.2 Displaying the External Input Channels

Setup Screen

External input channels can be assigned to groups and displayed in a similar manner to
measurement channels. See chapter 5.

e Channel Display Color
Press MENU (switch to the setting mode) and select Ext. Channel > Color

Group of channel 201-218

r Color —
2a1 [ | Red
282 B [ Green
283 [ | Blue
2r4 B [ B.violet
285 B [ Brown
288 Orange
207 Y. green
28 Lightblue
28 Violet
218 [ | Gray

201-218 | 211-220 | 221-238 | 231-248 | 241-258 | 251-268 |Next 1/4

¢ Zone Display, Scale Display, and Bar Graph Display
Press MENU (switch to the setting mode) and select Ext. Channel > Zone,
Scale, Bar graph

GROUP 1 = .
S 12:00:0 R DI I cin (S

Ext. Channel > Zone. Scale, Bar graph

First-CH kil Last-CH 201
r Zone

Lower [ 4

Upper 08 %

r Scale —
Position 1

Division 18

r Bar araph

Base position Normal
Division 18

¢ Partial Expanded Display
Press MENU (switch to the setting mode) and select Ext. Channel > Partial

GROUP 1 o] B
S 12:23:00 e 01 I in () )
Ext. Channel > Partial

First-CH Pl Last-CH 281

Partial

On/0ff [

Expand [

Boundary B. 60

IM 04L42B01-01E
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10.2 Displaying the External Input Channels

Setup Items

¢ Alarm Marks and Color Scale Band

Press MENU (switch to the setting mode) and select Ext. Channel > Alarm
mark, Color scale band

GROUP 1 = _
Snm/a9son 12:03:50  “ped 015 I 28nin

Ext. Channel > Alarm nark, Color scale band

First-CH Last-CH 281
Alarn mark —_— Color scale band

Hark kind Fixed Band area In
Indicate on Scale off Color Line
Alarn mark color Display position
Alarm 1 Red Lower B.88
Alarm 2 Orange Upper 1.88
Alarm 3 Orange
Alarm 4 Red

First-CH/Last-CH
Select the target channel range. Channel numbers are 201 to 440.

Channel Display Color
See section 5.5.

Zone Display
See section 5.6.

Partial Expanded Display
See section 5.9.

Bar Graph Display Method
See section 5.11.

Scale
See section 5.7.

Alarm Marks and Color Scale Band
See section 5.8.

10-4
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Chapter 11 Troubleshooting

11.1 A List of Messages

There are cases in which error codes and messages are displayed on the screen during

operation. A list of the possible error codes and messages are given in the table below.
Communication error codes and messages are also listed.
Error responses to communication commands are output in English.

Errors Related to Parameter Settings
. Setting Errors

Code Message

Explanation/Countermeasures/Ref. section

1 System error. Contact your nearest YOKOGAWA dealer.
2 Incorrect date or time setting. Enter a correct value.
3 A disabled channel is selected. Specify a channel that is not set to Skip or Off.

Specify a channel that is installed.

Incorrect function parameter.

See Communication Interface User’s Manual.

The input numerical value exceeds the set range.

Enter a proper value.

Enter a proper character string.

Too many characters.

Enter the correct number of characters.

4
5
6 Incorrect input character string.
7
8

Incorrect input mode.

Specify a correct mode.
See section 3.3.

9 Incorrect input range code. Specify a correct range code.
See section 3.3.

11 Range settings are not same within the selected channels. Specify channels with the same range setting.
See section 3.9.

21 Cannot set an alarm for a skipped channel. Cannot be specified on channels set to Skip.
See section 3.7.

22 The upper and lower span limits are equal. Cannot be set to the same value.
See section 3.3.

23 The upper and lower scale limits are equal. Cannot be set to the same value.
See section 3.3.

24 The lower limit of the span band is greater than the upper limit. Set the lower limit less than the upper limit.
See section 3.3.

25 The lower limit of the scale band is greater than the upper limit. Set the lower limit less than the upper limit.
See section 3.3.

30 The partial boundary value exceeds the range of the span. See section 5.9.

31 Partial-expansion display is set ON for a SKIPPED channel. Cannot be specified on channels set to Skip.

35 The upper and lower limits of the display band are equal. Set the upper limit greater than the lower limit + 5.
See section 5.6.

36 The lower limit of the display band is greater than the upper Set the upper limit greater than the lower limit + 5.

limit. See section 5.6.

37 The display band is narrower than 4% of the entire display. Set the upper limit greater than the lower limit + 5.
See section 5.6.

40 Incorrect group set character string. See section 5.1.

41 There is no specified input channel. Specify a channel that is installed.

42 Exceeded the number of channels which can be set. Up to 10 channels per group.

43 A channel number cannot repeat in a group. See section 5.1.

45 There is no character string saved in the clipboard. Copy a character string to the clipboard.

46 The character string saved in the clipboard is too long. Paste a character string with the specified number of
characters.

47 Start and end time cannot match. See section 2.1.

48 Invalid or missing DST time settings. See section 2.1.

61 There is no channel specified by the MATH expression. See section 9.1.

IM 04L42B01-01E
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11.1 A List of Messages

Code Message Explanation/Countermeasures/Ref. section
62 MATH expression grammar is incorrect. See section 9.2.
63 MATH expression sequence is incorrect. See section 9.2.
64 MATH upper and lower span values are equal. Set the upper limit not equal to the lower limit.
65 Too many operators for MATH expression. See section 9.2.
70 Nonexistent constant specified in MATH expression. See section 9.2.
71 Set range of the MATH constant is exceeded. See section 9.1.
80 This username is already registered. See section 8.2.
81 All space or ‘quit’ string cannot be specified. See section 8.2.
84 The login password has not been set up. See section 8.2.
85 The login password is incorrect. See section 8.3.
86 The key-lock release password is incorrect. See section 8.1.
87 This key is locked. See section 8.1.
88 This function is locked. See section 8.1.
89 Press [FUNC] key to login. See section 8.3.
90 No permission to enter to the SETUP mode. See sections 8.2 and 8.3.
91 Password is incorrect. See sections 8.2 and 8.3.
92 Press [ESC] key to change to the operation mode. Press the ESC key.
93 String including space or all space cannot be specified. Spaces are not allowed in the Web browser user
name and password.
94 More than one address cannot be specified. Only a single sender is allowed.
95 Number entered exceeds channel number range. Check the syntax of the Modbus command.
Use another command. See Communication Interface User’s Manual.
100 IP address doesn’t belong to class A, B, or C. See Communication Interface User’s Manual.
101 The result of the masked IP address is all Os or 1s. See Communication Interface User’s Manual.
102 SUBNET mask is incorrect. See Communication Interface User’s Manual.
103 The net part of default gateway is not equal to that of IP See Communication Interface User’s Manual.
address.
105 This port number is already in use. Please enter a different Enter a different port number for each function.
number.
113 Password entered is incorrect. Enter the correct password.
119 This user name is unable to use this mode. Check the user privileges on the operation.
See section 8.2.
120 Measured value is incorrect. (in ascending order) See section 3.9.
122 Measured value exceeds the range setting. See section 3.9.
125 Character entry cannot be performed. The DX is not showing a display used to enter
character strings.
126 You cannot use the same password. Specify a different password.
127 Report kind overlaps and cannot be set up. See section 9.5.
129 IP address is not set. Set the IP address of the DX.
131 You have exceeded the available channel capacity. You cannot connect more than 240 channels.
132 You have exceeded the available number of commands. The maximum number of commands that can be
sent is 16. The modules that can be set with a
single command are consecutive modules that can
be automatically set. Change the MW100 module
configuration so that there are no empty slots.
133 External I/O auto setting information is not available. Below are the possible causes. Check them.
* The MW100 is in calibration mode. Change to the
setting mode or measurement mode.
* The measurement module may not have been
detected. Perform system reconfiguration.
* There are no modules that can be automatically
set. Check the modules.
* An IP address has not been assigned to the
MW100. Set the IP address.
* The Modbus server of the MW100 is turned OFF.
Turn ON the server.
134 Auto setting has already been executed. You cannot set an MW100 that has been
automatically set.
135 External I/O cannot be found. Check the Ethernet connection.
136 External I/O start cannot be executed. The current MW100 settings do not allow the
measurement to be started. Check the settings.
137 DNS for this device is not set. Set the DNS of the DX.

11-2
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11.1 A List of Messages

Execution Errors

Code Message Explanation/Countermeasures/Ref. section
150 This action is not possible because sampling is in progress. Stop the memory sampling and then execute.
151 This action is not possible during sampling or calculating. Stop the memory sampling and then execute.
152 This action is not possible because saving is in progress. Wait until the saving is complete.

153 This action is not possible because formatting is in progress. ~ Wait until the formatting is complete.

154 Message not accepte because message limit was reached. The limit is 50 messages.

155 The message is not written while sampling is stopped. Start the memory sampling and then execute.
156 There are no channels to be saved to the memory. Set the channels to be saved.

157 This function is not possible at this time. Check the DX status.

158 Exceeds time deviation setting. See section 2.3.

159 It is outside the postscript message write-in range. See section 5.4.

Operation Errors

Errors Related to the External Storage Medium

Code Message Explanation/Countermeasures/Ref. section

200 Operation aborted because an error was found in media. Use another storage medium or format it.

201 Not enough free space on media. There is not enough free space on media or the
number of directories exceeded the limit. Use another
storage medium.See section 1.4.

202 Media is read-only. Make it writable.

210 Media has not been inserted. Insert a storage medium into the drive.

21 Media is damaged or not formatted. Use another storage medium or format it.

212 Format error. Try formatting again.

213 The file is read-only. Access another file or make the file writable.

214 There is no file or directory. Specified a file in which data is being added. Tried
to save a file which does not exists in the internal
memory.

215 Exceeded the allowable number of directories or files. Replace a storage medium. Delete unneeded files and
directories.

216 The file or directory name is incorrect. Use alphanumeric characters and symbols.

217 Unknown file type. Specify another file.

218 This directory or file now exists. Delete it or change the name. See section 6.2.

219 Invalid file or directory operation. Tried to delete multiple directory levels. Or, tried to
delete a directory containing files.

Delete the files and directories in the directory first
before executing the operation.

220 The file is already in use. Try again later. Wait until the file is accessible.

221 This action is not possible because FTP transmission is in Execute after FTP data transfer is complete.

progress.

222 Media is not recognized. Remove and reset the storage medium.

230 There is no setting file. Specify another file.

231 Abnormal setting exists in file. Specify another file.
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11.1 A List of Messages

Errors Related to the Historical Trend

232 There is no available data. Appears when displaying historical trends. Specify another

file.

233 The specified historical data do not exist. Appears when switching to historical trend from information

display. See section 4.5.
234 The specified channel is not assigned to the display group.  Appears when switching to trend, digital, or bar graph from
overview. See sections 4.4 and 7.6.
. Errors Related to E-mail and Web Server
260 IP address is not set or ethernet function is not available. The IP address is not specified.
Check the IP address.

261 SMTP server is not found. Occurs when the SMTP server is specified by

name.
» Check the DNS setting.
» Check the SMTP server name.

262 Cannot initiate E-mail transmission. » The host name of the DX is not correct. Check

the host name.
» The port number of the SMTP server is not
correct. Check the port number.

263 Sender’s address rejected by the server. Check the sender’s address.

264 Some recipients’ addresses are invalid. Check the recipients’ addresses.

265 SMTP protocol error. May occur if a network failure (cable problems,
duplicate addresses, network device failure, and so
on) occurs in the middle of the e-mail transmission.

266 Ethernet cable is not connected. Check the cable connection.

267 Could not connect to SMTP server. » Check to see that the SMTP server is connected

to the network.

+ If the SMTP server name is specified using an
IP address, check to see that the IP address is
correct.

268 E-mail transmission request failed. Contact your nearest YOKOGAWA dealer.

269 E-mail transfer error. May occur if a network failure (cable problems,
duplicate addresses, network device failure, and so
on) occurs in the middle of the e-mail transmission.

275 The current image cannot be output to the Web. The setup display cannot be output to the Web
browser. This message is displayed on the Web
browser.

276 Image data currently being created. Unable to perform key Try again a little later.This message is displayed on

operation. the Web browser.

277 Could not output screen to Web. Failed to create the image.This message is

displayed on the Web browser.

11-4
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11.1 A List of Messages

o Errors Related to FTP Client

For a description of the FTP client function of the DX, see the Communication Interface
User’s Manual (IM 04L41B01-17E). The detail code does not appear in the error message
on the screen. You can view the code on the FTP log display of the DX or using the FTP
log output via communications.

Code Message

280 IP address is not set or FTP function is not available.

Further details are provided by the character string that appears after error code 280.

Character String and Details

HOSTADDR
An IP address has not been assigned to the DX.
Check the IP address.
DORMANT
Internal processing error.”
LINK
Data link is disconnected.
Check the cable connection.

281 FTP mail box operation error.

Further details are provided by the character string that appears after error code 281.

Character String and Details

MAIL

Internal processing error.”
STATUS

Internal processing error.”
TIMEOUT

Internal processing error.™
PRIORITY

Internal processing error.”
NVRAM

Internal processing error.”

282 FTP control connection error.

Further details are provided by the character string that appears after error code 282.

Character String and Details

HOSTNAME
Failed the DNS lookup (search the IP address corresponding to the host name).
Check the DNS setting and the destination host name.
TCPIP
Internal processing error.”
UNREACH
Failed to connect to a control connection server.
Check the address setting and that the server is running.
OOBINLINE
Internal processing error.”
NAME
Internal processing error.”
CTRL
The control connection does not exist.
Check that the server does not drop the connection and that it responds within the proper
time period.
IAC
Failed to respond in the TELNET sequence.
Check that the server does not drop the connection and that it responds within the proper
time period.
ECHO
Failed to transmit data on the control connection.
Check that the server does not drop the connection and that it responds within the proper
time period.
REPLY
Failed to receive data on the control connection.
Check that the server does not drop the connection and that it responds within the proper
time period.

IM 04L42B01-01E
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11.1 A List of Messages

Character String and Details

SERVER

The server is not in a condition to provide the service.

Check that the server is in a condition in which service can be provided.

Code Message
283 FTP command was not accepted.
Further details are provided by the character string that appears after error code 283.
Character String and Details
USER
Failed to verify the user name.
Check the user name setting.
PASS
Failed to verify the password.
Check the password setting.
ACCT
Failed to verify the account.
Check the account setting.
TYPE
Failed to change the transfer type.
Check that the server supports the binary transfer mode.
CWD
Failed to change the directory.
Check the initial path setting.
PORT
Failed to set the transfer connection.
Check that the security function is disabled.
PASV
Failed to set the transfer connection.
Check that the server supports PASV commands.
SCAN
Failed to read the transfer connection settings.
Check that proper response to the PASV command is received from the server.
284 FTP transfer setting error.
Further details are provided by the character string that appears after error code 284.
Character String and Details
MODE
Internal processing error.”
LOCAL
Internal processing error.”
REMOTE
The destination file name is not correct.
Check that you have the authority to create or overwrite files.
ABORT
File transfer abort was requested by the server.
Check the server for the reason for the abort request.
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11.1 A List of Messages

Code

Message

285

FTP data connection error.
Further details are provided by the character string that appears after error code 285.

Character String and Details

SOCKET

Failed to create a socket for the transfer connection.?
BIND

Failed the transfer connection command.”
CONNECT

Failed the transfer connection.”
LISTEN

Failed the transfer connection reception.™
ACCEPT

Failed to accept the transfer connection.”
SOCKNAME

Internal processing error.”
RECV

Failed to receive data over the transfer connection.”
SEND

Failed to send data over the transfer connection.”

286

FTP file transfer error.

290

SNTP access failure.
Further details are provided by the character string that appears after error code 290.

Character String and Details

DORMANT
Internal processing error.”
LINK
Data link is disconnected.
Check the cable connection.

291

SNTP server does not respond.
Further details are provided by the character string that appears after error code 291.

Character String and Details

TIMEOUT
Check that the server is running.”

292

Incorrect SNTP server setting.
Further details are provided by the character string that appears after error code 292.

Character String and Details

HOSTNAME
Failed the DNS lookup (search the IP address corresponding to the host name).
Check the DNS setting and the SNTP server name.

TCPIP
Internal processing error.”

293

Invalid SNTP server reply.
Further details are provided by the character string that appears after error code 293.

Character String and Details

SEND
A correct IP address has not been assigned to the DX.
Check the IP address.

BROKEN
There is a problem with the SNTP server.

If this error occurs even after executing SNTP manually several times, check the SNTP

server.

IM 04L42B01-01E

Bunjooyss|qno.y H
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Code

Message

294

No time correction because excess time deviation with SNTP server.

Further details are provided by the character string that appears after error code 294.

Character String and Details

OVER
This error occurs when periodic SNTP is executed by the auto setting of the clock and
the clock is not adjusted because the time difference between the DX and the SNTP
server is greater than or equal to 10 minutes.

Check the time on the DX and the SNTP server.

295

IP address was released because DHCP setting is invalid.

Further details are provided by the character string that appears after error code 295.

Character String and Details

REJECT
Address obtained by DHCP is inappropriate.

296

DHCP access failure.

Further details are provided by the character string that appears after error code 296.

Character String and Details

ESEND

Failed to transmit to the DHCP.
ESERVER

DHCP server not found.
ESERVFAIL

No response from the DHCP server.
ERENEWED

Address renewal rejected.
EEXTENDED

Address lease extension rejected.
EEXPIRED

Address lease period expired.

297

Registration of the hostname to the DNS server failed.

Further details are provided by the character string that appears after error code 297.

Character String and Details

INTERNAL

Failed to register the host name (transmission error, reception timeout, etc.).
FORMERR

Failed to register the host name (format error: DNS message syntax error).
SERVFAIL

Failed to register the host name (server failure: DNS server processing error).
NXDOMAIN

Failed to register the host name (non existent domain).

NOTIMP

Failed to register the host name (not implemented).
REFUSED

Failed to register the host name (operation refused).
YXDOMAIN

Failed to register the host name (name exists).
YXRRSET

Failed to register the host name (RR set exists).
NXRRSET

Failed to register the host name (RR set does not exist).
NOTAUTH

Failed to register the host name (not authoritative for zone).
NOTZONE

Failed to register the host name (different from zone section).
NONAME

Host name not entered on the DX.

IM 04L42B01-01E
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Code

298

Deletion of the hostname to the DNS server failed.

Further details are provided by the character string that appears after error code 298.

Character String and Details

INTERNAL

Failed to delete the host name (transmission error, reception timeout, etc.).
FORMERR

Failed to delete the host name (format error: DNS message syntax error).
SERVFAIL

Failed to delete the host name (server failure: DNS server processing error).
NXDOMAIN

Failed to delete the host name (non existent domain).

NOTIMP

Failed to delete the host name (not implemented).
REFUSED

Failed to delete the host name (operation refused).
YXDOMAIN

Failed to delete the host name (name exists).
YXRRSET

Failed to delete the host name (RR set exists).
NXRRSET

Failed to delete the host name (RR set does not exist).
NOTAUTH

Failed to delete the host name (not authoritative for zone).
NOTZONE

Failed to delete the host name (different from zone section).
NOTLINKED

4Physical layer was disconnected when removing the host name.

Nofte

*1 Contact your nearest YOKOGAWA dealer.
*2 These errors may occur if the network experiences trouble during the data transmission
(bad cable connection, duplicate addresses, network equipment failure).

The FTP client function on the DX has a timer function that drops the connection if there is
no data transfer for two minutes. If the server does not respond within this time period, the
transfer fails.

The FTP client function on the DX overwrites files without a warning if files with the same
name exist at the transfer destination unless the server returns a negative response.

IM 04L42B01-01E

11-9

Bunjooyss|qno.y H



11.1 A List of Messages

Communication Errors

For information regarding the communication function of the DX, see the Communication
Interface User’s Manual (IM 04L41B01-17E).

. Errors during Setting and Basic Setting Modes, Output Communication
Command Execution, and Setup Data Loading

Code Message

300 Command is too long.

301 Too many number of commands delimited with ;.

302 This command has not been defined.

303 Data request command can not be enumerated with sub-delimiter.
350 Command is not permitted to the current user level.

351 This command cannot be specified in the current mode.

352 The option is not installed.

353 This command cannot be specified in the current setting.

354 This command is not available during sampling or calculating.

. Memory Access Errors during Setting and Basic Setting Modes and Output

Communication Command Execution
An English error message is returned via the communication interface. It is not displayed
on the screen.

Code Message
362 There are no data to send ‘NEXT’ or ‘RESEND’.
363 All data have already been transferred.

11-10 IM 04L42B01-01E



11.1 A List of Messages

. Maintenance and Test Communication Command Errors

An English error message is returned via the communication interface. It is not displayed

on the screen.

Code Message

390 Command error.

391 Delimiter error.

392 Parameter error.

393 No permission.

394 No such connection.

395 Use ‘quit’ to close this connection.
396 Failed to disconnect.

397 No TCP control block.

398 Format error.

. Other Communication Errors
An English error message is returned via the communication interface. It is not displayed

on the screen.

Code Message

400 Input username.

401 Input password.

402 Select username from ‘admin’ or ‘user’.

403 Login incorrect, try again!

404 No more login at the specified level is acceptable.
410 Login successful. (The special user level)

411 Login successful. (The general user level)

420 Connection has been lost.

421 The number of simultaneous connection has been exceeded.
422 Communication has timed-out.

IM 04L42B01-01E
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11.1 A List of Messages

Status Messages

Code Message

500 Execution is complete.

501 Please wait a moment...

503 Data are being saved to media...

504 File is being loaded from media...

505 Formatting...

506 Memory save to media was interrupted.

508 There is no file or directory.

509 Press [DISP/ENTER] key to display file name.
510 Range cannot be changed during sampling or calculating
511 MATH expression cannot be changed during sampling or calculating.
513 Post process in progress.

514 Now loading historical data.

515 Data save is completed.

516 Files are now being sorted.

520 Connecting to the line..

521 The data file is being transferred.

530 Media can be removed safely.

531 Media was removed compulsorily.

532 USB device has been connected.

533 USB device cannot be recognized.

534 There was no data which is not saved to media.
535 Media was recognized.

536 Media is not recognized.

542 Media read error.

543 Flash write error.

550 The A/D calibration is being executed...

551 FTP test is being executed...

552 E-mail test is being executed...

560 Now connecting to SNTP server...

561 Now adjusting the time.

11-12
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Code

Message

562

Ethernet cable is disconnected.
Further details are provided by the character string that appears after error code 562.

Character String and Details

ON

Detected that an Ethernet cable was connected.
OFF

Detected that an Ethernet cable was disconnected.

563

The command is sent to DHCP.
Further details are provided by the character string that appears after error code 563.

Character String and Details

RENEW
Requesting address renewal to the DHCP server.

564

The response was received from DHCP.
Further details are provided by the character string that appears after error code 564.

Character String and Details

RENEWED

Address renewal complete.
EXTENDED

Address release extension request complete.
RELEASED

Address release complete.

565

IP address was set.
Further details are provided by the character string that appears after error code 565.

Character String and Details

IPCONFIG
Assigned the IP address.

566

It is a setting that doesn’t register hostname to the DNS server.
Further details are provided by the character string that appears after error code 566.

Character String and Details

NOREQUEST
Configured not to register the host name.

567

The hostname was registered to DNS server.
Further details are provided by the character string that appears after error code 567.

Character String and Details

UPDATE
Registered the host name to the DNS server.

568

The hostname was deleted from DNS server.
Further details are provided by the character string that appears after error code 568.

Character String and Details

REMOVE
Assigned the IP address.
OFF
Removed the host name from the DNS server.

IM 04L42B01-01E
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11.1 A List of Messages

Warning Messages

Code Message Ref. Section
600 Measured data and Settings have been initialized. -

601 Measured data have been initialized. -

610 This usernema is already registered. See section 8.2.
614 Calibration settings are reset because of range setting change. See section 3.9
615 Noise may influence measurement in test mode. See section 3.1

System Errors
Servicing is required when a system error occurs. If this happens, contact your nearest
YOKOGAWA dealer for repairs.

Code Message

901 ROM failure.

902 RAM failure.

910 A/D memory failure for all input channels.
911 Channel 1 A/D memory failure.

912 Channel 2 A/D memory failure.

913 Channel 3 A/D memory failure.

914 Channel 4 A/D memory failure.

921 Channel 1 A/D calibration value error.
922 Channel 2 A/D calibration value error.
923 Channel 3 A/D calibration value error.
924 Channel 4 A/D calibration value error.
930 Memory acquisition failure.

940 The Ethernet module is down.
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11.2 Troubleshooting

Does not function (nothing is displayed).

Is the power switch
turned ON? Does the

Turn ON the power properly. 0.G.
switch work properly?

Is the power supply
connected properly?

Connect properly. ) 0.G.

Is the power
supplied properly?

Supply the power at the specified 0.G.
voltage and frequency.

Contact your nearest YOKOGAWA
dealer.

0.G.: Operation Guide

IM 04L42B01-01E
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11.2 Troubleshooting

¢ The error is large.
* The trend or digital values fluctuate.

¢ The trend is off the scale on either the 0% or 100% side.

Does the input meet
the specifications?

NO

YES

Is the range/span
setting appropriate?

NO

YES

Taking measures NO

against noise?

YES

Is the environmental
temperature kept constant?

NO

YES

NO

Is the input wiring correct?

YES

Is the input wiring parallel
with other equipment?

NO

Is the RJC setting correct NO

(TC input)?

YES

Contact your nearest YOKOGAWA
dealer.

Change the input to meet the
specifications.

) Section 13.1

» Adjust the span and range (section 3.3).

« If you use Calibration Correction (/CC1
option), check the set values for
correction points (section 3.9).

KSeparate the input wiring from the \
noise source.

» Ground the recorder.

» Ground the measured object properly.

* Insulate the TC from the measured object.
*» Use shielded cables for input.

» Change the integral time of the input
A/D converter (section 3.1).

YES

» Use moving average on the input

k(section 3.4). j

« Attach the input terminal cover properlﬁ

« Protect the input terminal from wind or
fans.

» Keep the temperature fluctuation near
the input terminal to a minimum.

» Wire correctly (O.G.).

« Install the terminal block correctly.

« Fasten the terminal screws correctly.
« Insulate the RTD from the ground.

« If burnt, replace the TC.

» Stop the TC burnout upscale/downscale
function of other equipment.

» Ground the DX and other equipment
at one point.

 Disconnect parallel wiring
(use a double-element TC, for instance).

Set it correctly. Section 3.2

N 7S N/

0.G.: Operation Guide
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11.2 Troubleshooting

Display and other functions do not work properly.

(Move the input and communication wires\
away from the noise source.

Taking measures

against noise?
» Ground the recorder.

» Use shielded cables for input and
communication wires.

* Insert an isolation transformer into the
power line.

YES

* Insert a power line filter into the power line.

* If an inductive load is used in the alarm
output line, insert a serge suppressor in
the line.

- /

Contact your nearest YOKOGAWA
dealer.

Some items on the display selection menu
or FUNC key menu are not displayed.

» Use the customize-menu function to show | Section 5.18
the item on the menu.

+ Confirm that the DX is equipped with the

necessary options.

Is the function of the DX
configured properly?

Contact your nearest YOKOGAWA
dealer.

Bunjooyssjqno.y H
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Chapter 12 Maintenance

12.1 Periodic Inspection

Check the operation periodically to keep the DX in good working order.

Perform the following checks and replace worn parts as needed.

 Is the display and storage functioning properly?
If not, see chapter 11, “Troubleshooting” in the DX2000 User’s Manual.

» Has the brightness of the LCD backlight deteriorated?
If replacement is necessary, see “Recommended Replacement Periods for Worn
Parts.”



12.2 Calibrating the DX

It is recommended that the DX be calibrated once a year to assure its measurement
accuracy.

Calibration service is also provided by YOKOGAWA dealers.

For details, contact your nearest YOKOGAWA dealer.

Required Instruments
Calibration instruments with the following resolution are required for calibrating the DX.

Recommended Instruments
+ DC voltage standard: 5520A by FLUKE or equivalent
Main specifications
Output accuracy: £(0.005% + 1 pV)
» Decade resistance box: Yokogawa Meters & Instruments Model 2793-01
or equivalent
Main specifications
Accuracy of output range 0.1 to 500 Q: £(0.01%
+2 mQ)
Resolution: 0.001 Q
» 0°C standard temperature device: ZC-114/ZA-10 by Coper Electronics or equivalent
Main specifications
Standard temperature stability accuracy: +0.05°C
For information on purchasing the calibration instruments, contact your nearest
YOKOGAWA dealer.

Calibration Procedure

1. Wire the DX and the calibration instrument as shown in the following figure, and
adequately warm up the instruments (the warm-up time of the DX is at least 30
minutes).

2. Check that the operating environment such as ambient temperature and humidity
is within the standard operating conditions (see section 13.6).

3. Apply appropriate input signals corresponding to 0, 50, and 100% of the input
range and calculate the errors from the readings.

If the error does not fall within the accuracy range of the specifications, contact
your nearest YOKOGAWA dealer.

Nofte
For thermocouple inputs, you must measure the temperature of the input terminal and apply a
voltage taking into account the reference junction temperature.

DC Voltage Measurement (Example for the DX2010)

Input terminal

e QO O O Q

DC voltage stan
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12.1 Calibrating the DX

Temperature Measurement When Using an RTD (Example for the DX2010)

The resistance of three lead
wires must be equal.

f =z

On
(o]i]
(@]1]
(o]i]
(o]l
o1

|I L\o%o

Decade resistance box

(Model 2793-01 from Yokogawa
Meters & Instruments Corporation)

Temperature Measurement When Using a Thermocouple (Example for the

DX2010)
Thermocouple wires or TC
Copper wires extension wires
((
! )
« «

Copper 1, < ht Thermocouple
DC voltage standard wires wires

(0 °C standard temperature device ZC-114/ZA-10 by Coper Electronics)

RJC of TC Input

As the measurement terminal of the DX is generally at room temperature, the actual
output of the thermocouple is different from the values given on the thermoelectromotive
force table based on 0°C. The DX performs compensation by measuring the temperature
at the input terminal and adding the corresponding thermoelectromotive force to the
actual output of the thermocouple. Therefore, when the measurement terminal is shorted
(equivalent to the case when the detector tip is 0°C), the measured value indicates the
temperature of the input terminal.

When calibrating the DX, this compensation voltage (thermoelectromotive force of 0°C
reference corresponding to the input terminal temperature) must be subtracted from the
output of the standard generator before application. As shown in the figure, by using the
0°C standard temperature device to compensate the reference junction at 0°C, you can
input the thermoelectromotive force of 0°C reference from the DC voltage standard and
perform the calibration.

IM 04L42B01-01E
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Chapter 13 Specifications

13.1 Signal Input and Alarm

Measurement Input

Item

Specifications

Number of inputs, scan interval, and A/D integration time

i Scan interval

Model Number of inputs Normal mode Fast sampling mode
DX2004 4 125 ms, 250 ms 25 ms
DX2008 8
DX2010 10
DX2020 20
DX2030 30 1s 125 ms
DX2040 40
DX2048 48
Integration time of the A/D converter | 60 Hz/50 Hz 60 Hz/50 Hz/100 ms 600 Hz (fixed)

Input Type

DC voltage, 1-5V, thermocouple (TC), resistance temperature detector (RTD), ON/OFF input (DI),
and DC current (by adding an external shut resistor)

Measurement range and measurable range

Input Type Range Measurable Range

DC voltage 20 mV —20.000 to 20.000 mV
60 mV —60.00 to 60.00 mV
200 mV —200.00 to 200.00 mV
2V —2.0000 to 2.0000 V
6V —6.000 to 6.000 V
20V —20.000 to 20.000 V
50V —50.00 to 50.00 V

1-5V 1-5V 0.800 to 5.200 V

Thermocouple| R 0.0 to 1760.0°C 32 to 3200°F
S 0.0 to 1760.0°C 32 to 3200°F
B 0.0 to 1820.0°C 32 to 3308°F
K" —200.0 to 1370.0°C —328 to 2498°F
E™ —200.0 to 800.0°C —328.0 to 1472.0°F
J1 —200.0 to 1100.0°C —328.0 to 2012.0°F
™ —200.0 to 400.0°C —328.0 to 752.0°F
N*1 0.0 to 1300.0°C 32 to 2372°F
W2 0.0 to 2315.0°C 32 to 4199°F
L3 —200.0 to 900.0°C —328.0 to 1652.0°F
U3 —200.0 to 400.0°C —328.0 to 752.0°F
WRe™ 0.0 to 2400.0°C 32 to 4352°F

RTD Pt (Pt100)"S —200.0 to 600.0°C —328.0 to 1112.0°F
JPt (JPt100)"5 | —200.0 to 550.0°C —328.0 to 1022.0°F

DI Level 0: Less than 2.4 V. 1: 2.4V or higher (judged at the 6 V range
Contact 0: Open. 1: Closed (parallel capacitance of 0.01 yF or less)

*1: R, S,B, K E, J, T, N: IEC584-1 (1995), DIN IEC584, JIS C1602-1995

*2: W: W-5%Re/W-26%Re (Hoskins Mfg. Co.), ASTM E988

*3: L: Fe-CuNi, DIN43710, U: Cu-CuNi, DIN43710
*4: WRe: W-3%Re/W-25%Re (Hoskins Mfg. Co.)

*5: Pt100: JIS C1604-1997, IEC751-1995, DIN IEC751-1996

JPt100: JIS C1604-1989, JIS C1606-1989
Measuring current: i = 1TmA (Pt100, JPt100)

Thermocouple burnout®

Burnout upscale/downscale selectable (for each channel).
Normal: 2 kQ or less., Burnout: 100 kQ or more (parallel capacitance of 0.01 pF or less)
Detection current: Approx. 10 pA

1-5 range burnout*

Burnout upscale/downscale selectable (for each channel).
Burnout detection: Greater than “scale upper limit + 10% of scale width* or “scale lower limit — less
than 5% of scale width“

TC reference junction compensation
Internal reference junction compensation or external reference junction compensation

Moving average function

Takes the moving average of the input values (for each channel). Moving average data points: 2 to

400

* In fast sampling mode, burnouts on all measurement channels cannot be detected within a scan interval. Burnout may not be
detected until the number of measurements indicated below is carried out if measurement is started in a burnout condition or

after a burnout occurs.
DX2004 and DX2008: Up to 4 measurements. DX2010, DX2020, DX2030, DX2040, and DX2048: Up to 2 measurements

IM 04L42B01-01E
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13.1 Signal Input and Alarm

Item

Specifications

Computation
Difference computation
Linear scaling

Square root computation

Computable range:
Computable range:
Scalable range:

Unit:
Over value detection:

Computable type:
Scalable range and unit:
Low-cut:

Over value detection:

DC voltage, TC, RTD, and DI

DC voltage, TC, RTD, and DI

—30000 to 30000. The decimal place is within 4 digits to the right
of the decimal point.

6 digits or less

The value can be set to over value when +5% of the scale range
is exceeded.

DC voltage

Same as linear scaling

Set the low-cut value in the range of 0.0% to 5.0% of the span.
Same as linear scaling

1-5V Computable range: 1-5
Scalable range and unit: Same as linear scaling
Low-cut: The low-cut point is fixed to the span lower limit.
Over value detection: Same as linear scaling
Alarms
Item Specifications
Number of alarms Up to four alarms (level) for each measurement channels
Alarm type High limit, low limit, difference high limit, difference low limit, high limit on rate-of-change alarm, low

limit on rate-of-change alarm, delay high limit, and delay low limit

Alarm delay time

1 to 3600 s (for each channel)

Rate-of-change calculation interval of rate-of-change alarms
1 to 32 times the scan interval (common to all channels)

Alarm output

Output to the internal switch
Number of internal switches: 30

Internal switch operation: AND/OR operation selectable

Hysteresis High and low limit alarm: 0.0 to 5.0% of the span (common to all channels)
Difference high and low limit alarms: 0.0 to 5.0% of the span (common to all channels)
Display Displays the status on the respective operation screen and an alarm icon on the status display

section when an alarm occurs.

Display operation: Hold or not hold the display until the alarm acknowledge operation.

Alarm hide function (alarm no logging function)
Not display alarms nor record to the alarm summary (for each channel)

Alarm information

Displays a log of alarm occurrences on the alarm summary.

13-2
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13.2 Display Function

Display

Item Specifications

Display* 10.4-inch TFT color LCD (640 x 480 dots)

Brightness 6 levels

Backlight saver function Dim or turn off the LCD backlight if there is no key operation for a specified time.

* A section of the LCD monitor may contain pixels that are always on or off. The brightness of the LCD may also not be uniform
due to the characteristics of the LCD. This is not a malfunction.

Displayed Information

Item Specifications
Display groups Assign channels to groups on the trend display, digital display, and bar graph display and display.
Number of groups 36
Number of channels that can be assigned to each group
Up to 10
Display color Channel: Select from 24 colors
Background: Select white or black
Trend display (T-Y display)
Waveform line width Select from 1, 2, and 3 dots
Display method Orthogonal axis display with time axis (T) and measured value axis (Y)
Layout: Vertical, horizontal, wide, or split

Trend interval:  Select from 15 s/div (DX2004/DX2008 only) and available settings between 30
s/div and 10 h/div.
Switchable to the secondary trend interval.

Scale Display a scale for each channel.
Current value bar graph, color scale band, and alarm point marks can be displayed on the scale.
Others Grid (divisions: 4 to 12), trip line (line width: 1, 2, or 3 dots), message, zone display, and partial

expanded display
Trend display (circular display)
Display method Time axis: Circle, Measured value axis: Perimeter
Time per revolution: Select from the available settings between 20 min and 4 weeks (20 min
available only on the DX2004 or DX2008).

Digital Display Displays measured values numerically
Update rate 1 s (scan interval if the scan interval is greater than 1 s)
Bar graph display Displays the measured value on a bar graph
Direction Vertical or horizontal
Base position End or center
Update rate 1 s (scan interval if the scan interval is greater than 1 s)
Scale Display a scale for each channel

Color scale band, and alarm point marks can be displayed on the scale.
Historical trend display (T-Y display)
Redisplays the display data or event data in the internal memory or external storage medium.

Display format All screen or half screen (only when the display data is being redisplayed)
Time axis operation Reduce/expand and continuous data display possible.
Add message Messages can be added.
Background color Select from white, cream, black, or light gray.
Historical display (circular display)
Display format Full circle display and quarter cycle display
Others Same as the historical trend display (T-Y display)
Overview Display Displays the measured values of all channels and the alarm statuses (if the number of channels

exceeds 261, the measured values are not displayed.).
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13.2 Display Function

Item

Specifications

Information display
Alarm summary display

Message summary display

Memory summary display

Report
Status Display

Displays a log of up to 1000 alarms.
Specify an alarm with the cursor and jump to the corresponding section on the trend display.

Time and content of up to 450 messages (including 50 add messages)

Specify a message with the cursor and jump to the corresponding section on the trend display.
Displays the information of the data in the memory.

Specify a file with the cursor and jump to the corresponding section on the trend display.

Save the data in the internal memory to the external storage medium using keys.

Displays the report data residing in the internal memory.

Relay status display: Displays the ON/OFF status of the alarm output relay and internal
switch.
Modbus client status: Displays the communication status on the Modbus client

Modbus master condition:  Displays the communication status on the Modbus master

Log display

Displays the login log, error log, communication log, FTP log, Web log, e-mail log, SNTP log,
DHCP log, and Modbus log.

Four panel display

Divides the screen into four sections and displays four different display formats.

Four combinations of screens can be registered.

Other Displayed Information

Item Specifications
Tag display Up to 16 alphanumeric characters
Message Write messages to the trend display.
Number of messages 100
Character Up to 32 alphanumeric characters

Write method
Write destination
Auto message

Write a preset message or write an arbitrary message on the spot.

Select only the displayed group or all groups.

Write a message when the DX recovers from a power failure while memory sampling is in
progress.

Write a message when the trend interval is switched during memory sampling.

Add message
Number of messages

Write messages to the past data positions.
50

Status display section
Displayed contents

Displays the DX status at the upper section of the display.

Year, month, day, time, displayed group name/display name, user name (when using the login
function), batch name (when using the batch function), internal memory status, external storage
medium status, alarm status, and function usage status (key lock , computation function, and
e-mail)

Auto switching of displayed groups

Switches the display group at a given interval.
Interval: Select from the available settings between 5 s and 1 min.

Auto recovery display

Specify the display to be shown automatically when keys are not operated.
Time until the display switches: Select from the available settings between 1 min and 1 h.

Favorite display

Register frequently used displays to the Favorite key and show them through simple operation.
Up 8 displays can be registered.

Language

Select English, Japanese, German, French, or, Chinese.

System information display

Displays the number of measurement, computation, and external input channels, options, remote
controller ID, MAC address, firmware version, and internal memory capacity.

Network information display

Displays the DX network setup information.

Display selection menu customization

Show/hide and change the positions of each item in the display selection menus and sub menus
Insert/delete separators.

FUNC key menu customization

Show/hide and change the display positions of each item.
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13.3 Data Saving Function

Configuration

Item Specifications

Internal memory Temporarily saves various types of data.
Medium Flash memory

External storage medium
Medium CF card (up to 2 GB)
Format FAT32 or FAT16

Data Type

Name Description

Data type (file name extension)
Display data (.dad), event data (.dae), and manual sampled data (.dam)
Screen image data (.png), setup data (.pdl), report data (.dar) (/M1)

Display Data and Event Data

Item Specifications

Internal memory
File storage capacity 80 MB (standard memory) or 200 MB (large memory)

Number of files Up to 400
Operation FIFO (First In First Out)
Display data

Target Measurement/computation/external input channel

Sampling interval Synchronized to the trend interval.

Description Maximum or minimum value per sampling interval

Data size Measurement/External input channel data: 4 bytes/data value. Computation channel data: 8 bytes/
data value.

File size Up to 8 MB

Data format Binary

Recording Records data at all times.

Event data

Target Measurement/computation/external input channel.

Sampling interval Select from the available settings between 25 ms to 600 s.

Description Data per sampling interval

Data size Measurement/External input channel data: 2 bytes/data value. Computation channel data: 4 bytes/
data value.

File size Up to 8 MB

Data format Binary

Mode Free: Records data at all times.

Trigger: Starts recording data when a certain event occurs and records for the specified interval.

Combinations of saved data
Display data only, event data only, or display data and event data

File size See appendix 1.
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13.3 Data Saving Function

Manual Sampled Data

Item

Specifications

Item

Data format

Measured value at an arbitrary time
Specify up to 120 channels when external input channels (/MC1) are used.
ASCII

Maximum number of data values that the internal memory can store

400

Report Data (/M1)

Item

Specifications

Item
Data format

Report at each scheduled time of report
ASCII

Maximum number of reports that the internal memory can store

100

Saving Data to the External Storage Medium

Item Specifications
Data Saving Saves the data in the internal memory to the external storage medium.
Manual save Saves when the external storage medium is inserted with a key operation.
Auto save Display data: Every file save interval
Event data: Every data length

Auto save operation

Manual sampled data: When manual sampling is executed.
Report data: When report is created.

Select “save data only if there is sufficient free space on the CF card” or “constantly retain the most
recent data files in the CF card (media FIFO)” (release number 2 or later).

File name

Select from “sequence number+user-assigned string+date,” “sequence number+user-assigned
string,” or “sequence number+batch name.”

Save destination

Auto save: CF card. Manual save: CF card or USB flash memory (/USB1)
Directory name: Specify using up to 20 characters.

Snapshot Data

Item

Specifications

Item Displayed screen image data
Data format PNG

Output destination CF card or communication output
Setup Data

Item Specifications

Item DX setup data

Data format Binary

File name Specify using up to 32 characters.

Output destination
Load

CF card or USB flash memory (/USB1)
Loadable from a CF card or USB flash memory (/USB1)

Data File Loading

Item Specifications

Function Load and show the display data or event data in a CF card or USB flash memory (/USB1).
Miscellaneous

Item Specifications

Header comment

Add up to 50 characters of comment to display data, event data, manual sampled data, or report
data file.
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13.4 Other Standard Functions

Event Action Function

Item Specifications
Event action Execute a specified operation when a given event occurs.
Number of settings 40
Events Remote control input, etc.
Timer Number of timers: 4
Match time timer Number of timers: 4
Action Specify memory start/stop, alarm ACK, etc.

There are limitations on the combinations of events and actions.

Security Function

Item Specifications
Key lock function Limitations to key operation, access to the external storage medium, and various operations
Login function Allow DX operation to registered users.

System administrators 5 administrators

Users 30 users

Time Related Functions

Item Specifications
Clock With a calendar function
Accuracy +10 ppm (0 to 50°C), excluding a delay (of 1 second, maximum) caused each time the power is
turned on.
Time setting Using key operation, communication command, event action function, or SNTP client function

Time adjustment method
While memory sampling  Corrects the time by 40 ms for each second.
Limit in which the time is gradually adjusted: Select from the available settings between 10 s and
5 min.
If the time is outside the limit, the time is immediately corrected.
Cannot be used after hour 0 on January 1st, 2038.
While memory is stopped Immediately change the time.

DST The date/time for switching between standard time and DST can be specified.
Time zone Sets the time difference from GMT.
Date format Select YYYY/MM/DD, MM/DD/YYYY, DD/MM/YYYY, or DD.MM.YYYY.

Types of Characters That Can Be Handled
Item Specifications
Characters Alphabet characters, numbers, and symbols (limitation exists)
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13.4 Other Standard Functions

Communication Functions
Item Specifications
Electrical and mechanical specifications
Conforms to IEEE 802.3 (Ethernet frames conform to the DIX specification).

Medium Ethernet (10BASE-T)
Implemented protocols TCP, IP, UDP, ICMP, ARP, DHCP, HTTP, FTP, SMTP, SNTP, Modbus, and DX-dedicated protocols
E-mail client Automatically send e-mail at specified times.
FTP client Automatically transfer data files to the FTP server.
Applicable files: Display data, event data, screen image data, and report data
FTP Server Transfer files, delete files, manipulate directories, and output file lists of the DX.
Web server Shows the DX display on a Web browser.
SNTP client Inquires the time to the SNTP server and sets the DX.
Cannot be used after hour 0 on January 1st, 2036.
SNTP server Outputs the DX time.

Time resolution: 5 ms
Cannot be used after hour 0 on January 1st, 2036.

DHCP client Automatically obtain the network address settings from the DHCP server.
Modbus client Reads data from another device and writes to the registers.
Modbus server Outputs the DX data.

Setting/Measurement server

Operate, set, and output data of the DX using a dedicated protocol.
Maintenance/test server Outputs connection information and network information.
Instrument information server

Outputs information (serial number, model name, etc.) of the connected DX.

Batch Function

Item Specifications
Function Data management using batch names. Enter text fields and batch comments in the data file.
Batch name Added to the file name of the display data and event data.
Structure Batch number (up to 32 characters) + lot number (up to 8 digits)
Text field Adds text to the display data and event data.
Batch comment Adds text to the display data and event data.
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13.5 Options

Alarm Output Relay (/A1, /A2, /A3, /A4, and /A5)

Item Specifications

Action Outputs relay contact signals from the terminals on the rear panel when alarms occur.
Number of outputs 2 outputs (/A1), 4 outputs (/A2), 6 outputs (/A3), 12 outputs (/A4), and 24 outputs (/A5)
Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)

Output format NO-C-NC

Relay operation Energized/deenergized, AND/OR, hold/non-hold, and reflash settings are selectable.

RS-232 Interface (/C2) and RS-422A/485 Interface (/C3)

Item Specifications

Connection EIA RS-232(/C2) or EIA RS-422A/485(/C3)
Protocol Dedicated protocol or Modbus protocol
Synchronization Start-stop synchronization

Transmission mode (RS-422A/485)
Four-wire half-duplex multi-drop connection (1:N (N = 1 to 32))

Data rate 1200, 2400, 4800, 9600, 19200, or 38400 bps
Data length 7 or 8 bits
Stop bit 1 bit
Parity Odd, even, or none
Handshaking Off:Off, XON:XON, XON:RS, and CS:RS
Communication distance (RS-422A/485)
1200 m
Modbus communication Operation modes: Master or slave
VGA Output (/D5)
Item Specifications
External display Resolution: 640 x 480 dots (VGA)

Connector: 15-pin D-Sub

FAIL/Status Output Relay (/F1)

Item Specifications
FAIL output Relay contact output on CPU error
Relay operation Energized during normal operation and de-energized on system error.
Status output Output a relay contact signal when a selected condition occurs.
Relay operation Relay is energized when a condition occurs.
Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)

FAIL/Alarm Output Relay 22 Outputs (/F2)

Item Specifications
FAIL/status output Same as /F1
Alarm output relay Number of outputs: 22. Same as /A[ ] for other specifications.

Clamped Input Terminal (Detachable) (/H2)

Item Specifications

Input terminal Make the input section clamp input terminals (detachable).
Recommended wire size: 0.08 to 1.5 mm? (AWG 28 to 16)
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13.5 Options

Desktop Type (/H5[ ])

Item

Specifications

Construction

With carrying handle.

/H5D, /H5F, /H5R, /H5J, /H5H: Power Inlet connector. With a power cord.

/H5: Can only be specified when /P1 is simultaneously specified. Screw type power terminal.
Without power cord.

Computation Function (including the report function) (/M1)

Item

Specifications

Number of computation channels

DX2004 and DX2008: 12 channels (101 to 112)
DX2010, DX2020, DX2030, DX2040, and DX2048: 60 channels (101 to 160)

Operation

General arithmetic operations:  Four arithmetic operations, square root, absolute, common
logarithm, natural logarithm, exponential, and power

Relational operations: <, <> 2 = and #

Logic operations: AND, OR, NOT, and XOR
Statistical operations: TLOG or CLOG

Special operations: PRE, HOLD, RESET, and CARRY
Conditional operation: [a?b:c]

Computation accuracy

Double-precision floating point for TLOG.SUM and single-precision floating point for all other
computations

Data that can be used
Channel data
Constants
Communication input data
Remote control input status
Pulse input
Status input

Measurement, computation, and external input channels (/MC1)
60 constants

60

0/1 (/R1)

Counts the number of pulses (/PM1)

Internal switch, alarm output relay (/A[ ]), and flags

Rolling average

Performs moving average on the computed results.

Measurement range

—9999999 to 99999999
Decimal place: 0 to 4 digits to the right of the decimal point

Alarms High limit, low limit, delay high limit, and delay low limit
Hysteresis: High and low limit alarm: 0.0% to 5.0% of the span.

Display Same as the measurement channels

Data saving Same as the measurement channels

Report function

Number of report channels

DX2004 and DX2008: 12

DX2010, DX2020, DX2030, DX2040, and DX2048: 60
Computation types: Average, maximum, minimum, sum, or instantaneous value
Report types: Hourly, daily, hourly + daily, daily + weekly, daily + monthly

Cu10, Cu25 RTD Input/3 Leg Isolated RTD Input (/N1)

Item Specifications
Measurement/display accuracy Under standard operating conditions
Input Type Measurement | Accuracy Measurement Accuracy Max.
Range Guaranteed A/D integration time: A/D integration time: | Resolution
Range 16.7 ms or more 1.67 ms
Cu10 (GE) —70to 170°C
Cu10 (L&N) —75 to 150°C
Cu10 (WEED) —200 to 300°C |-200 to 260°C (0.4% of rdg + 1.0°C) (0.8% of rdg + 5.0°C)
Cu10 (BAILEY) —328 to 572°F 0.1°C
Cu10: a = 0.00392 at 20°C _200 to 300°C
Cu10: a = 0.00393 at 20°C
Cu25: a =0.00425 at 0°C (0.3% of rdg + 0.8°C) (0.5% of rdg + 2.0°C)

* Measuring currenti = 1 mA

Input source resistance

1 Q or less per wire (The resistance of all three wires must be equal).

Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater)

Input source resistance

+(0.2% of range + 2 digits) or less

With variation of 1 Q per wire (resistance of all three wires must be equal): +(0.1% of rdg + 1
digit) or less

With maximum difference of 40 mQ between wires: Approx. 1 °C
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13.5 Options

3 Leg Isolated RTD Input (/N2)

Item Specifications
Input terminal Isolated on each channel.
Applies to DX2010, DX2020, DX2030, DX2040, and DX2048

Extended Input Type (/N3)

Item Specifications
Measurement/display accuracy
Under standard operating conditions

Input Type Measurement Range Measurement Accuracy Max.
AID integration time: A/D integration time: | Reso-
16.7 ms or more 1.67 ms lution
Kp vs Au7Fe 0.0to 300.0 K 0to20K Within 4.5 K Within 13.5 K
20 to 300 K Within 2.5 K Within 7.5 K 01K
PLATINEL 0.0 to 1400.0°C |32 to 2552°F (0.25% of rdg + 2.3°C) (0.25% of rdg + 8.0°C)
PR40-20 0.0 to 1900.0°C |32 to 3452°F 0 to 450°C Accuracy not guaranteed [Accuracy not guaranteed
450 to 750°C  |(0.9% of rdg + 3.2°C) |(0.9% of rdg + 15.0°C)
TC 750 to 1100°C__ |(0.9% of rdg + 1.3°C) |(0.9% of rdg + 6.0°C)
1100 to 1900°C  |(0.9% of rdg + 0.4°C) |(0.9% of rdg + 3.0°C)
NiNiMo 0.0 to 1310.0°C  [32 to 2390°F (0.25% of rdg + 0.7°C) (0.5% of rdg + 3.5°C) 0.1°C
W/WRe26 0.0 to 2400.0°C |32 to 4352°F 0 to 400°C 15.0°C 30.0°C ’
400 to 2400°C  |(0.2% of rdg + 2.0°C) |(0.4% of rdg + 4.0°C)
Type N (AWG14) |0.0 to 1300.0°C |32 to 2372°F (0.2% of rdg + 1.3°C) (0.5% of rdg + 7.0°C)
Pt50 —200.0 to 550.0°C|-328.0 to 1112.0°F | (0.3% of rdg + 0.6°C) (0.6% of rdg + 3.0°C)
Ni100 (SAMA)  |-200.0 to 250.0°C|-328.0 to 482.0°F |(0.15% of rdg + 0.4°C) (0.3% of rdg + 2.0°C)
Ni100 (DIN) —60.0 to 180.0°C |-76.0 to 356.0°F | (0.15% of rdg + 0.4°C) (0.3% of rdg + 2.0°C)
Ni120 —70.0 to 200.0°C |-94.0 to 392.0°F (0.15% of rdg + 0.4°C) (0.3% of rdg + 2.0°C)
RTD* |J263*B 0.0to 300.0 K Oto40K Within 3.0 K Within 9.0 K
40 to 300 K Within 1.0 K Within 3.0 K 01K
Cu53 -50.0 to 150.0°C |-58.0 to 302.0°F (0.15% of rdg + 0.8°C) (0.3% of rdg + 4.0°C)
Cu100 —50.0 to 150.0°C |-58.0 to 302.0°F (0.2% of rdg + 1.0°C) (0.4% of rdg + 5.0°C) 0.1°C
Pt25 —200.0 to 550.0°C|-328.0 to 1022.0°F | (0.15% of rdg + 0.6°C) (0.3% of rdg + 3.0°C)

* Measuring currenti = 1 mA
Input source resistance Thermocouple input: 2kQ orless
RTD input:1 Q or less per wire (The resistance of all three wires must be equal).

Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater)

TC input +(0.1% of rdg + 0.05% of range) or less, excluding the error of reference junction compensation
RTD input 1(0.2% of range + 2 digits) or less
Input source resistance
TC input With variation of +1 kQ: +10 pV or less
RTD input With variation of 1 Q per wire (resistance of all three wires must be equal): +(0.1% of rdg + 1

digit) or less
With maximum difference of 100 mQ between wires:Approx. 1 °C

Remote Control (/R1)

Item Specifications
Number of input terminals 8
Input type Isolated from the main circuitry through a photocoupler, built-in isolated power supply for the input

terminals, and shared common.
Input type and signal level
Voltage-free contact
Open collector
Allowable input voltage
Signal type
Action

Contact closed at 200 Q or less and contact open at 100 kQ or greater.

ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or less
5VDC

Level or edge (250 ms or more)

Executes a specified action by applying a given signal to the remote signal input terminal.

Action type: Action of the event action function

suoneoioadg
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13.5 Options

24 VDC Transmitter Power Supply (/TPS4 and /TPS8)

Item Specifications

Number of loops 4 (/TPS4) or 8 (/TPS8)

Output voltage 22.8 to 25.2 VDC (under rated load current)

Rated output current 4 to 20 mADC

Max. output current 25 mADC (overcurrent protection operation current: approx. 68 mADC)

Allowable conductor resistance
RL < (17.8 — minimum transmitter operation voltage)/0.02 A

where 17.8 V is the result obtained by subtracting the maximum drop voltage of 5 V when the
load shunt resistance is 250 Q from the minimum output voltage of 22.8 V

Max. length of wiring 2 km (when using the CEV cable)
Insulation resistance 20 MQ or more at 500 VDC between output terminal and ground
Dielectric strength 500 VAC (50/60 Hz, | = 10mA) for one minute between output terminal and ground

500 VAC (50/60 Hz, | = 10mA) for one minute between output terminals

Easy Text Entry (/KB1 and /KB2)
Item Specifications
Remote control terminal (438227)

Operating temperature range

0 to 40°C
Operation humidity range  20% to 80% RH (at 5 to 40°C no condensation)
Power supply 3 VDC AA dry batteries x 2
Weight Approx. 60 g (excluding the batteries)
External dimensions 170 (H) x 50 (W) x 23.7 (D) mm
Signal Infrared

Combination with the DX
Number of units that can be controlled individually
Up to 32 units by setting the ID number
Communication distance  Up to 8 m from the front of the light receiving section of the DX (reference value)*
Directional characteristics
See the figure below (reference characteristics)*
* Varies depending on the operating environment such as the battery voltage and the presence
or absence of external light.
Standard accessories (/KB1)
Remote control unit, two alkaline dry batteries, and ID number label

Horizontal Vertical
0° 0°

30 ° 30° 30° 30°

15 10 5 11 5 10 15 15 10 5 11 5 10 15
Distance (m) Distance (m)

USB Interface (/USB1)

Item Specifications

USB port Complies with Rev. 1.1 and host function

Number of ports 2 (one each on the front panel and rear panel)

Power supply 5V +10% , 500 mA (per port)
Devices which need more than 500 mA total bus power for 2 ports can not be connected at the
same time.

Connectable devices Only connect the devices listed below to prevent damage to the devices.

Keyboard Complies with HID Class Ver. 1.1

104 keyboard (US) and 109 keyboard (Japanese)
Number connectable units: 1
External medium USB flash memory (up to 2 GB)
Does not guarantee the operation of all USB flash memories.
External medium such as a hard disk, ZIP, MO, and optical discs are not supported.
Number connectable units: 1
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Pulse Input (/PM1)

Item Specifications
Pulse input
Number of inputs 3 (8 when using the remote control input terminals)
Input type Isolated from the main circuitry through a photocoupler and built-in isolated power supply for the

input terminals.
Shared common for pulse inputs.
Input type and signal level Voltage-free contact Contact closed at 200 Q or less and contact open at 100 kQ or greater

Open collector  ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when
OFF: 0.25 mA or less

Counting Counts the rising edges of pulses.
For voltage-free contact input: Contact open to contact close
For open collector: Voltage level of the terminal H from high to low

Allowable input voltage 30 vDC

Max. sampling pulse period 100 Hz

Minimum detected pulse width

5 ms or more for both low (closed) and high (open)

Pulse detection period Approx. 3.9 ms (256 Hz)

Pulse measuring accuracy ~ +1 pulse
Remote control Number of inputs: 5. Same as remote control (/R1) for the other specifications
Computation function Same as the computation function (/M1)

Calibration Correction (/CC1)

Item Specifications
Calibration correction method

Corrects the measured value of each channel using segment linearizer approximation.
Number of segment points: 2 to 16 (including the start and end points)

External Input Function (/MC1)

Item Specifications

Function Loads data from other instruments using the Modbus client or Modbus master function and
displays, records, and saves the data.

Number of channels 240 channels (201 to 440)

Display Same as the measurement channels

Data saving Same as the measurement channels

Manual sample Specify up to 120 channels from measurement, computation, and external input channels.

DC/AC 24 V power supply (/P1)
Item Specifications
Rated supply voltage 24 VDC and 24 VAC (50/60Hz)
Allowable power supply voltage range
21.6V to 26.4 VDC/AC

Insulation resistance Between power terminal and earth: 20 MQor greater at 500 VDC.
Withstand voltage Between power terminal and earth: 500 VAC at 50/60 Hz for one minute
Rated power supply frequency (for AC)

50/60 Hz

Allowable power supply frequency range (for AC)
50 Hz+2%, 60 Hz+2%
Power supply fluctuation (for AC)
With variation within 21.6 to 26.4 VDC/AC: +1digit or less
With variation of +2 Hz from rated power supply frequency (at 24 VAC): £(0.1% of rdg+1digit) or
less
Rated power consumption 45 VA (for DC), 70 VA (for AC)
Power consumption

Supply voltage LCD backlight off Normal Maximum
24 VDC 12 VA 20 VA 45 VA
24 VAC (50/60Hz) 20 VA 34 VA 70 VA

IM 04L42B01-01E 13-13

suoneoyoadg H



13.6 General Specifications

Construction

Item Specifications

Mounting Flush panel mounting (on a vertical plane) (excluding the desktop type)

Mounting angle Inclined backward up to 30 degrees from a horizontal plane.

Allowable panel thickness 21026 mm

Material Case: Metal plate
Bezel and display cover:  Polycarbonate

Color Case: Grayish blue green (Munsell 2.0B5.0/1.7 or equivalent)
Bezel:  Charcoal gray light (Munsell 10B3.6/0.3 or equivalent)

Front panel Water and dust proof: Complies with IEC529-1P65 and NEMA No.250 TYPE 4 (except External
Icing Test) (Style number 2 or later), except for side-by-side mounting

External dimensions 288(W) x 288(H) x 226(D) mm (D: depth from the panel mounting plane)

Weight DX2004 and DX2010: Approx. 6 kg. DX2008 and DX2020: Approx. 6.3 kg. DX2030: Approx. 6.9

kg, DX2040 and DX2048: Approx. 7.3 kg excluding options

Normal Operating Conditions

Item Specifications

Supply voltage 90 to 132, 180 to 250 VAC

Power supply frequency 50 Hz + 2%, 60 Hz + 2%

Ambient temperature 0to 50°C

Ambient humidity 20 to 80%RH (at 5 to 40°C), 10 to 50% (at 40 to 50°C)

Vibration 10 to 60 Hz, 0.2 m/s’

Shock Not allowed

Magnetic field 400 A/m or less (DC and 50/60 Hz)

Noise Normal mode (50/60 Hz)
DC voltage The peak value including the signal must be less than 1.2 times the measuring range.
Thermocouple The peak value including the signal must be less than 1.2 times the measuring thermal electromotive force.
RTD 50 mV or less
Common mode noise 250 VACrms or less for all ranges (50/60 Hz)

Maximum noise voltage between channels
250 VACrms (50/60 Hz) or less

Mounting position Can be inclined up to 30 degrees backward. Left and right horizontal.
Warm-up time At least 30 minutes after power on

Installation location Indoors

Operating altitude 2000 m or less

Power Supply

Item Specifications

Rated supply voltage 100 to 240 VAC

Allowable power supply voltage range
90 to 132, 180 to 264 VAC
Rated power supply frequency 50 Hz to 60 Hz

Power consumption Supply voltage LCD backlight off Normal Maximum
100 VAC 28 VA 42 VA 74 VA
240 VAC 38 VA 54 VA 100 VA
Allowable interruption time Less than 1 cycle of the power supply frequency
Isolation
Item Specifications
Insulation resistance Between the Ethernet, RS-422A/485, and insulation terminals and earth: 20 MQ or greater at 500 VDC
Withstand voltage Between the power terminal and earth: 2300 VAC at 50/60 Hz for one minute
Between the contact output terminal and earth: 1600 VAC at 50/60 Hz for one minute
Between the measurement input terminal and earth: 1500 VAC at 50/60 Hz for one minute
Mutually between measurement input terminals: 1000 VAC (50/60 Hz) for one minute (excluding the

RTD input terminal of DX2010, DX2020, DX2030,
DX2040, and DX2048)

Between the remote input terminal and earth: 1000 VDC for one minute
Between the pulse input terminal and earth: 1000 VDC for one minute
Ground Grounding resistance: 100 Q or less
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13.6 General Specifications

Transport and Storage Conditions

Item

Specifications

Ambient temperature

Ambient humidity
Vibration
Shock

-251t0 60°C
5 to 95%RH (no condensation)
10 to 60 Hz, 4.9 m/s? maximum

392 m/s? maximum (in packaged condition)

Supported Standards

Item Specifications

CSA CSA22.2 No.61010.1, installation category I, and pollution degree 2
uL UL61010B-1 (CSANRTL/C)

CE

EMC directive

Low voltage directive

C-Tick

EN61326 compliance (Emission: Class A, Immunity: Annex A)

EN61000-3-2 compliance
EN61000-3-3 compliance
EN55011 Class A Group 1

EN61010-1, measurement category I, pollution degree 2
AS/NZS CISPR11 compliance, Class A Group 1

*1 Installation category (overvoltage category) II: Describes a number which defines a transient overvoltage condition. limplies
the regulation for impulse withstand voltage. “II” applies to electrical equipment which is supplied from the fixed installation

like a distribution board.

*2 Pollution degree 2: Describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface
resistivity is adhering. “2” applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.

*3 Measurement category Il: Applies to measuring circuits connected to low voltage installation, and electrical instruments
supplied with power from fixed equipment such as electric switchboards.

Standard Performance

Item

Specifications

Measurement/display accuracy

Standard operating conditions:
Temperature:
Humidity:
Power supply voltage:
Power supply frequency:
Warm-up time:

23+2°C

55% + 10%RH

90 to 132 or 180 to 250 VAC
50/60 Hz + 1%

At least 30 minutes.

Other ambient conditions such as vibration should not adversely affect the operation.

Input Type Range Measurement Accuracy (Digital Display) Max. Resolution of
A/D integration time: 16.7 ms or more A/D integration time: 1.67 ms Digital Display
20 mV (0.05% of rdg + 12 digits) (0.1% of rdg + 40 digits) 1uv
gg Omn\'I/V (0.05% of rdg + 3 digits) (0.1% of rdg + 15 digits) 18 E\\;
2V (0.05% of rdg + 12 digits) (0.1% of rdg + 40 digits) 100 pVv
DC voltage 15V T mv
2(:/\/ (0.05% of rdg + 3 digits) (0.1% of rdg + 15 digits) 1 zx
50 V 10 mV
R (0.15% of rdg + 1°C) (0.2% of rdg + 4°C)
R,S 0to 100°C: 3.7°C, R,S 0to 100°C: 10°C,
S 100 to 300°C: 1.5°C 100 to 300°C: 5°C
B 400 to 600°C: 2°C, B 400 to 600°C: 7°C,
B Accuracy not guaranteed for Accuracy not guaranteed for
values less than 400°C values less than 400°C
K (0.15% of rdg + 0.7°C) (0.2% of rdg + 3.5°C)
Thermocouple —200 to —100°C: (0.15% of rdg + 1°C) —200 to —100°C: (0.15% of rdg + 6°C)
(excluding E (0.15% of rdg + 0.5°C) (0.2% of rdg + 2.5°C)
RJC J —200 to —100°C: (0.15% of rdg + 0.7°C) —200 to —100°C: (0.2% of rdg + 5°C) 0.1°C
accuracy) T
N (0.15% of rdg + 0.7°C) (0.3% of rdg + 3.5°C)
W (0.15% of rdg + 1°C) (0.3% of rdg + 7°C)
L (0.15% of rdg + 0.5°C) (0.2% of rdg + 2.5°C)
U —200 to —100°C: (0.15% of rdg + 0.7°C) —200 to —100°C: (0.2% of rdg + 5°C)
WRe (0.2% of rdg + 2.5°C) (0.3% of rdg + 10°C)
0 to 200°C: 4.0°C 0 to 200°C: 18.0°C
RTD P00 15 15% of rdg + 0.3°C) (0.3% of rdg + 1.5°C)
JPt100

IM 04L42B01-01E
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13.6 General Specifications

Item

Specifications

Measuring accuracy in case of scaling

Accuracy during scaling (digits) = measurement accuracy (digits) x multiplier + 2 digits (rounded up)
*  Fractions rounded up
where the multiplier = scaling span (digits)/measuring span (digits).
Example  For 1-5 V range (A/D integration time is 16.7 ms or more), measurement span of 1.000 to
5.000 V, and scaling span of 0.000 to 2.000
The measuring accuracy for 5 V input is as follows.
Measuring accuracy (1-5 Vrange) =+(0.05% x 5 V + 3 digits) = £(0.0025 V [3 digits] + 3
digits) = 16 digits
Multiplier = {2000 digits (0.000 to 2.000)}/4000 digits (1.000 to 5.000) = 0.5
Thus, accuracy during scaling = £(6 x 0.5 + 2) digits = 5 digits (rounded up)

Reference junction compensation accuracy

Maximum input voltage
Input resistance

Input source resistance
Volt, TC
RTD input

Bias current

When measuring temperature greater than or equal to 0 °C and when input terminal temperature is balanced
Type R, S, B, W, WRe: +1.0°C

Type K, J, E, T, N, L,and U: +0.5°C. Type B: Internal reference compensation is fixed to 0°C

160 VDC (continuous)

200 mV range or less and TC: 10 MQ or more

2V range or higher: Approx. 1 MQ

2 kQ orless
10 Q or less per wire (The resistance of all three wires must be equal).
10 nA or less (except when burnout detection function is enabled)

Maximum common mode noise voltage

250 VACrms (50 Hz/60 Hz)

Maximum noise voltage between channels

250 VACrms (50 Hz/60 Hz)

Interference across channels

120 dB (when the input source resistance is 500 Q and the input to other channels is 60 VDC)

Common mode rejection ratio
When the A/D integration time is 20 ms

120 dB (50 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)

When the A/D integration time is 16.7 ms

120 dB (60 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)

When the A/D integration time is 1.67 ms

80 dB or higher (50/60 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)

Normal mode rejection ratio
When the A/D integration time is 20 ms

40 dB or more (50/60 Hz + 0.1%)

When the A/D integration time is 16.7 ms

40 dB or more (60 Hz + 0.1%)

When the A/D integration time is 1.67 ms

Not reject 50/60 Hz

13-16
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13.6 General Specifications

Effects of Operating Conditions

Item

Specifications

Ambient temperature (applies when the A/D integration time is 16.7 ms or greater)
DC voltage, TC range With temperature variation of 10°C: +£(0.1% of rdg + 0.05% of range) or less

RTD range
Power supply fluctuation

Magnetic field
Input source resistance
DC voltage range

TC range
RTD range (Pt100)

Effects of vibration

* Excluding the error of reference junction compensation

+(0.1% of rdg + 2 digits) or less

With variation within 90 to 132 V and 180 to 250 VAC (50/60 Hz):
Accuracy specifications are satisfied.

With variation of +2 Hz from rated power frequency (power supply voltage 100 VAC):
Accuracy specifications are satisfied.

AC (50/60 Hz) and DC 400 A/m fields:+(0.1% of rdg + 10 digits) or less

With variation of +1 kQ:
200 mV range or less: 10 pV or less
2V range or higher:  +0.15% of rdg or less
With variation of +1 kQ: +10 pV or less
With variation of 10 Q per wire (resistance of all three wires must be equal): £(0.1% of rdg + 1 digits)
orless
With maximum difference of 40 mQ between wires: Approx. 0.1 °C
Effects from a sinusoidal vibration along all three axis at a frequency between 10 to 60 Hz and an
acceleration of 0.2 m/s: +(0.1% of rdg + 1 digit) or less

Miscellaneous

Item

Specifications

Memory backup

A built-in lithium battery backs up the settings and runs the clock
Battery life: Approximately 10 years (at room temperature)

IM 04L42B01-01E
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13.7 External Dimensions

See the DX2000 Operation Guide (IM04L42B01-02E).
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Appendix

Appendix 1 File Size of Display Data and Event Data

File Size

This section explains how to calculate the file size of display data files and event data
files. The calculation examples are given for the display data only and event data only
cases. If you are recording both display and event data, calculate the data size of each
and add them together.

Use the calculated file size as a rough guide.

A file consists of the following data.
Information other than the sampled data + the sampled data

Size of Information Other Than the Sampled Data

Item Size [Bytes]
File header 216
Channel information |88xN + 28

Group information

96x36 + 28 = 3,484

Message information

104*50 + 28 (an add message area is reserved by default)

Batch information

832

Sampled data header

80+32+Nx4+2+18

Message information

Up to 104x1050 (varies depending on the number of messages)

Alarm information

Up to 32x5000 (varies depending on the number of alarms)

channels).

N is the number of channels (measurement channels + external input channels + computation

Example 1: If display data of 12 measurement channels and 24 computation
channels is recorded. There are no messages or alarms.

216 + (88x280 + 28) + 3,484 + (104x50 + 28) + 832 + (80 + 32 + 280x4 + 2 + 18)

= 34,894 bytes

Sampled Data Size
* Data Size of Display Data and Event Data

Channel

Display Data

Event Data

Measurement channel

4 bytes/channel

2 bytes/channel

External input channel

4 bytes/channel

2 bytes/channel

Computation channel

8 bytes/channel

4 bytes/channel

Time data common to all channels is added for each sample.

|Time data

|8 bytes/sample

¢ Data Size per Sample

Display Data

(Number of measurement channelsx4 bytes) + (Number of external input channelsx4
bytes) + (number of computation channelsx8 bytes) + 8 bytes (time data)

Event Data

(Number of measurement channelsx2 bytes) + (Number of external input channelsx2
bytes) + (number of computation channelsx4 bytes) + 8 bytes (time data)

IM 04L42B01-01E
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Appendix 1 File Size of Display Data and Event Data

¢ Sampled Data Size per File

Display Data
Data size per samplexfile save interval/sampling interval
The sampling interval is determined by trend interval (s)/30.

Example 2: If the display data of 30 measurement channels, 240 external input
channels, and 10 computation channels is recorded with a trend interval of 30 min/div
(the sampling interval of display data is 60 s) and a file save interval of 1 day (24 h)

(30x%4 bytes + 240%4 bytes + 10%8 bytes + 8 bytes)x24 hx60x60/60 s
= 1,168 bytesx24 hx60x60/60 s
=1,681,920 bytes

Event Data
Data size per samplexdata length/sample rate

Example 3: If the display data of 30 measurement channels, 240 external input
channels, and 10 computation channels is recorded with a sample rate of 1 s and data
length of 2 h

(30x%2 bytes + 240%2 bytes + 10x4 bytes + 8 bytes)x2 hx60x60/1 s
= 588 bytesx2 hx60x60/1 s
= 4,233,600 bytes

Size per File
The size per file is the sum of the size of information other than the sampled data and the
size of the sampled data.

Display Data

Example 4: If recording under the conditions of examples 1 and 2

From examples 1 and 2, we obtain 34,894 + 1,681,920 = 1,716,8144 bytes = 1.637 M
bytes

Event Data

Example 5: If recording under the conditions of examples 1 and 3

From examples 1 and 3, we obtain 34,894 + 4,233,600 = 4,268,494 bytes = 4.071 M
bytes

App-2
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Appendix 1 File Size of Display Data and Event Data

Save Duration to the CF Card

We will estimate the duration over which measured data can be saved to a CF card when
measured data is being saved automatically.
Display Data
Save duration to the CF card (estimate) = (Size of the CF card/size of a file)x[file save
interval]
Example 6: We will estimate the save duration to the CF card under the conditions
of examples 1 and 2. In this example, the size of the CF card is assumed to be 256 M
bytes.

256 M bytes/1.637 M bytesx24 h
=3.753 h
= 156 days

Event Data
Save duration to the CF card (estimate) = (Size of the CF card/size of a file)x[data
length]
Example 7: We will estimate the time until the CF card needs to be replaced
under the conditions of examples 1 and 3. In this example, the size of the CF card is
assumed to be 256 M bytes.

256 M bytes/4.071 M bytesx2 h
=125h
=5.2 days

Time until the Internal Memory Becomes Full

If you are manually saving the measured data in the internal memory, old data is
overwritten when the internal memory is full. You must save the measured data to the CF
card before the data is overwritten.
Display Data
Time until the internal memory becomes full (estimate) = (Size of the internal memory/
size of a file)x[file save interval]
Example 8: We will estimate the time until the internal memory becomes full under
the conditions of examples 1 and 2. In this example, the internal memory is assumed
to be of a standard type (80 M bytes).

80 MB/1.637 MBx24 h
=1,172h
= 48 days

Event Data
Time until the internal memory becomes full (estimate) = (Size of the internal memory/
size of a file)x[data length]
Example 9: We will estimate the time until the internal memory becomes full under
the conditions of examples 1 and 3. In this example, the internal memory is assumed
to be of a standard type (80 M bytes).

80 MB/4.071 MBx2 h
=39h
=1.63 days
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Appendix 2 Types of Data That the DX Can Create
and Their Application

This section explains the types of data that the DX can create and their application.

Data Type In the DX Extension Format Display Method’
DX DAQ Application

Display data Yes DAD Binary Yes Yes  Yes*®
(undisclosed)

Event data Yes DAE Binary Yes  Yes Yes”®
(undisclosed)

Report data Yes DAR ASCII (see Yes Yes Yes
appendix 3)

Manual sampled data Yes DAM ASCII (see - - Yes
appendix 3)

Setup data Yes PDL Binary Yes Yes -
(undisclosed)

Snapshot data None PNG PNG (general - - Yes

format)

1 DX: DX main unit, DAQ: DAQSTANDARD, Application: Software application
2 The data format can be converted on DAQSTANDARD and displayed on a software

application such as Microsoft Excel.
3 The data can be retrieved from the DX using the communication function and displayed on a

software application.

App-4
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Appendix 3 Data Format of ASCII Files

This section explains the format of ASCII files. The ASCII files that the DX can create are
manual sampled data files and report files.
In the explanation below, CRLF represents a terminator.

Format of the Manual Sample Data File
* The manual sampled data is output using numerical values and strings in ASCII format

delimited by tabs.

* Values of measurement channels set to Skip and computation and external input
channels set to Off are not output.
» The data is appended to the file each time manual sample operation is performed.

Format
YRECCRLF
Manual Sample Data Version 1.00.00 CRLF
Model DX2000 CRLF
Language Code shift-JIS CRLF
File Status ffffffff CRLF
Serial No. IITeeeI CRLF
File Header HHHeeeH CRLF
Ch ccecece ccccece L ccccece CRLF
Tag ttteeet ttteeet see ttteeet CRLF
Unit uuuuuu uuuuuu L uuuuuu CRLF
yyyy/mo/dd hh:mi:ss nnneeen nnneeen e nnneeen CRLF
fEFFEEFE File status (8 characters)
Complete Completed
Progress Data being added
Decrease Defective
IITeeeI Serial number of the DX (16 characters)
HHHe e« *H File header (50 characters)
ccecee Channel number (5 characters)
ttteeot Tag (16 characters)
uuuuuu Unit (6 characters)

yyyy/mo/dd hh:mi:ss

nnneeen

Sampling year, month, day, and time (19 characters)
Measured value (13 characters)

IM 04L42B01-01E
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Appendix 3 Data Format of ASCII Files

File Output Example
Below is a manual sample data example of channels 1, 2, 3, and 4.

YREC
Manual Sample Data Version 1.00.00
Model DX2000
Language Code shift-JIS
File Status Progress
Serial No. S5E701600
File Header
Ch CHOO01 CHO002 CHO03 CHO004
Tag TI-101 oUT-102 FI-103 VA-204
Unit ~C \Y, m3/h %
2005/10/01 08:57:22 213.8 0.517 368.4 68.9
2005/10/01 08:57:28 208.6 0.494 363.0 68.1
Nofte
Output when error data, overrange data, or computation overflow data is detected
Channel Data Output
Measurement channels, Error (Space)
external input channel +over range (includes burnout detection) 99999
—over range (includes burnout detection)  —99999
Computation channel Error 999999999
Positive computation overflow 999999999
(when the value exceeds 3.4E + 38)
Negative computation overflow —-999999999

(when the value falls below —3.4E + 38)

A new manual sampled data file is created in the following cases.

* A measurement channel is changed to Skip from a range other than Skip.

* A measurement channel is changed from Skip to a range other than Skip.

« A computation or external input channel is changed from On to Off or Off to On.

* The unit is changed.

App-6

IM 04L42B01-01E



Appendix 3 Data Format of ASCII Files

Report File Format
» The hourly, daily, weekly, and monthly reports are output using numeric values and
strings in ASCII format delimited by tabs.
» Values of measurement channels set to Skip and computation and external input
channels set to Off are not output.
» The data is appended to this file every time a report is created.

Format
YRECCRLF
Report Data Version 1.00.00 CRLF
Model DX2000 CRLF
Language Code shift-JIS CRLF
File Status ffffffff CRLF
Serial No. IITeeeT CRLF
File Header HHHe e eH CRLF
Report Set RRRe**R CRLF
File Data rrreeer CRLF
Math Set MMM MMM MMM MMMM CRLF
Start Time YYYY/MO/DD HH:MI:SS CRLF
Ch ccccce ccccce see cceccece CRLF
Tag ttteeet ttteeet LR ttteeet CRLF
Unit uuuuuu uuuuuu see uuuuuu CRLF
Data Type Ssseees CRLF
Time yyyy/mo/dd hh:mi:ss CRLF
Status eeceeeeeeee CRLF
Ave nnneeen nnneeen soe nnneeen CRLF
Max nnneeen nnneeen o nnneeen CRLF
Min nnneeen nnneeen see nnneeen CRLF
Sum nnneeen nnneeen e nnneeen CRLF
fEffffff File status (8 characters)
Complete Completed
Progress Data being added
Decrease Defective
IITeeeI Serial number of the DX (16 characters)
HHHe e *H File header (50 characters)
RRRe*°*R Report setting (setting on the DX) (13 characters)
Hourly
Daily
Hourly+Daily
Daily+Weekly
Daily+Monthly
rrreeer Contents of the report file (13 characters)
Hourly
Daily
Hourly+Daily
Daily+Weekly
Daily+Monthly

Example:  When the DX is set to Hourly+Daily and
Combine, Hourly+Daily is output.
When the DX is set to Hourly+Daily and
Separate, the hourly report is output as Hourly,
and the daily report as Daily.
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Appendix 3 Data Format of ASCII Files

YREC

Report Data
Model
Language Code
File Status
Serial No.
File Header
Report Set
File Data
Math Set
Start Time
Ch

Tag

Unit

Data Type
Time

Status

Ave

Max

Min

Sum

MMMM

YYYY/MO/DD HH:MI:SS
CcCCcccc

ttteeot

uuuuuu

ceeeeeeeee

SSSeeeS

yyyy/mo/dd hh:mi:ss

nnneeen

File Output Example

Report items (16 characters (including tabs that are counted
as one character each), up to four types)

Ave

Max

Min

Sum

Inst Instantaneous value

Report start year, month, day, and time (19 characters)
Channel number (5 characters)

Tag (16 characters)

Unit (6 characters)

Status (output the events that occurred while creating report
data) (10 characters)

Bo Burn out detected

Er Error (error detection)

ov Over (overrange/computation overflow detection)
Pw Power failure (power failure occurrence)

Cg Change (time change present)

Report type (7 characters)

Hourly

Daily

Weekly

Monthly

Report year, month, day, and time (19 characters)
Average, maximum, minimum, sum, or instantaneous value
(13 characters)

Below is an example of an hourly report of 4 channels while creating hourly and daily
reports and saving each type of report to a separate file.

Version 1.00.00

DX2000
shift-JIS
Complete
S5E701600

Hourly+Daily
Hourly
Ave

2005/10/01 08:10:56

CHOO01
TI-101
~C
Hourly

2005/10/01 09:00:00

91.5

259.8

-59.9
3.293636E+05

Max Min Sum
CHOO02 CHO03 CHOO04
ouUT-102 FI-103 VA-204
v m3/h %
-0.039 241.1 48.6
0.726 416.5 76.6
-0.727 83.4 23.3

-1.392980E+02 8.680871E+05 1.748983E+05
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Note

When the channel data is in the condition shown in the table below, the Ex, Ov, or Bo status

is output to a report.

Data Condition Status
Error Er
Measurement and external input channels
Positive over range ov
Negative over range ov
Burn out detection Bo
Computation channels
Positive computation overflow (when the value exceeds 3.4E + 38) Oov

Negative computation overflow (when the value falls below —3.4E + 38) Ov

The report output value of Ave, Max, Min, Sum, and Inst varies depending on the channel

data condition as shown in the table below.

Item Data Condition of Measurement/ Report
External Input Channels Output Value

Ave When all of the data are errors or over range (Space)

Max, *  When all of the data are errors (Space)

Min, » For +over range (includes burnout detection) 99999

Inst » For —over range (includes burnout detection) —99999

Sum *  When all of the data are errors or over range (Space)

*  When the sum value exceeds approx. 3.4E + 38
*  When the sum value is below approx. —3.4E + 38

9.999999E+99
—9.999999E+99

Item Data Condition of Computation Channels Report
Output Value
Ave When all of the data are errors or computation overflow (Space)
Max, * When all of the data are errors (Space)
Min, ¢ When the maximum value or instantaneous value 999999999
exceeds 99999999
Inst *  When the minimum value or instantaneous value is less —“999999999
than —9999999
Sum * When all of the data are errors or computation overflow (Space)
*  When the sum value exceeds approx. 3.4E + 38 9.999999E+99
*  When the sum value is below approx. —3.4E + 38 —9.999999E+99

*

The decimal place that was specified when the span for the channel was specified

applies to the maximum and minimum values or the instantaneous values. For example,
if the span setting of the channel is “200.0,” then “999999999"” is output when the value
exceeds “9999999.9” and “—999999999” is output when the value is below “~-999999.9.”

IM 04L42B01-01E

App-9

E Xipuaddy



24 VDC transmitter power supply........ccoocveeenieeeiiinennnns 13-12
3 legisolated RTD input.......ccoocveiiiiiiiniiiciiec e 13-11
A

A/D integration time ..........cccoeiiiiiiiii e

ABS e
absolute time Mode ..........cooeeiiiiiiiiiie e

action.........c.coeeennn.
added messages ..
administrator.....

alarm acknowledge..................
alarm acknowledge operation
alarm delay time ............ccc......
alarm hide funCtion ...........ccceeiiiiiinii e
alarm indication ..........cccoeiiiiie e
alarm mark indication .
alarm output relay.........ccocoiiiiiiiee

alarm Settings ......ccviiiieiiec
alarm SUMMANY ........oooiiiiieiieeeeee e
alarm value ...
all channel display ...

auto increment..
auto logout........cceeeeee. .

automatic message Writing ........cocoevveiiiiieiiienie s
AULO SAVE ..o

B

background COIOr ...........oiiiiiiiiiiiieeee e
background color (historical trend).
backlight saver............cccoiiiii
bar graph display ..........cccooiiiiiiii e
base position (bar graphs).
batch comment..
batch function ... .
batch name............ccocooiii
batch NUMDbEr........c.ooii e

brightness......
burnout .......
burnout detection.............ocieiiiiiiii

c

calculate the file Size ........ccoooveeiiiiiiie
calibration...................
calibration correction ..

Change MESSATE ......ceiiiiiiiiiiie ettt
channel (computation)
channel display colors ...
channel NUMDEr ...
circular display.........cooieieeiieee i
clamped input terminal ............ccoooiiiiiiiis

clears the entire waveform (circular)
CLOG computation.........c.ccccveeenneen. .
color scale band .........cccoooiiiiiiiii
COMMUNICALION EITOIS .....iiiiiiiiiiiii et
communication functions.
COMMUNICALION 10g.....eiiiiiiiiiiii e
computation channel ..........ccccoiiiiiiiiii e,
computation data dropout...........cccceeeiiiiiiiie i,
COMPULALION EITON ...
computation function . .
computation tYPes ........ceeeiiiiiiiiiie e
conditional eXPression ..........cocivcieiieiiie i
configuration (storage)..
construction (DX)...

continuing data.............. .
count (MOVING @VEIage).......ceeueeiuiieiiieiiieeiieeiee s
Cu10, Cu25 RTD iNPUL ...eeeeiieeeiiie e
current value display.....

cursor (circular).............

cursor (historical trend)...........cccooveiiiiiiciiiieee .
customizing the display selection menusmenu ................. 5-35
customizing the FUNK key menus ............cccoceeinieeeninnn. 5-35
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